Creating detailed drawings
Creating detailed drawings
This software and related documentation are proprietary to Siemens Product Lifecycle Management Software Inc.

© 2010 Siemens Product Lifecycle Management Software Inc. All Rights Reserved.

All trademarks belong to their respective holders.
Contents

Introduction ................................................................. 1-1
Drafting ................................................................. 2-1

Drawing Production Overview ............................................. 3-1
Create a part drawing ......................................................... 3-2
Create an assembly drawing ............................................... 3-4
Opening and saving draft documents ..................................... 3-6
Drawing sheets ............................................................... 3-9
Drawing view creation ....................................................... 3-13
Principal views ............................................................... 3-22
Auxiliary views ............................................................... 3-22
Detail views ................................................................. 3-24
Section views ................................................................. 3-29
Broken Views ................................................................. 3-37
Draft quality and high quality views .................................... 3-37
Drawing view manipulation .................................................. 3-40
Drawing view updates ....................................................... 3-47
Drawing properties ......................................................... 3-50
Defining Drawing Standards ............................................... 3-52
Using Hyperlinks ........................................................... 3-55
2D drawing views and 2D model views ................................ 3-57
Schematic Diagramming using Blocks and Connectors ............... 3-61
Symbols overview ........................................................... 3-79

Activity: Drawing view placement ....................................... 4-1

Activity: Assembly drawing creation .................................... 5-1

Activity: Quicksheet ......................................................... 6-1

Activity: Broken view creation .............................................. 7-1

Activity: Broken-out section creation .................................... 8-1

Dimensions, Annotations, and PMI ...................................... 9-1
Dimensioning overview ..................................................... 9-1
Annotations overview ....................................................... 9-37
Product Manufacturing Information (PMI) .............................. 9-62
Property text codes ......................................................... 9-93
Contents

Activity: Retrieving and placing dimensions .......................... 10-1
Activity: Placing annotations ........................................... 11-1
Activity: Placing a parts list ............................................ 12-1
Summary ................................................................. 13-1

Activity: Drawing view placement ................................. A-1
Create a draft document ........................................... A-2
Setup the background and sheet size for the drawing sheet .......... A-2
Select the drawing standards for the drawing sheet ................. A-2
Select views in the Drawing View Creation Wizard ................. A-3
Place the views selected on to the drawing sheet ................. A-5
Place an additional part view on the drawing sheet ............... A-7
Save the drawing file ............................................ A-9
Place an auxiliary view on the drawing sheet ....................... A-10
Create a new drawing sheet and move the auxiliary view to the new sheet A-10
Create a cutting plane for a section view .......................... A-11
Create a section view ........................................... A-12
Change the cross-hatch properties of the section view .......... A-13
Place a detail view off of the front view .......................... A-13
Change the display of a drawing view to shaded ................. A-15
Activity summary ............................................. A-16

Activity: Assembly drawing creation ........................... B-1
Create a new draft document ................................... B-1
Define views to place on the drawing sheet ...................... B-2
Place an exploded assembly view ................................ B-2
Place a front view on a new sheet ................................ B-2
Draw a cutting plane for a section view .......................... B-4
Create a section view ........................................... B-5
Hide a part in the drawing view .................................. B-7
Adjust the parts display ........................................ B-8
Activity summary ............................................. B-8

Activity: Quicksheet ............................................... C-1
Create a new draft document ................................... C-1
Set the drawing standards ...................................... C-2
Define the drawing views ........................................ C-2
Arrange the views on the sheet .................................. C-4
Create a quicksheet template ................................... C-5
Populate a quicksheet template ................................ C-6
Place the new quicksheet template in the Solid Edge templates folder C-6
Create a new draft file using the quicksheet template ....... C-6
Activity summary ............................................. C-7

Activity: Broken view creation ................................. D-1
Create a new draft document ................................... D-1
Define the drawing view ........................................ D-1
Add a vertical broken region to the drawing view ............... D-3
Place a horizontal break in the drawing view ................... D-5
<table>
<thead>
<tr>
<th>Activity</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Place a broken view with different break line types</td>
<td>D-6</td>
</tr>
<tr>
<td>Activity summary</td>
<td>D-6</td>
</tr>
<tr>
<td><strong>Activity: Broken-out section creation</strong></td>
<td>E-1</td>
</tr>
<tr>
<td>Create a new draft document</td>
<td>E-1</td>
</tr>
<tr>
<td>Set the drawing standards</td>
<td>E-1</td>
</tr>
<tr>
<td>Define the drawing view</td>
<td>E-2</td>
</tr>
<tr>
<td>Define the broken-out section view</td>
<td>E-3</td>
</tr>
<tr>
<td>Edit the broken-out section</td>
<td>E-4</td>
</tr>
<tr>
<td>Activity summary</td>
<td>E-6</td>
</tr>
<tr>
<td><strong>Activity: Retrieving and placing dimensions</strong></td>
<td>F-1</td>
</tr>
<tr>
<td>Open a draft file</td>
<td>F-2</td>
</tr>
<tr>
<td>Retrieve dimensions</td>
<td>F-3</td>
</tr>
<tr>
<td>Modify the retrieved dimensions</td>
<td>F-5</td>
</tr>
<tr>
<td>Place center marks</td>
<td>F-5</td>
</tr>
<tr>
<td>Place angular dimensions</td>
<td>F-7</td>
</tr>
<tr>
<td>Place a linear dimension and add a prefix</td>
<td>F-9</td>
</tr>
<tr>
<td>Place a Smart dimension and add prefix, suffix and special characters</td>
<td>F-10</td>
</tr>
<tr>
<td>Dimension a section view</td>
<td>F-11</td>
</tr>
<tr>
<td>Edit a dimension and add a tolerance</td>
<td>F-13</td>
</tr>
<tr>
<td>Use the dual unit dimension display</td>
<td>F-14</td>
</tr>
<tr>
<td>Fit the drawing sheet</td>
<td>F-16</td>
</tr>
<tr>
<td>Change sheet size</td>
<td>F-16</td>
</tr>
<tr>
<td>Close the draft file</td>
<td>F-17</td>
</tr>
<tr>
<td>Open part file used to create drawing views</td>
<td>F-18</td>
</tr>
<tr>
<td>Edit a circular pattern feature</td>
<td>F-18</td>
</tr>
<tr>
<td>Open draft file</td>
<td>F-19</td>
</tr>
<tr>
<td>Use Drawing View Tracker</td>
<td>F-20</td>
</tr>
<tr>
<td>Activity summary</td>
<td>F-21</td>
</tr>
<tr>
<td><strong>Activity: Placing annotations</strong></td>
<td>G-1</td>
</tr>
<tr>
<td>Open draft file</td>
<td>G-1</td>
</tr>
<tr>
<td>Place a datum frame</td>
<td>G-1</td>
</tr>
<tr>
<td>Reposition a dimension</td>
<td>G-2</td>
</tr>
<tr>
<td>Place a feature control frame</td>
<td>G-3</td>
</tr>
<tr>
<td>Place another feature control frame</td>
<td>G-4</td>
</tr>
<tr>
<td>Place a surface texture symbol</td>
<td>G-4</td>
</tr>
<tr>
<td>Hide an edge in the drawing view</td>
<td>G-6</td>
</tr>
<tr>
<td>Place a centerline on the section view</td>
<td>G-6</td>
</tr>
<tr>
<td>Place an edge condition on the section view</td>
<td>G-8</td>
</tr>
<tr>
<td>Add notes to the drawing sheet</td>
<td>G-9</td>
</tr>
<tr>
<td>Activity summary</td>
<td>G-10</td>
</tr>
<tr>
<td><strong>Activity: Placing a parts list</strong></td>
<td>H-1</td>
</tr>
<tr>
<td>Open draft file</td>
<td>H-1</td>
</tr>
<tr>
<td>Set the parts list option for auto ballooning</td>
<td>H-2</td>
</tr>
<tr>
<td>Set the balloon properties</td>
<td>H-2</td>
</tr>
<tr>
<td>Define location of the parts list</td>
<td>H-3</td>
</tr>
<tr>
<td>Define the parts list columns</td>
<td>H-3</td>
</tr>
<tr>
<td>Place the parts list columns</td>
<td>H-6</td>
</tr>
<tr>
<td>Activity summary</td>
<td>H-6</td>
</tr>
</tbody>
</table>
Lesson

1 Introduction

Welcome to self paced training for Solid Edge. This course is designed to educate you in the use of Solid Edge. The course is self-paced and contains instruction followed by activities.

Solid Edge self-paced courses

- spse01510—Sketching
- spse01515—Constructing base features
- spse01520—Moving and rotating faces
- spse01525—Working with face relationships
- spse01530—Constructing treatment features
- spse01535—Constructing procedural features
- spse01536—Modeling synchronous and ordered features
- spse01540—Modeling assemblies
- spse01541—Explode-Render-Animate
- spse01545—Creating detailed drawings
- spse01546—Sheet metal design
- spse01550—Practicing your skills with projects
- spse01560—Modeling a Part Using Surfaces
- spse01610—Solid Edge frame design
- spse01640—Assembly patterning
- spse01645—Assembly systems libraries
- spse01650—Working with large assemblies
- spse01655—Revising assemblies
- spse01660—Assembly reports
- spse01665—Replacing parts in an assembly
Lesson 1  

Introduction

- **spse01670**—Designing in the context of an assembly
- **spse01675**—Assembly features
- **spse01680**—Inspecting assemblies
- **spse01685**—Alternate assemblies
- **spse01690**—Virtual components in assemblies
- **spse01695**—XpresRoute (tubing)
- **spse01696**—Creating a Wire Harness with Harness Design
- **spse01424**—Working with Solid Edge Embedded Client

**Start with the tutorials**

Self-paced training begins where tutorials end. Tutorials are the quickest way for you to become familiar with the basics of using Solid Edge. If you do not have any experience with Solid Edge, please start by working through the tutorials for basic part modeling and editing before starting this self-paced training.
Lesson

2 Drafting

Course Overview

The Drafting course focuses on creating and editing drawings of 3D models. Upon completion of this course, you will be able to:

- Create drawings
- Add views to a drawing
- Create dimensions
- Create annotations
Lesson

3 Drawing Production Overview

Overview

Drawing production is the process of formally documenting the design of a part or assembly. Solid Edge gives you a variety of tools that allow you to easily document designs during any stage of drawing production. You can create associative drawing views of 3D parts and assemblies that you can quickly update when the part or assembly changes. You can also create drawing views that consist of 2D elements drawn from scratch that you can quickly change without making changes to a part or assembly document.

A combination of the above methods also gives you the ability to meet the changing demands of your workflow. You can place an associative drawing view, which you can update when the model changes. Then, when you want to make changes to the drawing document without changing the model, you can convert the associative drawing view to a 2D element drawing view.

- Create a part drawing
- Create an assembly drawing

You can make a 2D drawing in Solid Edge using two types of drawing views: part views and 2D views. The 2D drawing can contain dimensions and other annotations that describe the size of a part or assembly, the materials used to create it, and other information.
Drawing View Types

When working from a 3D model, you can create the following types of drawing views:

- Principal views
- Auxiliary views
- Perspective views
- Detail views (dependent and independent)
- Section views
- Broken views
- Draft quality or high quality views
- Exploded assembly drawings

When working with Solid Edge 2D Drafting, you cannot create 3D views that require a 3D model: section views, broken-out section views, and detail views.

Create a part drawing

Workflow to create a part drawing

Use the following process to produce a drawing from any Solid Edge part or sheet metal document (.par and .psm file types).

1. Open a new draft document using the ISO Draft template.
2. Use the View Wizard command to define and place primary part views.
3. (Optional) Create additional views as needed.
   - Auxiliary views
   - Detail views
   - Section views
- Broken views
- Draft quality views

4. Dimension the part views. For example, you can:
   - Retrieve dimensions and annotations from the model.
   - Use the Smart Dimension command to add dimensions.

5. Annotate the part views. For example, you can use these commands to annotate the model:
   - Place a balloon.
     ![Balloon annotation example]
   - Place a callout.
     ![Callout annotation example]
   - Place a feature control frame or datum frame.
     ![Feature control frame example]
   - Place an edge condition symbol.
   - Define a weld symbol.
Lesson 3  Drawing Production Overview

- Place a Surface Texture Symbol.

- Automatically create center lines and center marks in a drawing view.

- Use the Edge Painter command to redraw, show, or hide part edges.

- Use the Text command to add notes to the drawing sheet.

6. Save the draft document.

7. Print a document.

8. When the model changes, drawing views go out-of-date. Do either of the following:

   - Use the Update Views command to update views of the model, indicated by gray borders.

See Drawing view updates to learn about these features.

   - Use the Dimension Tracker dialog box to Review changed dimensions and annotations.

See Tracking dimension and annotation changes to learn about these features.

Create an assembly drawing

You can choose model representations defined in the assembly model to show in a drawing view, such as an exploded model display configuration or a PMI model view. Use the following process to create an isometric drawing view of an exploded
assembly with a ballooned parts list. You can do this from the assembly model or from a draft document.

1. **Start the Drawing View Wizard**
   In the assembly document, do the following:
   a. Save the assembly document.
   b. From the Application menu, select the New→Create Drawing command.
   c. In the Create Drawing dialog box, select the Run Drawing View Creation Wizard check box and click OK.

2. **Choose an assembly model representation**
   In the Drawing View Creation Wizard (Drawing View Options), select one of the following from the .cfg, PMI model view, or zone list:
   - To create an exploded isometric model view, select an exploded model display configuration , and then click Finish.
     To learn how to create an exploded model configuration, see Explode an assembly automatically.
   - To communicate design, manufacturing, and functional information that has been added to a saved view of the model, select a PMI model view name , to Create a PMI drawing view.
     To learn how to create a PMI model view, see Create a PMI model view.
   - To create a user-defined view of the equipment and components in a rectangular area of a large assembly model, select a zone name , and then click Next.
   - If there is no predefined model representation to select, or to create any combination of user-defined assembly views, select No Selection, and then click Next.

3. **Place a user-defined view on the sheet**
   If the Drawing View Creation Wizard (Drawing View Orientation) is displayed:
   a. Select a named view, such as isometric, as the principal view.
   b. Click Next to choose additional views, or click Finish.
   c. Click the drawing sheet to place the view(s).

   **Tip**
   Predefined PMI model views and display configurations are placed on the drawing automatically.

4. After placing the view, you can do any of the following:
   - **Adjust the assembly display**
Use the Display page (Drawing View Properties dialog box) to control the display of the individual parts and subassemblies in the assembly.

To learn more, see Creating drawings of assemblies.

- **Retrieve model dimensions and annotations**
  - If the drawing views are orthographic, you can use the Retrieve Dimensions command to extract dimensions and annotations from the model onto the drawing.
  - If the drawing views are pictorial (isometric, dimetric, or trimetric), you can use the Smart Dimension command to Place a 3D dimension on a pictorial drawing view.

5. **Add a ballooned parts list**

Use the Home tab→Tables group→Parts List command to Create a parts list.

**Tip**

- To place a parts list that shows the assembly model item numbering schema in the table and in the balloons, select the Use assembly generated item numbers check box on the Options page (Parts List Properties dialog box). If this option is unavailable, you need to set the Create item numbers check box on the Item Numbers page (Solid Edge Options dialog box).

- You can rearrange balloons that have been generated automatically with a parts list, so that all of the balloons are visible. To learn how, see Stack balloons.

- If parts are missing in a parts list or a drawing view for an assembly, verify that the missing parts are not turned off in the assembly document Occurrence Properties dialog box. To learn how, see Display assembly occurrences in a drawing view or parts list.

### Opening and saving draft documents

Some of the more specialized file operations that pertain to draft documents are described in this topic. For basic file operations, see Opening and saving Solid Edge documents. To learn about file operations for managed documents, see Adding Solid Edge documents to a managed library.

**Opening draft documents in active mode or review (inactive) mode**

You can open a draft document in two different modes: active mode or review mode. Active mode is the default. Review mode reduces the time required to open the document. To open a draft document in review mode, set the Inactivate Drawing Views For Review option in the Open File dialog box.

**Active mode vs. review mode**

*Active mode* specifies that a draft document is opened with normal editing capability. All commands are available. Drawing views, parts lists, drawing
tables, and other items are checked to determine whether they are out-of-date. Model geometry is live and accessible.

*Review mode* is intended for drawing review and printing. You can open a large draft document quickly by forgoing out-of-date checking and by limiting functionality. This also is useful when opening a managed draft document with many other documents linked to it.

In review mode:

- You can put the finishing touches on a drawing by selecting and moving 3D drawing views, adding and editing dimensions and annotations, changing their scale, and adjusting their properties.

- Functions that rely on model-derived data, such as retrieving dimensions, adding center lines automatically, editing parts lists and model-derived tables, and dimensioning to draft quality views, are disabled.

- You can create new views from geometry on the 2D Model sheet. You also can create detail views of 2D Model views. However, commands for creating new 3D drawing views are not available.

- You cannot update drawing views.

You can identify a draft document that has been opened in review mode by the **Inactive** watermark stamped on working sheets and the 2D Model sheet. Another indicator is the document title bar, which displays the following in front of the document name and revision ID: “Draft with Inactive Drawing Views.”

Changing drawing view mode within the document

Once a document is open, you can change from one mode to the other. On the Tools tab, in the View Activation group, you can select these commands:

- Activate Drawing Views

- Inactivate Drawing Views

For example, if you open the document in review mode to print a drawing, but then decide you want to add a new view or change drawing view depth, you can select the Activate Drawing Views command. This returns the drawing to normal edit mode for you to make your changes.
Also, if you try to drag a model file into a draft document that is in review mode, a dialog box prompts whether you want to activate the drawing on-the-fly. Click Yes to change the document to active and continue creating the drawing view. Click No to end the drawing view creation command and leave the drawing in review mode.

Specifying a document open preference
You can set a preference for a draft document to open in review mode. Before you click the Open button to open the document, choose one of these options in the Open File dialog box, and then click the Save As Default button:

• Activate Drawing Views For Edit
• Inactivate Drawing Views For Review

Opening draft documents in the Solid Edge Viewer
Solid Edge provides a standalone Viewer that allows you to view draft documents without activating Solid Edge. To activate the Viewer from Windows Explorer, right-click the document you want to view, and then choose Viewer on the shortcut menu.

Saving draft documents for View and Markup and the Solid Edge Viewer
Before you can view a draft document in View and Markup or the Solid Edge Viewer, the metafile data for the document must be generated. You can do this automatically whenever you save a Draft document by setting the Include Draft Viewer Data In File option on the General page of the Options dialog box. To learn how, see Help topic Open a document in View and Markup.
Drawing sheets

Drawing composition begins with choosing a drawing sheet. Drawing sheets are similar to pages in a notebook. You can place drawing views on different drawing sheets in the document. For example, you can place a front view and a right view on one drawing sheet and a section view on another drawing sheet. Both sheets are saved in the same document. To set up a drawing sheet, use the Sheet Setup command on the Application menu.

All 3D model drawing views, dimensions, and annotations are placed on the active working sheet, which has two components. The sheet outline (1) shows the orientation and print region of the sheet. You can change the size and orientation of the sheet outline with the Sheet Setup command. The area outside of the outline (2) is also part of the drawing sheet.

You also can draw, dimension, and annotate geometry on the 2D Model sheet, and then create 2D model views of the 2D design and place them on the active working sheet.

Working sheets

The sheet where you do all of your drawing view construction is called a working sheet. You can create as many working sheets as you need. Each working sheet has a background sheet attached to it.

You can modify a drawing sheet’s characteristics, such as the size and attached background sheet, with the Sheet Setup command on the Application menu. The Sheet Setup command also allows you to set the defaults for all new working sheets created in the document. To do this, set the options you want and then click the Save Defaults button.
Background sheets

A background sheet is used as a backdrop to the working sheet. You can attach the same background sheet to any number of working sheets, making them useful for any geometry that you want to place on more than one drawing.

- Use the Background tab on the Sheet Setup dialog box to apply a background sheet.
- Use the View tab→Sheet Views group→Background command to format a background sheet.

When you attach a background sheet to a working sheet with the Sheet Setup command, geometry on the background sheet is displayed and printed along with the working sheet. So that the paper sizes and graphics on both sheets line up, the size of the working sheet is automatically set to the size of the background sheet you attach. A typical customized scheme would be to have a different background sheet for each standard-sized drawing (such as A, B, C, D, or A0, A1, A2, A3, A4).

![Background sheet example]

**Note**

The graphics on the background sheet are not affected by drawing sheet scale. They are always displayed 1:1 with respect to the working sheet.

You also can add a drawing border sheet as a background to the 2D Model sheet using the Drawing Area Setup command or by dragging it directly onto the sheet.

For example, you can add a company-standard border and title block, insert a raster image of your company’s logo with the Insert Object command on the Sketching tab, or draw other geometry.
2D model sheet

The 2D Model sheet is a special sheet used exclusively for working in 2D model space. It enables you to draw on the sheet and annotate at a scale appropriate for the overall size of the part you are designing, yet it prints your drawing with annotations appropriately scaled to the output sheet size you specify.

For example, you can drag a file containing 2D geometry—such as a Solid Edge .dft document or an AutoCAD .dwg or .dxf file—onto the 2D Model sheet. You can add annotations and dimensions using one drawing scale, then use the 2D create 2D views of your design that you place on one or more working sheets at a different scale for printing.

Unlike working sheets, there is just one 2D Model sheet allowed per document. It is always the first sheet in the document, and it cannot be renamed.

- Select the View tab→Sheet Views group→2D Model command to make this sheet available.

- The scale of the 2D Model sheet is 1:1. To annotate and dimension at a different scale than the scale of the printed drawing, without having to change the text height before printing, use the Drawing Area Setup command on the Application menu. This command automatically calculates the size and scale of your work area on the 2D Model sheet based on the printout sheet size and the width and height of your intended design.

- You can add a drawing border sheet to the 2D Model sheet. Use the Drawing Area Setup command, and select one of the drawing border block files listed on the Drawing Area dialog box in the Place Block list. Using the Drawing Area Setup command ensures that the border is placed at the correct scale for the paper it will be printed on.

  If you are not concerned with scaling the border, you can drag a file containing a drawing border onto the model sheet and click to place it.

Manipulating sheets

You can use the named tabs at the bottom of the drawing sheets to manipulate the sheets easily. You can use the tabs in the following ways:

- To select and display a drawing sheet, click a tab. The name of the displayed drawing sheet appears in bold.

- To activate a drawing sheet and set up sheet options, double-click the sheet’s tab.

- To activate the drawing sheet shortcut menu, click the right mouse button on any tab.
Lesson 3  

*Drawing Production Overview*

You can use the following scroll buttons to scroll through the drawing sheet tabs.

- Scrolls to the first drawing sheet tab in the document.
- Scrolls to the last drawing sheet tab in the document.
- Scrolls to the previous drawing sheet tab in the document. To scroll through several tabs at a time, hold Shift, then click this button.
- Scrolls to the next drawing sheet tab in the document. To scroll through several tabs at a time, hold Shift, then click this button.

Right-click a drawing sheet tab to access the drawing sheet tab shortcut menu. From this menu, you can insert, delete, reorder, and rename drawing sheets.

**Sheets and document templates**

You can reuse your customized background sheets by saving them in a document template. When you use the template to create a new document, all of the background sheets in the template are copied into the new document.

**Drawing view scale**

When you model a part or assembly, you can construct the model to the full scale of the real-world object you are creating. The size of the working sheet determines the scale you should use to display the 3D part or assembly. For example, the drawing view scale for a front loader bucket part would be smaller if an A size sheet were used, because the A size border is smaller than the D size.

The Drawing View Wizard command uses the size of the working sheet to compute the best-fit scale value needed to display part views of the selected part. This scale appears in the Scale box on the Drawing View Wizard command bar.

Alternatively, before you place the part view, you can select a different drawing scale from the Scale List on the Drawing View Wizard command bar.

The scale value that you use in the Drawing View Wizard command is saved as the *sheet scale* of the working sheet you place them on. The next time you run the Drawing View Wizard command for that sheet, you can select this scale from the command bar so that the new part view has the same scale as the views you have already placed.

**Note**

Part views, with the exception of detail views, have the same scale as the part view they are created from. Aligned part views also share the same scale. To change the scale of an individual part view, remove the alignment with the Unalign command on the shortcut menu, and then use the Properties command on the shortcut menu to set the scale you want.

**Dimensional values in drawing views**

The dimensional values of the parts or assemblies in your part views measure the actual size of the model. For example, if a hole feature in a part is 25 millimeters and the drawing view scale is 2:1, when you dimension the hole feature, it will be 25 millimeters, not 50 millimeters. This means that you never have to worry about the part view scale affecting the dimensional values when you are creating a drawing.
The dimension and annotation sizes in your working sheets are independent of the drawing view scale. For example, if you define the height and size of dimension text as 0.125 inch or 3.5 millimeters, these are the actual values of the dimension text on the printed drawing.

**Sheet scale**

A sheet scale is a standard scale value for drawing views placed on the working sheet. Typically, the sheet scale is indicated in the drawing border title block. When you place a drawing view on the same sheet using a different scale, you can note the exception scale value in a drawing view caption.

- You can set a different sheet scale for each working sheet using the Sheet Setup command.
- The sheet scale of the active sheet can be shown and updated automatically in the drawing border title block by creating a callout annotation that extracts the Sheet Scale property text value from the active document: %{Sheet scale}.

**Note**

Only working sheets can have a sheet scale other than 1.0. Background sheets, the 2D Model sheet, and draw-in-view windows have their sheet scale fixed at 1:1.

**Referencing sheet name, number, and scale on the active sheet**

You can use callouts and other types of annotations to extract and display property text that identifies the sheet name, number, and scale of the active drawing sheet. For example, you can place a callout on a shared background sheet, in the drawing border title block, so that it displays the sheet scale on each working sheet.

To create a callout that extracts property text, such as the Sheet Name, Sheet Number, and Sheet Scale properties, see the Help topic, Create property text. Many other properties, such as file name, title, and author, can be extracted as well.

**Displaying drawing sheets in Draft viewers**

When you want to make your Draft documents available for review in Solid Edge Viewer and View and Markup, you must specify the sheets to be included in the file. Use the following check boxes on the General page (Solid Edge Options dialog box, Draft environment), to select the sheet types:

- Include Draft Viewer data in file
  - Include Working Sheets
  - Include 2D Model Sheet
  - Include Background Sheets

**Drawing view creation**

You can make a drawing in Solid Edge using several types of drawing views: 2D part views, 2D views, and predefined 3D model views. The drawing can contain
dimensions and other annotations that describe the size of a part or assembly, the materials used to create it, and other information.

You can place any number of drawing views on a sheet. You can also modify the characteristics of a selected drawing view with the Properties command on the Edit menu or the shortcut menu.

To learn about creating a 2D view, see the Help topic, 2D views and 2D model views. To learn about creating a 3D model view, see the Help topic, Creating 3D model views with PMI.

**Part views**

You can create part views of any Solid Edge part, sheet metal, or assembly document (.par, .psm, and .asm file types). Multiple part, sheet metal, and assembly documents can be used as the basis for part views in a draft document. To document foreign data, first convert the data into a Solid Edge document.
Creating a primary part view

You begin creating part views by using the Drawing View Creation Wizard to create a primary view of a 3D part or assembly. A primary view is simply the first view placed on the drawing.

The Drawing View Creation Wizard displays a series of pages. The specific options you see depend upon whether you start the command from a draft or 3D model document:

- To start the Drawing View Creation Wizard from a draft document, select the Drawing View Wizard command. You are then prompted to choose a 3D part, sheet metal or assembly document as the source file for the drawing view.
- To start the Drawing View Wizard command from a part, sheet metal, or assembly model document, on the Application menu, choose New→Create Drawing.
- The Drawing View Options page sets drawing view options for the model.
- The Drawing View Orientation page is where you select a named view, such as front, dimetric, or top.
- The Custom Orientation dialog box contains view manipulation commands that you can use to create a custom view as the primary view. For example, you can define a perspective view.
- The Drawing View Layout page is where you select companion orthographic views to place with the primary view.

Placing a primary part view

When you click Finish on the Drawing View Creation Wizard, the cursor is displayed as a rectangle the size of the new part view. You can position the view anywhere on the sheet, and then click to place it. If you selected companion views from the wizard's Drawing View Layout dialog box, when you click the drawing sheet, all selected views will be placed at once.
Creating additional part views

After you create one or more primary part views, you can use them to create:

- Principal views
- Perspective views
- Auxiliary views
- Detail views
- Section views
- Broken views

You can then use those part views to create still others. For example, if you create a principal view (2) based on the primary view (1), you can create a section view (3) based on the principal view.

![Diagram showing part views](image)

Setting the projection angle

The projection angle defines the appearance of a new part view that is folded from an existing part view. The projection angle is dependent on the mechanical drafting standard you use and, typically, once you set the projection angle you will rarely, if ever, need to reset it.

![Diagram showing part views](image)

Mechanical drafting standards use either a first angle projection or a third angle projection for creating multi-view projections of a part on a drawing sheet. The first angle method is predominantly used by engineers and designers who follow ISO and DIN standards. The third angle method is predominantly used by engineers and designers who follow ANSI standards. You can create part views using either method.

You can set the projection angle on the Drawing Standards tab on the Options dialog box. You can also set the method you want to use in a template so that all documents created using that template conform to the standard you need.
Creating drawings of assemblies

When you create a part view of an assembly, you can control the display of the individual parts and subassemblies in the assembly. For example, you may want to hide certain parts or specify that a part is displayed as a reference part. You can also control the display of weld beads and material addition features in a part view of a weldment assembly.

- You can use the Model Display Settings button on the Drawing View Wizard command bar to specify which parts you want to display in the part view before you place it on the sheet.

- After placement, you can select the part view on the drawing and edit its properties using the Properties command on the shortcut menu.

- You also can use the display configurations, PMI model views, and zones you have saved in the Assembly environment to control the display of the parts in the part view. When you select an assembly document in the Select Model dialog box of the Drawing View Wizard, you can select the display name you want to use from the .cfg, PM Model View, or Zone list on the Assembly Drawing View Options page. For example, you can use an exploded display configuration name to place a part view of an exploded assembly.

To enhance the performance of assembly drawing views, clear the Show Hidden Edges and Show Edges of Hidden Parts options on the Assembly Drawing View Options dialog box. To make these changes for all assembly drawing views, clear these options on the Edge Display tab of the Solid Edge Options dialog box. You can create a draft template file with these options cleared and use it to create all the drawing views of your assemblies without hidden lines.

**Note**

In the Assembly environment, you can define several types of display configurations: assembly configurations, zones, and exploded configurations.
Creating draft quality views of assemblies

You can use the Create Draft Quality Drawing Views option on the Assembly Drawing View Options page of the Drawing View Wizard to quickly create a draft-quality drawing of a complex assembly. To allow draft quality views to be quickly generated, only visible edges are created.

You can use draft quality views as input for principal views, auxiliary views, cutting planes, and broken-out section views. You can add balloons to draft quality views and create parts lists from them. You can place elements that connect to a drawing view with a leader, such as balloons and callouts. Some of the view properties, such as Hidden Edge Display, can be fixed. Others, such as Scale, can be modified.

You can use the Activate Parts for Dimensioning option on the Assembly Drawing View Options dialog box of the Drawing View Wizard command to activate (load into memory) the parts in the assembly so that you can use them for dimensioning and other operations that require precision. This option is only available when Create Draft Quality Drawing Views is also checked.

Creating 2D drawing views of 3D sections

To simulate the removal of material from a 3D model and to expose internal features, you can create sectioned views of a part, sheet metal component, or assembly. To do this, use the Section command, which is located on the Product Manufacturing Information (PMI) tab in the part, sheet metal, or assembly document.

You can create a 2D drawing view directly from the 3D section view in the part, sheet metal, or assembly document using the New → Create Drawing command on the Application menu. You also can create a 2D view of the 3D section from within the Draft environment. In this case, use the Drawing View Wizard command, and then select the assembly, part, or sheet metal file that contains the 3D section view.

After you place the view on the sheet, select the Properties command from the drawing view shortcut menu, then click the Sections tab on the Drawing View Properties dialog box. Select the 3D section view from the list, and click OK. You must then select the Update View command to update the drawing view with the 3D section view.
Creating drawings of a PMI model

You can produce drawings of model views containing product manufacturing information using the Drawing View Creation Wizard. The display data contained in the model view—view orientation, 3D sections, and PMI—is captured on the drawing. PMI text copied to the drawing retains its three-dimensional aspect.

Options on the Drawing View Wizard let you choose:

- A 3D PMI model view as the drawing view source.
- Whether to copy the model view PMI dimensions to the drawing view.
- Whether to copy the model view PMI annotations to the drawing view.

Once the drawing view is created, you can clear these options on the General page of the Drawing View Properties dialog box to turn associativity on or off with the model view:

- Include PMI Dimensions From Model Views check box.
- Include PMI Annotations From Model Views check box.

To learn how to create drawings of PMI model views, see Create a PMI drawing view.

Creating drawings of alternate assemblies

When creating a drawing of an assembly that has been converted to an alternate assembly, you can use the Drawing View Wizard (Select Family of Assembly Member) dialog box to specify the assembly member you want. When you select the member from the Family Member list, a preview of the member is displayed. When you click the Next button, you can define any other assembly drawing view options you want. For example, you can specify that the drawing view is placed as a draft quality view.

Creating drawings of weldment assemblies (.asm)

When creating a drawing of a part in a weldment assembly, you can create drawing views that document the process-specific stages of the weldment process by first saving the part to a new name using the Save Model As command.

This is useful when the part has assembly features that represent weld preparation and post-weld machining operations. For example, you may need to apply chamfers to parts in the assembly before constructing a groove weld.
Creating drawings of weldments (.pwd)

When creating a drawing of a weldment, you can create drawing views that document the process-specific stages of the weldment process. When placing a weldment drawing view, you can use the View option on the Weldment Drawing View Options dialog box to specify whether the drawing view reflects the machined view, welded view, or assembly view. For example, when you set the Machined View option, you can place drawing views that document the post-weld machining that was done to the weldment.

If you defined weld labels in the weldment document, you can use the Tie To Geometry option on the Weld Symbol command bar to extract the weld labels into the drawing.

**Note**

When you set the Tie To Geometry option, only edges that have had weld labels assigned to them are selectable.

Creating drawing views automatically

You also can create drawing views quickly and automatically by dragging a Solid Edge document onto a drawing sheet. You can even place an open Solid Edge document onto a drawing sheet by dragging it from your Open Documents folder in the Library.

- When you drag an assembly model onto an empty drawing sheet, an isometric view is created.
- When you drag any other model file onto an empty drawing sheet, front, top, and right views are created.

You also can drag a model onto a Quicksheet template. With a Quicksheet template, you can customize the view types and properties, save the document as a template, and reuse it with any model you want. The views remain unlinked to a model file, but retain their properties. Or you can use one of the templates delivered with Solid Edge in the Quicksheet folder. Included assembly templates (metric and English) consist of one isometric view, parts list, and auto-balloon enabled. Included part templates (metric and English) consist of front, top, and right orthogonal views, and one isometric view.
Component geometry in drawing views

You can display constructions, coordinate systems, sketches, reference planes, and center lines in drawing views created from a 3D part or assembly. For model files on which mass properties have been calculated, a center-of-mass coordinate system is available when you display coordinate systems. When the part file you are using to create the drawing view contains construction geometry, Solid Edge Draft treats it as an assembly. Like an assembly, you can expand it in the Parts List box on the Display Tab of the Drawing View Properties dialog box. You can use the Parts List Options button on the dialog box to control the display of component geometry.

You can create a query to find a specific type of model component, and then hide all instances of it in the drawing view at once. Using a query in this manner, you can quickly simplify a drawing of a complex assembly model, without having to select and hide the individual components within each assembly part. To learn how, see Help topic use a query to hide components in a drawing view.

Documenting multiple parts in one Draft document

Solid Edge allows you to document multiple parts or assemblies in a single draft document. This can be an advantage when working with an assembly. For example, instead of creating a separate draft document for the assembly and each part, you can use the Drawing View Wizard command to place drawing views of the assembly document and the individual part documents into one draft document. This makes document management and maintenance much simpler.

The Drawing View Wizard command tracks the parts and assemblies that you place in a draft document. You can click the Drawing View Wizard command to place the drawing views of the first part or assembly. The next time you click the command the Select Part dialog box is displayed. The Select Part dialog box displays the documents that are currently placed in the draft document in a folder tree structure.

If you have placed an assembly document, you can select a part in the assembly as the basis for the next part view. If you want to create a part view for a part in a different assembly, you can use the Browse button to find the part on your computer or another computer on your network.
Principal views

After you place the initial drawing views on the drawing sheet using the Drawing View Wizard, you can use the Principal View command to create additional orthogonal or pictorial drawing views using an existing drawing view.

You specify the orientation of the new drawing view using the cursor. For example, to place a new principal view using an existing orthogonal view, first select the source view (1), then position the cursor to the right, left, top, or bottom to place a new orthogonal view (2), or position the cursor diagonally to place a new pictorial view (3).

When you use the Principal View command to place new drawing views, they are aligned with and are placed at the same scale as the source view.

**Note**

You cannot use the Principal View command to place a new drawing view using a section view, auxiliary view, or detail view as the source view.

Auxiliary views

The Auxiliary View command creates a new part view that shows the part rotated 90 degrees about a folding line. The drawing view is created from the axis of this fold line. You can create auxiliary views from principal views and existing auxiliary views.
Defining a folding line

The cursor is displayed as a line that is used to define the folding line. The auxiliary view is created perpendicular to this folding line. To define the folding line, move the cursor across the drawing view to highlight an edge that is perpendicular to the desired auxiliary view.

You also can define the folding line for a new auxiliary view by selecting two keypoints using existing drawing view edges. Two points are required when a single, linear element does not exist along the angle of the desired auxiliary view.
Placing the auxiliary view

After defining the folding line, the cursor is displayed as a rectangle that is roughly the size of the auxiliary view. To place the view, move the rectangle on the sheet to position the view, and then click.

Modifying the auxiliary view

After you place the auxiliary view, you can:

- Move the viewing plane line in any direction using Shift+drag.
- Change the viewing plane line type, caption, and style in the Viewing Plane Properties dialog box.

Detail views

You can use the Detail View command to create an enlarged view of a specific area of an existing drawing view. You can think of a detail view as a magnifying glass focused on a special area within a drawing view.

You can create circular detail views or detail views using a closed profile you draw. You can create dependent detail views that update when the source view changes, and you can create independent detail views that do not reflect changes made in the source drawing view. Similarly, independent detail views allow you to add geometry with the Draw In View command and show or hide edges with Edge Painter without affecting the source view.
Dependent and Independent Detail Views

- Dependent detail views are tied to the source view from which they are created. To change shading, edge display, or other aspects of the dependent detail view, you must make the change in the source view and then update both views.

- Independent detail views can have different display properties than the source drawing view. For example, you can show or hide parts, display hidden lines, add shading, or draw in the independent detail view without affecting the source drawing view.

- Both dependent and independent views can be created from 3D geometry contained in principal views, auxiliary views, other detail views, section views, and broken out section views.

- You can create a dependent detail view—but not an independent one—from a 2D Model view and from a drawing view that has been converted to 2D.

- You can not create detail views from drawing views that are out of date.

Converting dependent detail views

Once created, you can convert a dependent detail view to an independent detail view by selecting the view then selecting the Convert to Independent Detail View command on the shortcut menu. However, you can not convert an independent detail view to a dependent view.
Creating a circular detail view

You define a circular detail view using the Circular Detail View option on the command bar. You can then specify the detail view envelope using three clicks of the mouse. The first click (1) defines the center of the circular area to enlarge on the source view, the second click (2) defines the diameter of the detail view circle, and the third click (3) places the detail view.

Creating a user-defined shape for a detail view

You define a user-defined shape for a detail view using Define Profile option on the command bar. You can then draw a profile the size and shape you want. Any closed profile can be a valid detail envelope.
Modifying detail views

Once created, both dependent and independent views can be modified with different results. Dependent detail views are associative to the source view. When you make changes to the geometry in the dependent detail view, the source view changes. Independent detail views do not reference the source view, nor are changes made in the independent view reflected in the source view. Independent detail views can be used to show or hide parts, display hidden lines, add shading, or draw in the view without affecting the source view geometry or view properties.

Drawing view properties

To modify a dependent or independent detail view, use the Select tool and the Properties command on the shortcut menu. The Drawing View Properties dialog box displays the properties that you can change, which vary with detail view type.

Detail view tool tip

If you pause the cursor over a detail view, a tool tip identifies the name of the source geometry file, the file type, and the view type. For example, the full tool tip for an independent detail view of a screw might display: "High Quality View - Independent Detail View - AllenScrewM8.par." The tool tip text for a dependent detail view is simply "High Quality View - Detail View - AllenScrewM8.par."

If you don’t see these tool tips displayed on the drawing view, set the Show Tool Tips option on the Helpers page of the Solid Edge Options dialog box.

Detail view caption

You can add and edit a caption using the Caption text box and the Show Caption button on the Detail View command bar. You can reposition the detail view caption using the Select tool by clicking on the view then dragging the label to a new location.

Detail view border

You can hide the display of the border of the detail view after you place it. Click the detail view border, then click the Properties button on the command bar. On the Drawing View Properties dialog box, clear the Show Detail View Border option.
Detail envelope

The detail envelope drawn on the source view in the shape of a circle or user-defined profile defines the cropping boundary of the detail view. You can use the Drawing Standards page on the Solid Edge Options dialog box to set the display standards for the detail envelope. For example, you can specify that the detail envelope display conforms to (1) ANSI, (2) ISO/DIN/JIS, or (3) ESKD standards.

You can click and drag a detail envelope to change its location. However, if the detail envelope is partially or fully constrained, the detail envelope will behave according to the rules of its constraints.

You can modify the detail envelope by clicking it in the original view and then clicking Define Profile on the command bar. Select and drag the detail envelope profile handles to change the size of the detail envelope. Dependent detail views on the drawing are updated when you change the size, shape, or location of the detail envelope on the source view. If you delete the detail envelope on the source view, the detail view is also deleted.

Displaying cropping edges

You can use the Display Cropping Edges option on the Annotation page of the Detail View Properties dialog box to specify whether edges are displayed where the drawing view boundary intersects the model. Edges are not generated where the boundary passes over holes or voids in the model.

When you change this option on an existing drawing view, the drawing view becomes out of date. You can update the drawing view using the Update Views command.
Section views

After you create a part view, you can use it to create a section view. A section view displays a cross section of the 3D part or assembly model. Sectioned areas are automatically filled.

You can create section views with the Section View command and the Broken-Out Section View command.

Before you can create a section view with the Section View command, you must create a cutting plane on the part view you want to use as the basis for the section view using the Cutting Plane command.

You can use the Broken-Out Section View command to define regions you want to remove to a depth you define. This allows you to expose interior features of a part so you can document them. With the Broken-Out Section View command you draw the profile within the command.

Selecting a part view

When you click the Cutting Plane button you are prompted to select a part view. This can be any orthographic, auxiliary, or detail view on the drawing. Click on the view geometry to select it.

Auxiliary views often show the part at the optimal orientation for making the section cut. A detail view can be useful for creating sections due to its scale.

Sections created from detail views inherit the same scale as the detail view.
Lesson 3  Drawing Production Overview

Drawing a cutting plane

You draw a cutting plane using many of the drawing tools you find elsewhere in Solid Edge. When you click the Cutting Plane button and then select a part view, the command ribbon updates and displays commands for drawing a cutting plane.

A cutting plane can consist of a single line or multiple elements, such as lines and arcs. If you draw a cutting plane that consists of more than one element, the cutting plane must meet the following requirements:

- The elements must meet at their end points.
- The elements cannot form a closed region or have loops.
- The elements cannot cross each other.
- Any arcs in the cutting plane cannot be the first or last element.
- Any arcs must be connected to a line at both ends of the arc.

If you draw a cutting plane on a detail view so that it extends beyond the cropping boundary, then the geometry outside the detail view, to the extent of the cutting plane, will be included in the section view. If you draw the cutting plane so that it is completely contained within the detail view, then only that geometry will be included in the section view.

You can add dimensions and relationships between the cutting plane and the part view to control the position, size, and orientation of the cutting plane.

When you have finished drawing the cutting plane, click the Close button on the home tab. You can then dynamically define the cutting plane view direction by clicking on one side of the view to be sectioned. If you need to change the view direction, you can use the cursor to drag the cutting plane view direction lines to the opposite side of the cutting plane.

You can edit the cutting plane by double-clicking it, or right-click the cutting plane and select Properties on the shortcut menu.

Displaying the cutting plane

You can control the display of cutting plane and viewing plane lines and the caption text using the options on the Annotation page of the Dimension Style dialog box. You can set these options in your custom draft templates to make it easier to create cutting plane and view plane annotations that automatically conform to your standards.

You can hide or show the edges resulting from cutting planes created with multiple line segments using the Show Edges Created By Cutting Plane Line Vertices option on the Options dialog box or the Drawing View Properties dialog box.

You can hide the cutting plane by moving the cutting plane element to its own layer, and then hiding the layer. To learn how to do this, see the Help topic, Hide a Cutting Plane.
Placing the section view

When you select the Section View command, you are prompted to select a cutting plane. After you select the cutting plane, a rectangle the size of the section view you are going to place is displayed on the cursor. Also, options on the command bar are activated that allow you to specify the type of section view you want to create. When you position the view and click, the section view is created so that it is aligned with the cutting plane.

Note
The view direction of the section view is defined by the cutting plane. The side on which you place the view, relative to the cutting plane, has no effect on view direction.

Formatting fill and hatch patterns in section views

When you place a section view, you can select a fill style to define the pattern displayed in the sectioned areas of the part. You can also specify the spacing and angle of the fill area when you place the section view. If you want more control over the properties of the fill pattern, you can create a new hatch style, then use the hatch style to define a new fill style. Hatch styles allow you to define color, line width, spacing, and angle properties to apply to a pattern.

Revolved section views

On certain types of parts you can create a revolved section view to more accurately view the features on the part. To create a revolved section view, select a cutting plane consisting of two or more lines, then set the Revolved Section View option on the command bar. The Revolved Section View option is only available when you create a section view. You cannot change this option when you modify an existing section view.
Multiple segment cutting planes

If the cutting plane is defined by multiple lines that are not orthogonal, or the first and last lines in the cutting plane are not parallel, you must specify whether the first line (1) or last line (2) in the cutting plane will be used to define the fold angle for the section view rotation. The line you select affects the placement angle of the section view.

Arcs in cutting planes

You can also include arcs in cutting planes. If an arc is included in the cutting plane, it must be connected to a line at both ends. You cannot begin or end a cutting plane with an arc. Also, when you create a section view from a cutting plane that includes an arc, the Revolved Section View option on the command bar is automatically set and cannot be cleared.

Arcs are ignored for sectioning and view creation. Rather, they serve to carry the cutting plane line from one area of the model to another.

Note

You cannot create additional section views from a section view that was generated from a cutting plane that includes an arc.
**Section-only (thin-section or paper thin) views**

To create a section view that does not include the geometry behind it, use the Section Only button on the command bar. This option creates a section view where only the thin slice of geometry that intersects the cutting plane is displayed. The geometry that is beyond the cutting plane is not processed or displayed. For example, you can create a section view of a part in which the keyway feature is not displayed.

To further illustrate this, if you were to rotate a typical section view and a Section Only section view, you would see half of the part with a typical section view (1), but only a thin slice of the part with a Section Only section view (2).

This option is useful when creating sections of complex parts and assemblies where displaying the geometry behind the cutting plane would be confusing or unnecessary. Section views placed with the Section Only option also process faster than standard section views.

You can also create a revolved section view using the Section Only option.

To learn how, see Create a thin section view.
Thin section views of assemblies

When working with a large or complex assembly, the processing time improvement with the Section Only option can be significant because fewer parts are processed. For example, in Section A-A below, all the parts beyond the cutting plane must be processed in a standard section view, but when you set the Section Only option for Section B-B, only the parts that are intersected by the cutting plane line are processed.

Note

You cannot create additional section views from a Section Only section view.

Creating a section view from an existing section view

You can also create a new section view from an existing section view.
When you create a new section view from an existing section view, you can use the Section Only and Section Full Model options on the command bar to control the appearance of the new section view. For example, when you create the new section view B-B using Section A-A as the source view, there are four output options:

The Section Only and Section Full Model options are cleared

The Section Full Model option is set

The Section Only and Section Full Model options are set

The Section Only and Section Full Model options are only available when you create a section view. You cannot change these options when you modify an existing section view.

**Section views in assembly drawings**

For assemblies, you can specify which parts you want to section by using the Model Display Settings button on the Section View command bar. After the section view is created, you can change these settings by editing the properties of the section view.

The fill angle you specify for the section view is rotated 90 degrees for each sectioned part. After the section view is created, you can edit the fill and apply different styles and overrides.
Modifying section views

Placement and alignment
You can modify the placement and alignment of the section view directly on the drawing sheet. To modify the section view’s position, click and drag the view.

Hatching on cut faces
Hatching on partially visible cut faces is controlled by the Process Partially Hidden Cut Faces setting on the Advanced tab of the Drawing View Properties dialog. When you set this option and update the section view, any hatching on partially visible hidden cut faces is reprocessed. This can eliminate the need to remove excess hatching using the Draw in View function.

Simplifying the section drawing view
You can simplify a section or broken-out section drawing view so that the area exposed by the cutting plane is easier to see. Use the Set Drawing View Display Depth command on the drawing view’s shortcut menu to set the visible display depth beyond which all model geometry will be removed by a back clipping plane.

Showing cut and uncut hardware
You can use the Cut hardware check box on the Display page (Drawing View Properties dialog box) to specify whether hardware parts—such as nuts, bolts, and washers—are cut when intersected by the cutting plane in section views.

Displaying thread graphics
When the cut is along the axis of a hole shown in a paper-thin section drawing view, you can use the Show threads in Section Only section views option on the Annotation page (Drawing View Properties dialog box) to display hole threads.

Note
You can create internal threaded holes in the model when you use the Hole command and set the Type to Threaded on the Hole Options dialog box.

To learn about creating threaded holes in the model, see Threaded features.
Broken Views

You can create broken views in the Draft environment using the Add Break Lines command and the Broken-Out Section View command.

You can use the Add Break Lines command on the drawing view shortcut menu to define regions you want to completely remove in a part view. This allows you to create a broken view of a long, slender part so you can display it at a larger scale.

You can use the Broken-Out Section View command to define regions you want to remove to a depth you define. This allows you to expose interior features of a part so you can document them.

Draft quality and high quality views

Views fall into two general categories: draft quality and high quality.

For assembly models, which typically are larger and more complex than part or sheet metal models, you can generate either a draft quality or a high quality view. Draft quality views usually require less processing time than high quality views, and only visible lines are created.

For part and sheet metal models, you can only generate high quality views. High quality views are the default representations of the model.

You specify whether to create a draft quality view or a high quality view, as well as other view options, in the Drawing View Wizard.
View generation options

The view generation options displayed by the Drawing View Wizard depend upon the source model file type: .asm, .par, or .psm. Once the view is generated, you can make additional modifications using the tabbed Drawing View Properties dialog box.

Some of the drawing view generation and display options include:

- Whether the view is a draft quality or high quality drawing view.
- Whether the assembly model and/or its parts will be generated as simplified graphics.
- Whether part or sheet metal model graphics are displayed As Designed, Simplified, or Flat Pattern.
- Whether hidden and tangent lines will be visible in orthographic and/or pictorial views.
- Whether tube centerlines, if present, are generated.
- Whether to show material-removed or material-added assembly features, such as cutouts, holes, and chamfers, or weldments and protrusions.

Identifying views on a drawing

If you are looking at a drawing and want information about a particular view on the drawing sheet, there are two quick ways to get it:

- You can right-click the view and select the Properties command to display the Drawing View Properties dialog box. Here, the dialog box title bar displays information about the drawing view.
• You can use the tool tip feature. To see how this works, click the Select Tool, and then place the cursor on the drawing view border and leave it there. A tool tip identifies the view quality, the view type, and the name of the source model document. For example, the full tool tip for an independent detail view of a screw might display: "High Quality View - Independent Detail View - AllenScrewM8.par." The tool tip for a draft quality drawing view is shown in this illustration.

If you do not see tool tips displayed on the drawing view, set both of these options on the Tools→Options→Helpers tab: Show Tool Tips and With Enhanced Text.

Draft quality views

Available for assembly models only, a draft quality view is a quickly generated line rendering for display and annotation in the Draft environment. Only visible edges are created. Typically, draft quality views are used to produce interim design drawings and to provide a pictorial illustration of a ballooned parts list.

Draft quality views are particularly useful when working with very large assemblies, as the time it takes to generate the view is reduced. However, when you zoom in on a draft quality view created from a large assembly, you may notice that it displays at a lower resolution.

Creating draft quality views

To create a draft quality drawing view, set the Create Draft Quality Views option on the Assembly Drawing View Options dialog box of the Drawing View Wizard.
Using draft quality views

You can use draft quality views as input for principal views, auxiliary views, cutting planes, section views, and broken-out section views.

Adding Annotations—You can add annotations such as balloons to draft quality views and create parts lists from them. You can also place elements that connect to a drawing view with a leader, such as callouts and weld symbols. For these types of annotation operations, you can use inactive parts.

Adding Dimensions—Because dimension values are generated from the 3D model, you first need to use the Activate Parts command to make the model part data available for dimensioning.

Final Drawing Production—Although draft quality views can be shown in shaded and wireframe formats, only visible lines are generated. To achieve the best appearance for final drawing production, you may want to convert the draft quality view to a high quality format. To do this, use the Convert to High Quality View command on the selected drawing view’s shortcut menu.

High quality views

A high quality view is a drawing view that provides an accurate representation of the model because it is generated from Parasolid objects. High quality views may be used for precise operations, such as dimensioning, and for final drawing production.

Creating high quality views

The default settings on the Drawing View Wizard generate a high quality drawing view for assembly, part, and sheet metal models. You can start the Drawing View Wizard using the File→Create Drawing command or by selecting the Drawing View Wizard command button.

Converting draft quality to high quality views

To convert a draft quality view to a high quality view, use the Convert to High Quality View command on the selected drawing view’s shortcut menu.

Drawing view manipulation

After you place a drawing view, you can manipulate it to ensure that information is presented the way you want.

Scaling drawing views

You can scale a drawing view with the Properties option when a drawing view is selected.

A part view shares the same scale as the part view used to create it. If you scale an aligned part view, all part views aligned with it are also scaled. If you want to scale one aligned part view without affecting the others, you must first clear the Maintain Alignment option on the shortcut menu when a drawing view is selected.

Repositioning views

You can manipulate the view positions on the drawing sheet to better organize it. To reposition a view, click on the view and drag it to its new location.
Rotating drawing views

You can rotate a drawing view with the Rotate command.

When you rotate a view, it becomes unaligned. You can use the Maintain Alignment command to restore the view to its original orientation.

Dimensions on the drawing view rotate with the view. Dimensions that use the horizontal and vertical dimension axis of the sheet are modified to use the horizontal and vertical axis of the rotated drawing view coordinate system.

You cannot perform folding, cropping, or broken view operations on rotated views and you cannot derive section or auxiliary views from a rotated view. The rotated view cannot be used as input for the Principal Views, Cutting Plane, or Auxiliary View commands.
Shading drawing views

You can shade a drawing view using the Shading and Color tab of the Drawing View Properties dialog box. You can control texture display, reflection display, and flat shading, as well as specify whether assembly override and part face colors display in the drawing view.

You can also control basic shading (color or grayscale, as well as edge display) with these command buttons, which are located on the Drawing View Selection command bar, the Auxiliary View command bar, the Section View command bar, and the Principal View command bar.

Adding graphics to the view

You can add 2D graphical elements to part views, draft views, and 2D views using the Draw In View command on the selected view’s shortcut menu.

When the Draw In View window opens, choose any of the standard drawing tools to add line graphics, such as rectangles, arcs, circles, or ellipses, or add external images and pictures using the Image command on the Sketching tab.

Drawing view alignment

Drawing view alignment ensures that when a source drawing view, or any of the views created from it, is moved or scaled, that the position of all related views is adjusted to maintain a horizontal/vertical or parallel/perpendicular relationship with the manipulated view. The view alignment relationship is indicated by a dashed line.

New principal, auxiliary, and section drawing views are automatically aligned to the source part view used to create them. However, when views are created from the 2D model space, you need to create and define their alignment position.
Creating and Deleting View Alignment

You can use the Create Alignment command on the shortcut menu to create alignment between drawing views based on the centers of the views or on selected keypoints within them. You can use the Delete Alignment command to delete an alignment you have created when it is no longer needed.

Unaligned Views

There may be times you want a view to be unaligned temporarily, for example:

- To scale a view independently of other views
- To move the view to another sheet.

Unaligned views are noted by a jog indicator.

If you need to move a drawing view to another sheet or scale the view, you can toggle the alignment relationship off with the Maintain Alignment command on the shortcut menu. After you move or scale the part view, you can again click Maintain Alignment on the shortcut menu to re-establish the alignment constraint.

Drawing view cropping

If you want to show only part of a drawing view, you can crop the drawing view. Cropping does not change the drawing view scale. Rather, it limits the portion of the view that is displayed on the drawing sheet.

You can crop any type of drawing view except a detail view. After you create a cropped view, you can use the Show Cropping Edges option on the Annotation page of the Drawing View Properties dialog box to specify whether cropping edges are displayed and what edge style is used.

There are two types of cropping boundaries you can define:

- A rectangular cropping boundary.
- A custom cropping boundary.
Rectangular cropping boundary

To crop a drawing view by resizing the original cropping boundary, first select it to display its border. Then drag one of the border’s handles (1) until only the geometry you want to see is visible (2).

Custom cropping boundary

You can use the Modify Drawing View Boundary option on the Drawing View Selection command bar to draw a non-rectangular cropping boundary.

When you click the Modify Drawing View Boundary button on the command bar, the drawing view is displayed in a special cropping window. The rectangular boundary is converted to four endpoint connected line segments.
You can use the 2D drawing tools to redraw the view cropping border. You can use any combination of lines, arcs, and curves to define the cropping boundary profile. However, the new cropping boundary profile must be closed. To use a portion of the existing rectangular boundary in the custom profile, draw 2D elements that connect to the existing line segments. Use the Trim command to remove the unneeded line segments.

To draw a new boundary profile, delete all the existing line segments and then draw the new boundary using the 2D drawing tools.

When you have finished drawing the custom boundary, you can click the Close Cropping Boundary button on the Home tab to exit the cropping window.

For more information, see Help topic: Example: Modify a drawing view cropping boundary.

**Displaying cropping edges**

When you crop a drawing view, you can use the Display Cropping Edges option on the Annotation page of the Drawing View Properties dialog box to specify whether edges are displayed where the drawing view boundary intersects the model. Edges are not generated where the boundary passes over holes or voids in the model.

When you change this option on an existing drawing view, the drawing view becomes out of date. You can update the drawing view using the Update Views command.
Uncropping a drawing view

You can return a cropped drawing view to its original display using the Uncrop command on the shortcut menu.

Removing Geometry from a View

By specifying a drawing view display depth for a back clipping plane, you can simplify any type of drawing view so that geometry behind the plane is removed from the view. This feature can be used, for example, to reduce the visible clutter behind a section view or a broken-out section view.

In this illustration, the hashed line in (1) indicates where the back clipping plane will be applied to the original drawing view display. The orthographic view (2) shows the dynamic line tool used to define the display depth and the location of the back clipping plane. The result (3) shows how the drawing view geometry in front of the plane was trimmed and the geometry completely behind the plane was removed.
A drawing view display depth and clipping plane can be defined for any type of view: orthographic, pictorial, section, auxiliary, and detail views. Dimensions and annotations that are attached to edges removed by the drawing view clipping plane are detached, also.

The Set Drawing View Depth command specifies a visible display depth for the drawing view, and then it applies a back clipping plane. Geometry behind the plane is removed from the drawing view when you update the view.

To adjust the location of the back clipping plane so that more or less geometry is visible, select the Set Drawing View Depth command again and then specify a different depth value.

To remove the drawing view clipping plane and restore the drawing view to its original display depth, use the Remove Defined Depth command from the drawing view’s shortcut menu and then update the view.

**Drawing view updates**

When you change parts and assemblies depicted in part views, you can easily update the views so they match the new model geometry. This works because part views are associative to the 3D part or assembly they were created from. For example, if you add a hole to a 3D part in the Part environment and then update the part view in the Draft environment, the hole geometry is added to the 2D drawing.

When a drawing view is out-of-date with respect to the 3D model, the software displays a solid border or box around it on the drawing sheet. To update the drawing view display as well as the retrieved dimensions, use the Update Views command.

**Tools for checking drawing view out-of-date status**

There are several tools that work together to identify drawing view out-of-date status conditions.

- **Drawing View Tracker**

  The Drawing View Tracker checks for both out-of-date geometry in part views and out-of-date model status in the document and provides specific instructions for what to do to update them. When you open a document with out-of-date
part views, Drawing View Tracker displays a warning that the views need to be updated before dimensioning.

- **Assembly Configuration Changes Make Drawing Views Out-of-Date In This Draft File option**
  
  This option (on the General page of the Solid Edge Options dialog box) is an automatic check for display configuration changes for all assembly views in the draft document that have the Configuration Match option enabled. Display configurations store both the show/hide and the simplified/designed status of the parts in the assembly. When this option is set, changes to an assembly configuration associated with a drawing view will make the view out-of-date. All drawing views in the document are checked automatically.

- **Configuration Check**
  
  This option (on the Display page of the Properties dialog box for a selected drawing view) is a manual check for display configuration changes for the assembly shown in the currently selected drawing view.

- **Configuration Match**
  
  This option (on the Display page of the Properties dialog box for a selected drawing view) controls whether show/hide part settings in the drawing view match the show/hide settings within the assembly configuration. Views without this option set will not be out-of-date after changes are made to an assembly display configuration.

**Using the Drawing View Tracker**

The Drawing View Tracker provides specific information on updating both out-of-date part views and out-of-date models. While a view becomes out-of-date when the 3D model to which it is associative changes, a model becomes out-of-date when links external to the Draft environment change. Out-of-date model causes may include, but are not limited to:

- A part file modified outside the context of its parent assembly file
- Broken internal links in a part file

Out-of-date model conditions cannot be resolved inside the Draft environment. Because different circumstances can cause an out-of-date model condition, the Drawing View Tracker provides step-by-step instructions for updating out-of-date models in the current document. Solid Edge displays a solid border around an out-of-date view (1), a corner border around an out-of-date model (2), and both a solid border and a corner border when both out-of-date view and out-of-date model conditions apply (3).

![Diagram](spse01545)
Correcting an out-of-date model condition usually causes an out-of-date view condition.

**Failed dimensions after updating part views**

When you update a part view, a dimension may fail to update because the edge it referred to is no longer displayed in the part view. For example, if you deleted a hole feature in the part model, the edge representing the hole will be removed from the part view when you update it.

When a dimension fails to update, it changes to the "failed" or detached color. The color change helps you detect failed dimensions easily, so you can edit the drawing. All failed dimensions for a part view form a single selection set, in case you want to delete them all at once.

**Reattaching dimensions**

Sometimes you may want to reattach failed dimensions in a drawing. For example, if you delete one of several holes that comprise a single hole feature on a part, and the edge representing the hole was dimensioned on the drawing, the dimension will fail. Instead of deleting the dimension and placing a new dimension, you can drag and drop the dimension line handle point to one of the remaining hole edges on the part view. This saves time because any prefixes, tolerances, and other formatting on the failed dimension are applied to the new dimension. You can also drag and drop the dimension line handle point(s) to different parent object(s), even if they have not failed.

**Tracking changed dimensions and annotations**

Wherever possible, Solid Edge attempts to rebind dimensions and annotations that were detached after a drawing view update.

All changed dimensions and annotations, whether they have been repaired or not, are reported in the Dimension Tracker dialog box. To activate this dialog box, select the Tools→Dimensions→Track Dimension Changes command.

To learn more, see [Tracking dimensions and annotations](#).
Drawing properties

Drawing property text

Drawing property text is text that is associative to properties in the current draft, part, or assembly file, as well as properties in models attached to the current file. Property text is variable text that is referenced and maintained without manual editing. For example, you can use property text to display a file’s name and last modification date, and this information will change when you save the file or select the Update Property Text command.

You can create or edit property text while creating or editing callouts, balloons, and parts lists. To add property text, use the Property Text button on the respective dialog boxes or command bars:

In some cases, you may want to change property text to plain text that is not associative to the drawing. To convert a specific drawing property text, first select the text in the drawing, then use the Convert Property Text command on the shortcut menu.

To convert all drawing property text to plain text at once, use the Tools-Convert All Property Text command.
Drawing View Properties

Drawing view properties define every display aspect of a drawing view or a 2D Model view. They are set and modified on the Drawing View Properties dialog box. This multi-tabbed dialog box displays options that vary with the type of view you are creating or modifying and whether it is a high quality view or a draft view.

- General tab—Defines the drawing view name, scale, and display characteristics. Not all options are available for all view types.
- Display tab—Defines the part display, edge display overrides, and section view options of part views. This tab is not available when you select a 2D view.
- Text and Color tab—Defines the caption text options and dimension style for the drawing view or the detail envelope.
- Sections tab—Displays a list of the 3D sectioned cutaway views available for the drawing view. This tab is available if the drawing view is a high quality drawing view.
- Part Edge Display Defaults - Defines edge display defaults for part views. These defaults are initially derived from the settings on the Edge Display tab of the Options dialog box, as well as Drawing View Options in the Drawing View Creation Wizard (which override settings on the Display tab). However, when you save the file, these default values are saved with the view, and they override any other settings the next time you open the file.
- Annotation tab—Defines the annotation display defaults for centerlines, detail borders, and drawing view captions.
- Model Options tab—Defines the drawing view options for simplified parts and assembly features.
- Simplify tab—Displays simplify part options available for the drawing view.
- Shading and Color tab—Defines the shading and color options for the drawing view.
- Advanced tab—Defines advanced display and processing options for the drawing view. The settings on this Advanced tab of the Drawing View Properties dialog box take precedence over their counterparts on the Advanced Edge Display Options dialog box (Solid Edge Options→Edge Display tab→Advanced button).

Reference Parts

Sometimes you may want parts or subassemblies to be included on a drawing, but only for reference purposes. Reference parts typically provide a frame of reference for the components in the drawing view to a higher level assembly or to a completed product.

You can specify that a part or subassembly is a reference part when you are placing a part view of an assembly or you can edit the drawing view properties for the part view later. The Display As Reference option on the Display tab of the Drawing View Properties dialog box allows you to specify that a part or subassembly is a reference part.
Reference parts

Sometimes you may want parts or subassemblies to be included on a drawing, but only for reference purposes. Reference parts typically provide a frame of reference for the components in the drawing view to a higher level assembly or to a completed product.

For example, when creating a drawing of the head subassembly (1) for a grinder, you may want to display the case and switch (2) as reference parts to illustrate the relationship between the head subassembly and the completed product.

You can specify that a part or subassembly is a reference part when you are placing a part view of an assembly or you can edit the drawing view properties for the part view later. The Display As Reference option on the Display tab of the Drawing View Properties dialog box allows you to specify that a part or subassembly is a reference part.

In an assembly, you can also use the Occurrence Properties command to specify that an assembly occurrence is a reference part. You can then set the Derive "Display As Reference" From Assembly option on the Drawing View Properties dialog box to display the component as a reference part in the drawing.

Reference parts and parts lists

When creating a parts list of an assembly, you can use the Exclude Reference Parts option on the List Control tab on the Parts List Properties dialog box to control whether reference parts are included in the parts list.

Defining Drawing Standards

The first time you load Solid Edge at your company, you should consider setting standards to apply to the drawings you create in the Draft environment.

Although you can change the settings in the Draft environment to meet company requirements each time you create a Draft document, you will be more productive if you set up one or more Draft documents with the standard settings you need. You can then use these documents as templates for all of your drawings, making it easier for all users to conform to company standards.

When setting your drawing standards, consider the following:

- Background sheet graphics for your drawing borders
• The projection angle you want
• The thread depiction standard you want
• The edge display symbology you want for the drawing views
• The standard you want for the dimension style
• The fonts you want for text on your drawings

Creating New Documents

When you use the Document option, the working units for the new document are based on the option you selected when you loaded the software. For example, if you selected the Metric option, the working units will be metric; if you selected the English option the working units will be English.

The advantage to this approach is that graphics for the background sheets already exist in the new document. You can customize these graphics by adding your company logo and any other graphics you want.

Creating Background Sheet Graphics

Most companies use custom graphics for their drawing borders. These graphics can include title block information, zone markings, company logos, and so forth. You can create the graphics you need from scratch or you can translate graphics from AutoCAD, MicroStation, or EMS using the Open command on the File menu.

If you are creating the graphics from scratch, you should consider modifying the generic background sheet graphics in the templates you use to create new documents.

These graphics have been sized correctly for the standard English and metric sheet sizes. You can easily delete and add graphics to meet your requirements. You can use the Grid command to precisely position the new graphics you place.

If you translate graphics from another CAD system, they will be placed on the working sheet. You can then cut and paste them to the background sheet.

After you have created your custom graphics for the sheet sizes you use, you can delete the background sheet graphics for any sizes you do not use. Doing this will reduce the size of your standard Draft document.

Setting the Projection Angle

When you create drawing views that are folded from an existing drawing view, they are created using either first angle or third angle projection. You can set the projection angle you want on the Options dialog box.
Setting the Thread Depiction Standard

When you create drawing views that contain threaded features, they are displayed using the ANSI or ISO standard for thread depiction. You can set the thread depiction standard you want on the Options dialog box.

Note

When constructing parts with industry standard threads, you should typically use the Hole or Thread commands, not the Helical Protrusion or Helical Cutout commands.

Helical features require significantly more memory to construct and display in part documents, and take significantly longer to process in a drawing view. You should only use helical features where the actual shape of the helical feature is important to the design or manufacturing process, such as with springs and custom or unique threads.

Setting the Edge Display Symbology

You can set the edge display symbology for visible, hidden, and tangent edges for drawing views so they are displayed according to the standards for your company or industry. For example, your company may not show hidden edges on the drawings you create. Also you may use a different line thickness for visible and hidden edges. You can set the Edge Display options you want on the Options dialog box.

Selecting the Standard for the Dimension Style

Solid Edge is delivered with dimension styles for commonly used drawing standards including ANSI, ISO, DIN, and so forth. The Style Type option on the Style dialog box is used to choose the dimension style you want.

After you select the dimension style you want, you can modify the settings within the style to conform to the standards for your company. For example, you can choose the font, font size, working units, and so forth for the dimensions you place. You can also create new styles that are based on one of the existing styles.

Setting the Text Font

For text you place on drawings, you will want to modify the text style settings to meet your standards. You can also create new text styles for the different types of text you place. For example you may use a different font for text in the title block than the text for notes.

By creating additional styles, you can quickly change all the text settings to match your needs. Defining the text styles in your standard Draft document will also ensure that all users place text that meet the standards for your company.
Maintaining your Standard Draft Documents

After you have finished creating your standard Draft documents you should test them to ensure that they meet your standards and make any modifications that are needed. You should archive a copy in case the originals are accidentally deleted or modified. If you have multiple users at your company, you should place your standard Draft documents in the folder where the other Solid Edge templates are stored.

When you load a new version of Solid Edge in the future, you should create new standard Draft documents again. This will ensure that any enhancements made to the document structure in the software are incorporated properly.

Using Hyperlinks

Working with hyperlinks

You can use a hyperlink to link an object or element on a drawing sheet to a file or URL. You can add a hyperlink to any Draft object or element that supports user properties. Drawing views, 2D line geometry, blocks, drawing views, dimensions, and some annotations are examples of some of the items that support hyperlinks.

You can use hyperlinks to:

- Link to a company Website to obtain material information or vendor specifications.
- Link to a local file that contains detailed information about some aspect of the drawing, such as weld specifications, assembly procedures, finite element analysis calculations or design criteria.
- Link to an image file, such as a logo, an installation illustration, or a photograph of a reference part.
- Link to a database for Material Requirements Planning (MRP) or Engineering Change Notices (ECNs) to get information for the drawing title block.
- Link to another Solid Edge document.

When you click an object hyperlinked to a file, the target file opens in the default viewer assigned to that file-type. When you click an object hyperlinked to a URL, the web page associated with the URL is opened in a default browser.

Enabling hyperlink mode

To get started, you must enable hyperlinks. Selecting the Insert→HyperLink command lets you:

- Add, edit, and remove hyperlinks between objects on the drawing sheet and external files or URLs.
- Select, open, and display the targets of previously created hyperlinks on the drawing.
Hyperlink pointers

In hyperlink mode, you see two different kinds of pointers when the mouse moves across objects and elements on the drawing sheet.

When this pointer is displayed, it means a link has not been assigned to the object or element. You can left-click to select it and add a hyperlink:

When this pointer is displayed, it means there is an existing hyperlink defined for the object or element:

In this case, you can left-click to follow the link, or you can right-click to edit, remove, or view the hyperlink target name associated with the object or element.

Adding and editing hyperlinks

In hyperlink mode, you can add, edit, and remove hyperlinks from 2D objects and elements. Items that are not highlighted are not hyperlinked.

- To add a link, left-click an object, or right-click the item and select the Add/Edit Link command from its shortcut menu. The Hyperlink dialog box is displayed for you to type a source URL or a target file path name. You also can use the Browse button to locate the file through your computer file system.

- To edit a link, right-click the object and select the Add/Edit Link command from its shortcut menu.

- To remove a link, right-click the object and select the Remove Link command.

Opening hyperlinks on a drawing sheet

When you select the HyperLink command, all objects with previously defined hyperlinks are highlighted at once on the drawing sheet. This identifies the items that have attached files, such as specification documents and installation instructions, or referenced web pages.

- When you left-click an object hyperlinked to a file, the target file opens in the default viewer assigned to that file-type.

- When you left-click an object hyperlinked to a URL, the web page associated with the URL is opened in a default browser.

- To display the target name without opening it, right-click the hyperlinked object or element and look at the text displayed to the right of the Open command.
2D drawing views and 2D model views

2D drawing views

A 2D drawing view consists of two-dimensional elements. It is not associative to a 3D model. A 2D drawing view allows you to quickly create or modify a drawing view without making changes to a part or assembly.

To create a 2D drawing view of a part or assembly, you can convert a 3D part view or you can draw the 2D graphics yourself. You also can import a 2D design file and then create 2D views from it. You can layer 2D graphics on top of a 2D view.

Whenever you add or edit 2D graphical elements, a full range of drawing tools is provided. These include drawing and relationship commands that make it easy for you to draw an accurate 2D representation of a part or assembly.

Note

For more information about 2D drawing in Solid Edge, see the Drawing 2D elements Help topic.

2D model views

2D model views are scaled 2D drawing views placed on working sheets of geometry that reside at full scale on the 2D Model sheet. You can create multiple 2D model views that reference the 2D model geometry, and you can customize the cropping boundary for each view created from the geometry on the 2D Model sheet.
Creating a 2D drawing view

There are several commands related to creating a 2D view from existing graphics:

- 2D Model View command—Creates a 2D view that references geometry on the 2D Model sheet. Use the Drawing Area Setup command, which is available only for the 2D Model sheet, to set up a scaled work area in 2D model space.

- Convert to 2D View command—Converts a 3D part view to 2D geometry. Once you convert a part view to a 2D view, associativity to the part or assembly document cannot be retrieved.

- Draw In View command—Available for a 3D part, assembly, or sheet metal view placed on a working drawing sheet, this command opens a 2D View Edit window for you to draw in the view and to add annotations at a 1:1 scale.

- 2D View command—Superseded by the 2D Model View command, but still available through customization.

2D drawing scales

When drawing inside a 2D view placed on a working sheet, you typically work at 1:1 scale. You also can draw directly on the working sheet. If you decide later that you want to scale graphics you have drawn directly on the sheet, just move or copy them into a drawing view with the Cut, Copy, and Paste commands.

The dimension and annotation sizes on the working sheet are independent of the drawing view scale. For example, if you define the height and size of dimension text as 0.125 inches or 3.5 millimeters, these are the actual values of the dimension text on the printed drawing.

Using the 2D Model sheet

You also can work on the 2D Model sheet in 2D Model space. The Drawing Area Setup command defines a scaled work area where you can create, edit, and annotate a 2D design at a scale appropriate to the size of the part or assembly, yet print at a scale appropriate to the dimensions of your drawing sheet.

The Auto-Hide layer is available at all times when working on the 2D Model sheet.
**2D Model view workflow**

This workflow is used to create a 2D model view in a draft document.

First, use the 2D Model Sheet command to display the full-scale 2D Model sheet. There is one 2D Model sheet per document.

Next, use the Drawing Area Setup command to define a work space on the 2D Model sheet.

Next, place or create the design geometry on the 2D Model sheet, using any combination of design file import, dragging an existing .dft file onto the sheet, and 2D line drawing tools.

On the working drawing sheet, use the 2D Model View command to create one or more 2D model views that reference the 2D model geometry. You can customize the clipping boundary for each view created from the geometry on the 2D Model sheet, and assign a unique caption to each view.

**Creating detail views from a 2D model view**

You can use the Detail View command to create a dependent detail view from a 2D model view or a drawing view that has been converted to 2D geometry. You can create a detail view that displays a circular envelope or a detail view with a custom boundary.

Click [here](#) to learn more about Solid Edge detail views and the procedures for creating them.

**2D views and associativity**

If you set the Maintain Relationships option in the Relate group on the ribbon, the graphics you draw in a 2D view can be updated associatively, similar to the profiles you draw in the Part environment. You can place driving dimensions and apply relationships to control the size and location of the elements.
Hiding construction graphics, dimensions, and annotations

When you want to hide elements in a drawing view but you do not want to assign the hidden elements to individual layers, you can use the Auto-Hide layer. You can hide construction geometry, dimensions, and certain annotations. For example, you can place dimensions on the 2D Model sheet Auto-Hide layer to drive the size of the geometry but not display when a drawing view is placed on the working sheet.

- The Auto-Hide layer is available while you are drawing and dimensioning on the 2D Model sheet. You can use the 2D Model View command to create a drawing view of the 2D Model sheet geometry, and all elements on the Auto-Hide layer are hidden automatically.

- The Auto-Hide layer also is created automatically when you right-click a drawing view and choose the Draw In View command. When you close a Draw In View window, elements on the Auto-Hide layer are hidden automatically.

Completing the 2D view

When you finish drawing in a 2D view on the working sheet, click the Return button on the command bar to close the 2D View Edit window. After you close the 2D view window, you can add driven dimensions and annotations, such as weld symbols, feature control frames, and so forth to the drawing sheet.

If you are working in 2D model space on the 2D Model sheet, you can add and edit annotations and dimensions directly on the sheet. The graphics you add on the 2D Model sheet are visible in the 2D view on the working sheet when you click the sheet tab.
Editing 2D views

When you need to edit 3D model graphics in a 2D view, double-click the view. You can also use the Draw in View command on the shortcut menu.

If the 2D view graphics were created from the 2D Model sheet as a block, or dragged onto the sheet as a file, then you can use the Open command on the shortcut menu to open the graphics for editing. Or you can use the Unblock command to drop the block to its base elements for individual manipulation.

If you created the 2D view associatively, you can edit the driving dimensions to modify the graphics. When you close the 2D view, the driven dimensions you placed on the sheet will update.

Drawing area setup in 2D model space

In a draft document, you can draw, design, annotate, and dimension on the 2D Model sheet. The 2D Model sheet is a special sheet used exclusively for working in 2D model space. It enables you to draw on the sheet and to annotate at a scale appropriate for the overall size of the part you are designing, yet it prints your drawing with annotations appropriately scaled to the output sheet size you specify.

- To display the 2D Model sheet, select the View tab → Sheet Views group → 2D Model command, and then click the document sheet tab labeled 2D Model.

- To set the size and scale of your work area on the 2D Model sheet, select the Application menu → Drawing Area Setup command. Work area setup calculations are made automatically based on sheet size and the dimensions of your intended design.

Schematic Diagramming using Blocks and Connectors

Blocks and connectors are used together to create schematics and flow diagrams in the Draft environment. Create and arrange the blocks on the drawing first using the Block command, and then add the connectors using the Connectors command.
Using blocks

The block and connector diagramming tools assist you in developing electrical, P&ID, and other diagrams. Solid Edge provides a library of industry-standard 2D blocks and access to all of your AutoCAD blocks through on-the-fly conversion. Intelligent connectors quickly snap to keypoints on the blocks and create associative links that are easily updated.

With convenient access to block libraries and functionality via the Library window, a block can be selected and placed in the active document with different representations, or views, without the overhead of duplicated graphics and data. When a design changes, you can easily replace or delete all occurrences of a block with one command. Property text can be referenced in block labels, which in turn can be referenced in annotations such as callouts.

Differences between blocks and symbols

Symbols use embedded draft documents, whereas blocks do not.

Blocks reduce file overhead because they do not insert duplicate geometry and data into the draft document.

Like symbols, blocks can be created and edited only in the Draft environment.

Block terminology

In this table of Solid Edge block terminology, if there is a different, equivalent AutoCAD term, it is shown in parentheses.

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block</td>
<td>A generic term for a named collection of one or more 2D elements or objects that can be selected and referenced as a single entity. A block consists of both graphics and data.</td>
</tr>
</tbody>
</table>
### Block occurrence (instance)

A block that has been placed on a sheet in the draft document. Each occurrence references a master block and displays it at the specified location. By editing the block occurrence graphics, you edit the data in the master block.

A block occurrence is generated with the Place Block or copy/paste commands.

### Master block (block master)

The combined graphics and data used to define a block. A master block is like a template or prototype for block occurrences.

A master block is created with the Block command and edited with the Open command.

### Block view

An alternative graphical representation of a master block. For example, a switch shown in the open and closed states has two block views.

A block view is created with the Add Block View command.

### Block library

A collection of block files that can be used in many documents and accessed by different designers. A block library also can be a single file containing many blocks.

### Block file

Files with the extension .dft, .dwg, or .dxf that contain one block or many related blocks. Block files can be imported using the AutoCAD Import Translation Wizard. Block files also can be converted to Solid Edge format by double-clicking them in the Block Library or by dragging and dropping the file onto the drawing. See Importing Existing Blocks and Placing Blocks, below.

### Block label (Attribute)

An object that contains one name-value pair and can be included in a master block definition to store alphanumeric data. Label values can be predefined or specified when the block is inserted as an occurrence. Label data can be extracted from a drawing and inserted into external files.

A block label is created with the Block Label command.

### Block properties (Attributes)

Both block graphics and block labels possess properties.

General Properties—One or more name-value pairs that pertain to the general appearance of the block. Typically, these name-value pairs identify the type of component, part, or element the block represents.

Label Properties—A name-value pair that provides specific alphanumeric information, notes, sequence numbers, or other details about a block.

All block properties are referenced by the same “Block Properties” property text, GBLK.

## Importing existing blocks

There are several ways to import AutoCAD blocks into Solid Edge.

One method is to use the File→Open command, and then click the Options button on the File Open dialog box to select translation options. There is an option to specify whether to import AutoCAD .dwg or .dxf files as a block or as a group. The default is to translate them as a block. When importing a block with attribute text, the text is imported as Solid Edge text and is added to a group containing the block and the text. The AutoCAD Import Translation Wizard guides you through the steps.
Lesson 3  

*Drawing Production Overview*

You can drag an entire .dwg or .dxf block file directly into the Library from Windows Explorer, whether or not the Block Library functions are displayed, and the file is translated to Solid Edge block format automatically. If the file contains multiple blocks, then this on-the-fly file translation method creates multiple blocks in the Block Selection Pane. If the file contains geometry but no block definitions, then translation generates a single block from the contents of the file. To separate the contents into individual blocks, use the Unblock command.

You also can select and place individual blocks from a .dwg, .dxf, or .dft file listed in the Block Library File List. When you click one of these file types in the Block Library File List, on-the-fly file translation displays the names of all blocks in the file in the Block Selection Pane. This method lets you preview and choose the individual blocks to insert from the file directly into the Solid Edge active document.

![Creating new blocks](image)

**Creating new blocks**

You can create new blocks in Solid Edge using the drawing tools to create the geometry and the Block command to define the graphics as a block. Click the Block command button then follow the prompts on the Block command bar to select its contents, assign an origin point, and assign a descriptive block name. When you click Accept, the block name is added to the Block Selection Pane for use in the active document. To exit create block mode, click the Select tool or press the Esc key.

To learn how master blocks, block views, and nested blocks are identified, see the Help topic, *Displaying Blocks in the Library.*

To create one or more blocks from blocks in an existing draft file, you can simply click a file name in the Block Library to open it, and then drag individual blocks from it onto the drawing sheet or 2D Model sheet. Use the Unblock command to unblock the geometry, and then use the Block command to create new blocks from the geometry. Also see Adding Alternative Block Views, below.

You also can create a block and simultaneously add it to the library by selecting and dragging 2D elements from the drawing sheet into the Block Library File List. This creates a block file with a default Symbol.dft file name, and it removes the geometry from the drawing sheet. Even though the block has a default symbol name, it is still a block. You can select the block in the library, and then use the Rename command on the file's shortcut menu to rename the file. Alternatively, you can use the Edit→Copy To Library function to both create and rename the block, without removing the geometry from the drawing sheet.

To learn about block libraries, see the Help topic, *Organizing Block Libraries.*

![Creating and placing block labels](image)

**Creating and placing block labels**

Block labels provide alphanumeric information about the master block or block view. New block labels can be created using the Block Label command. Existing labels can be copied and pasted between blocks on different sheets and in different documents.

There are several ways you can add labels to a master block or block view. You can define a block label and then include it in a master block or block view during the block creation process. Alternatively, you can add a label to a block that you edit with the Open command. When you drag an entire .dft, .dwg, or .dxf file as a block, and if the file contains labels, then the labels are added to the master block that is created automatically in the active document.
When a block that contains a label is placed in the document, the block label attributes update in the occurrence based upon the settings defined for the label in the master block. If the label requires you to confirm or enter a value for the current instance, the Block Label Properties dialog box is displayed for you to edit the information.

Only labels contained in a top-level block of a nested block are prompted for on placement.

When a block is copied and pasted, dragged onto the drawing sheet, copied in a pattern, moved or rotated, no prompt is displayed for the new occurrences. The copied blocks have the same value as the source block.

Adding alternative block views

Each block view is a master block that defines a specific set of geometry, for example, different states, locations, and configurations. All block views share the same block properties.

To create a block view, first manipulate the graphics on the drawing using the drawing tools or view commands, then right-click the master block name in the Block Selection Pane and select the Add Block View command from its shortcut menu.

If you want to create a block view from an existing block occurrence and if the occurrence is not selectable, first use the Unblock command to unblock the occurrence, then fence-select the graphics for the block view.

It is fast and easy to create master blocks and alternative block views by dragging a .dft, .dxf, or .dwg file that has several 2D views of the same graphics into the 2D Model sheet. If the file translates as a single block rather than individual blocks, use the Unblock command first to make the graphics individually selectable. Next, use the Block command to select and define the master block, for example the front view of a sink. Then, use the Add Block View command and the fence-select technique to define alternative views, such as Sink Top View and Sink Side View.

Blocks and groups

Blocks can be organized into groups. Grouping makes it easy to select multiple entities at once, especially in a complex drawing. Individual blocks can be grouped together using the Group command.

Groups cannot be selected for inclusion in a block. However, you can include the contents of a group if you first use the Ungroup command. Also, you can locate and select an individual item within a group for inclusion in the block using either QuickPick or the Bottom Up command button on the Select Tool command bar. The object is removed from the group when it is included in the block.

Nested blocks

A nested block is a block that is included in another block.

The benefit of creating a diagram using nested blocks is that nested blocks are easy to select and place. Also, you can easily replace all of the occurrences of a sub-block within the nested block using the Replace command.

To create nested blocks, create the sub-blocks first, then fence select the sub-blocks to create another block that includes them all. For example, you can draw an arrow, create a block from it, and then include the arrow as a sub-block in other blocks.
Defining properties for block graphics and block labels

Adding properties to the master block ensures that all block occurrences carry the same attributes.

When creating new blocks, you can define properties that identify the physical aspect of the block, such as the type of component, part, or element the block represents. These properties consist of one or more name-value pairs. Block properties are accessed during master block/block view definition using the Block Options command on the Block command bar, which in turn displays the Block Properties dialog box. Properties are entered in the Name and Value fields.

When creating new labels, you can define properties that identify specific alphanumeric information, notes, sequence numbers, or other details about a block. Block label properties are entered in the Name and Value fields on the Block Label Properties dialog box, which is displayed when you click the Block Label command.

The information entered in the Name and Value fields on both the Block Properties dialog box and the Block Label Properties dialog box can be extracted into callouts, balloons, and similar annotations.

You can update master block and block occurrence properties and values. To globally edit the properties of an existing master block and all block occurrences in the active document, use the Properties command from the master block’s shortcut menu in the Library.

You can add or modify properties of all of a block’s occurrences in the drawing using the Properties command on the block occurrence’s shortcut menu.

Block views you create inherit their properties from the master block. You cannot edit the properties of a block view in the Library, but you can edit it as a block occurrence after it is placed in the drawing.

Property edits made to occurrences in the drawing are updated to the respective source blocks in the Library.

Referencing block property text in annotations

Callouts, balloons, and similar annotations that are connected to blocks with defined properties will update to display the property text associated with that block when the block is placed. The annotations can be included in the master block or block view definition, or they can be added to a block occurrence on the drawing sheet.

To display block properties in the schematic, you must create references between the properties entered in the Block Properties dialog box and the "Block Property" property text string of the callout or balloon. To do this, first add the appropriate callout or balloon to the block. Click the Property Text button on the Callout dialog box or the Balloon dialog box to open the Select Property Text dialog box. Click From Graphic Connection as the source for the property text, then select "Block Property" from the Properties list. This displays %{Block Property|GBLK} in the Property Text field in the dialog box.

Type the block property name you entered in the Name field of the Block Properties dialog box over the BlockProperty portion of the property text string. For example, if the property name is Cost, then you replace "BlockProperty" with "Cost," so that it looks like this: %{cost|GBLK}.

Multiple levels of text can be displayed in callouts by creating multiple entries in the Callout Properties dialog box. For example: %{cost|GBLK} %{unit|GBLK}.
%(model|GBLK) will display values for cost, units, and model in the callout, if values have been entered in the Value column of the Block Properties dialog box for each of these attribute Names.

Property text in nested blocks is resolved only for the top level block.

For more information about how property text is used in draft documents, see the Help topic Using Property Text.

**Placing blocks**

Existing blocks can be dragged into the document, copied and pasted between documents, or placed using the Place Block command available from a block’s shortcut menu in the Block Selection Pane. All of these methods allow you to set the scale and change the rotation of the graphics before they are placed. To learn how, see Place a block.

Individual blocks or block views can be dragged from the Block Selection Pane into the active document. Select the block name in the Block Selection Pane, drag the block to the location in the document where you want to place it, then click the left mouse button to place it. To place the same block in another location, move the mouse and click again. Click the right mouse button to end the function. Dragging a block onto the sheet is equivalent to placing a block using the Place Block command.

You can select and place a single block from an external block library file. If you set the Block Library File List to display Thumbnails, you can see what is in the file. You can drag an entire block file of type .dft, .dwg, or .dxr into the document from the Block Library File List or from Windows Explorer.

- If the file is type .dwg or .dxr, and if the file was created with one or more blocks defined, then the contents of the file are translated and placed as individual blocks in the active document. If there is one block in the file, then a single block is placed in the active document. The AutoCAD Import Translation Wizard settings control how the block is translated into Solid Edge. These are set on the Open File dialog box.

- If the file is type .dft, and if there is a single block occurrence in the file, then it is placed as a single block. If there are multiple blocks in the file, all of the graphics in the file are placed as a single block. In the latter case, you can use the Unblock command to drop the graphics to individual elements.

  **Note**

  When you drag a .dft file onto the sheet, only the contents of the active sheet of the file are copied and placed in the current draft document. If the .dft has more than one sheet, first open and save it with the sheet containing the block set as the active sheet.

Blocks are placed in the document according to the origin point initially defined for them when they are created. You can always move the block to a new location once it is placed.

**Scaling block graphics**

The default scale value for blocks you place with the Place Block command or by dragging them onto the sheet is 1.00. You can change this value in the Block Scale box on the command bar before you click to place the block.
Lesson 3  Drawing Production Overview

When dragging an entire file into the active document, it is helpful to use the 2D Model sheet, which has infinite scale. Select the View tab→Sheet Views group→2D Model Sheet command, and then click the 2D Model tab on the drawing to make it the active sheet. Then, drag the file onto the 2D Model sheet and set the scale value before you click to place it.

You also can view and change the scale factor of a block you have already placed on the drawing by selecting the block and then typing or selecting a new scale value in the Block Scale box on the command bar.

For sizing tips, see View and modify block scale.

Rotating block graphics

After you drag a block into the document, but before you click to place it, you can rotate it in 45° increments using these keys:

-Press the A key to rotate counterclockwise.

-Press the S key to rotate clockwise.

Editing blocks

Blocks you have placed in the document can be renamed, opened for edit, deleted, replaced, and unblocked. These commands are available on the shortcut menu of the selected master block or block view in the Library, and from the shortcut menu of a block occurrence on the sheet. Behavioral differences between masters and occurrences determine whether a command is available or not.

To learn more about editing blocks, see the Help topic, Editing Blocks.

Displaying blocks in the Library

Block display in the Library

To display the Block Library, click the Show Blocks button on the Library tab of the Library window.
### Block display

Like AutoCAD, block occurrences reside on layers. When a block is placed in a document, the occurrence is placed on the active layer.

Layer display in Solid Edge is controlled from the Layers tab in the Library window. If the layer the occurrence resides on is turned off, then all block graphics are hidden, including block graphics on layers that are set to display.

To move a block to a different layer, select the block occurrence graphics, then use the Move Elements command button on the Layers tab.

To learn about layer display and control, see the Help topic, Layers overview.

| Block Library File List | Displays all files in the specified folder. Block library files are those with extension .dwg, .dxf, and .dft. You can display thumbnail previews of the block file contents in the Block Library File List. To change from the file list format to thumbnails, click the Views button on the Library tab. To place an entire block file as a single block into the active document, drag the file from this location onto the 2D Model sheet or the drawing sheet. |
| Block Selection Pane | Lists all blocks in the active document by name. Also displays individual block names contained in an external block file when you click a file name in the Block Library File List (above). To place an individual block, drag it from this location. To see the block shortcut menu, right-click in the Block Selection Pane. |
| Block Preview Pane | Displays a graphical preview of a block name selected in the Block Selection Pane. Also displays the contents of a file selected in the Block Library File List. |
Identifying block types

Most of the block commands are available only from the shortcut menu in the Library pane, where block names display one of these icons:

<table>
<thead>
<tr>
<th>Icon</th>
<th>What It Means</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Block1" /></td>
<td>-No occurrences</td>
</tr>
<tr>
<td><img src="image2" alt="Block2" /></td>
<td>-Used</td>
</tr>
<tr>
<td><img src="image3" alt="View1" /></td>
<td>-Alternate block view</td>
</tr>
<tr>
<td><img src="image4" alt="Block3" /></td>
<td>-Nested</td>
</tr>
</tbody>
</table>

The block usage indicator mark is added when you place the first occurrence of a block in the document and removed when you delete the last occurrence.

In the example below, there are multiple representations of Block2 in the active document. View1 is the source or default view of Block2. View2 is another view of Block2.

Block4 contains Block3 as a nested block. Nested blocks are identified with a glyph that is an unfilled rectangle.

<table>
<thead>
<tr>
<th>Block Selection Pane</th>
<th>What It Means</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image5" alt="Active Document" /></td>
<td>-Block1, Block2, Block3 are used in the document.</td>
</tr>
<tr>
<td><img src="image6" alt="Block2" /></td>
<td>-Block4 is not used.</td>
</tr>
<tr>
<td><img src="image7" alt="View1" /></td>
<td>-View1 and View2 are alternate representations (block views) of Block2.</td>
</tr>
<tr>
<td><img src="image8" alt="View2" /></td>
<td>-View2 is set as the default block view.</td>
</tr>
<tr>
<td><img src="image9" alt="Block3" /></td>
<td>-Block3 is used as a nested block in Block4.</td>
</tr>
</tbody>
</table>

A block name that is listed in boldface in the Block Selection Pane indicates it is the default representation of a block with multiple views. The default block representation is the one displayed if you drag a block from Library onto the drawing sheet. You can change or set a default block using the Set as Default command.

Organizing block libraries

Organizing blocks in a Block Library

Blocks can be organized in any way that suits your design needs. For example, each block can be stored as a discrete Block Library file, or a group of related blocks can be stored and organized in a single file. Battery.dft might contain one battery or it might contain different types of batteries. In general, however, defining many blocks in each Block Library file results in a more efficient use of storage space than defining one block per file.

Also, a single Block Library file can contain all of the different blocks that are used in a particular type of schematic or flow diagram. This example shows how all of the
electrical components that are needed in a motorcycle schematic can be stored in one file, cycle_blocks.dft.

Files of type .dft, .dxf, and .dwg can be accessed and opened as illustrated here.

**Sample Schematic Block Library**

A comprehensive Sample Schematic Block Library of more than 1,000 electrical and mechanical schematic blocks is included with Solid Edge. These are stored in the Sample Blocks folder, organized by design disciplines: Electrical, Mechanical, and Piping. Below these discipline-level categories are sub-folders that further organize the blocks.

Some Electrical sub-categories include:
Lesson 3  Drawing Production Overview

- Analog Logic
- Circuit Protectors
- Communication and Power Generation
- Composite Assemblies
- Motors and Machines
- PCL and Static Switching
- Qualifying Symbols
- Semiconductors
- Switches and Relays
- Transformers and Inductors
- Transmission Path
- VHF UHF SHF

To locate these schematic blocks, use the Block Library File List to browse to the Sample Blocks folder in the Solid Edge program folder, then browse through the Electrical, Mechanical, and Piping folders.

Sample drawing sheet border blocks

The Sample Blocks folder also contains a set of drawing sheet borders with title blocks for various sheet sizes. These borders also contain examples of property text and block labels, which extract information and display it in the title block.

These drawing sheet borders can be scaled and placed on the 2D Model sheet using the Drawing Area Setup command. Or you can drag and drop them onto the 2D Model sheet, a working sheet, or a background sheet.

The sample drawing sheet border blocks are also located in the Solid Edge\Sample Blocks folder, in a single file, TitleBlocks.dft.

Previewing individual sample blocks in the sample block library

You can preview the contents of a block file by clicking the block file name in the Block Library File List, then looking in the Block Preview Pane to see the graphics in the file.

Another way to preview all of the sample blocks in each category at once is to use Microsoft Explorer. Browse to the Sample Blocks folder in the Solid Edge Program folder on your desktop. Click the View icon, then set the view fly-out option to Thumbnails.

All the geometry in these draft files is on the 2D Model sheet. There is no geometry on Sheet 1. The majority of the geometry in these files is on the '0' zero layer.

In some files there is a 'TEXT' layer. This is the layer on which the text resides. Some files may have a 'TEXT' layer and not have text in the file.
Editing blocks

Editing blocks using the Open command

You can edit a master block from the Library window by right-clicking the block and then selecting the Open command from its shortcut menu. All elements that comprise the master block are displayed in a new edit window. Labels included in the block are displayed using the label name rather than the label value.

You can add, edit, and delete master block graphics, you can add and edit label name-value pairs, add annotations that reference block property text, and add dimensions.

You can move, rotate, scale, mirror, and stretch any of the block elements.

When you exit the edit session by clicking the Return button on the command bar, the changes are applied to the master block. If there are occurrences of the master block in the active document, they are updated, too.

Editing block occurrences

When you single-click a block occurrence:

- Edit handles are displayed. There is one handle for the block graphics and one handle for each label that can be modified in the block. If a label has been defined so that its position is locked, then no edit handle is displayed.

- You can use the Block Occurrence Selection options on the command bar to change the block name, block scale, block properties, and 2D element line style and color.

When you double-click a block occurrence:

- It is the same as selecting the Open command to open the block for editing in a Draw In View window.

- You can use any of the standard drawing commands to edit the block.

Editing labels

You can edit a label that is part of a block using the Open command on the block shortcut menu. If you select the Open command from the Library tab, then your edits update the master block. If you select the Open command from the drawing, then your edits update the block occurrence. When you click Return, all changes are saved to the block and label definition.

Editing block labels produces these results:

- If you edit a label definition in the master block, and if label formatting and location properties have been changed locally in individual block occurrences, the occurrence settings are preserved.

- Changing an existing label so that it is set to Use Same Value in All Occurrences changes the value of all occurrences to the value defined in the master block.

- Deleting a label in the master block deletes it from all occurrences.
Creating detailed drawings

Lesson 3  Drawing Production Overview

- Adding a new label adds it to all occurrences. The default label location and value is taken from the master block.

- Changing an existing label so that the Lock Position Within Block option is set changes all the occurrence labels to the location specified in the master block.

- Moving a label that has the Lock Position Within Block option set moves all the labels in all occurrences relative to the master block origin point.

Renaming blocks and views

Blocks and views created from blocks can be renamed only from the shortcut menu in the Library. Block names and view names must be unique within the active document.

Select the block name, select the Rename command from the shortcut menu, then type the new block name over the existing block name, then press the Enter key.

Deleting blocks

Blocks can be deleted only from the shortcut menu in the Library. When you delete a block in the Block Selection Pane, all occurrences of the block in the active document, including all views of the block, are deleted with it.

You can cut and paste blocks and copy and paste blocks between documents using those commands from the selected block’s shortcut menu. When pasted in the new document, a new occurrence and/or master block, are created.

Replacing blocks

A block and all its occurrences can be replaced globally with a single command, or you can choose to replace only a selected instance of the block. The replacement replaces the block graphics as well as its attributes.

The Replace command is available only from a block’s shortcut menu. When you replace from the Block Selection Pane in the Library, all occurrences of the selected block in the active document are replaced. When you replace a selected block in the drawing, you can choose whether to replace that one or all instances of the block.

Unblocking blocks

The Unblock command operates on graphics in the 2D Model sheet or active drawing sheet, dropping the selected block occurrence to its individual components or elements. If the selected block is nested, only the top level block will be unblocked.

If you want to select an existing block’s graphics as the basis for a new master block or another view of an existing block and the block occurrence is not selectable, use the Unblock command on the block’s shortcut menu in the drawing before selecting the Block command or the Add Block View command.

If you dragged a file into the drawing and the contents of the file translated as a single block, you can separate the contents into individual elements using the Unblock command. This makes them selectable when you create a new block or add a block view.
Cut, copy, paste

You can copy and paste block occurrences between sheets and between documents. When a block occurrence is pasted into a document, the settings on the master block determine the values of the labels of the new occurrences.

Using connectors

About connectors

Connectors are a type of annotation that can be added to blocks and other 2D elements to create schematic diagrams, flow charts, and other drawings. An efficient way to use them is to create and arrange the blocks or other 2D objects on the drawing first, and then add the connectors using the Connector command.

You can also modify the appearance, location, and orientation of existing connectors by selecting a connector in the drawing and making changes on the Connector command bar and on the Connector Properties dialog box.

Connector shapes

There are four connector shape types: Line, Corner, Jump, and Step. Line and corner connectors consist of start and end handles. Jump and step connectors also contain a midpoint handle that defines the center of the step or arc.

The midpoint of the jump arc can be connected to another line, such as a wire, or to another connector segment, so that it moves with the connected element. The midpoint of the step can only be snapped to another object, not connected to it.

For more information about these shapes, see the Connector command bar Help topic.

Adding connectors

The Connector command initiates dynamic connector placement mode, in which a continuous series of connectors can be added to the drawing until you click the right mouse button, click the Select tool, or press the Esc key to exit.

Input to create a connector consists of two points. These two points can be on a block, another 2D graphic object, on a keypoint, on a grid, in free space, and even a point on another connector. The eligible points on a connector include a midpoint or start/end vertex.

Similarly, connectors can be connected to text, dimensions, leader lines, and other annotations. When you attach a jump connector to another element, both the jump and the connected element highlight to show they are connected. When the annotation moves, the connector moves with it.

Connector midpoints can be snapped to a grid during placement and editing.

Manipulating connectors

Once placed, connectors are driven by the objects they are attached to. If a connected block, element, or object is moved, the connector end point moves with it, stretching the connector line segment as needed to maintain connectivity. For line and jump connectors only, if the other end of the connector is free, then the entire connector moves with the object.
You can easily align connectors using a grid and the Snap To Grid options on the Grid Options dialog box. You can snap to a point or to a line.

While modifying an existing connector, you can select a handle or the midpoint of a jump connector and drag it, and it will snap into position. When you turn off the grid, you turn off the snap-to-grid feature.

**Highlight color**

When you select a connector to edit, connector handles as well as connected elements are highlighted. It is helpful to know the default highlight color scheme, as it determines how connectors and connected elements will behave when you try to modify or move them.

- The default selected connector color is purple.
- The default handle highlight color for the connector start point is red. Any parent elements that the connector is connected to are displayed in the same highlight color.
- The default handle highlight color for the connector end point is black.

**Note**

The color scheme described above is the default color scheme. You may choose a different color scheme, which can be implemented through templates or a custom Connector style. See Connector Properties to learn where these default colors are set and can be changed.

**Changing connector shape and orientation**

You can easily edit an existing connector.

You can change the shape of a selected connector by pressing S on the keyboard or clicking a different connector type in the Shape list on the command bar. For example, you might change a connector shape from a line to a jump where two wires cross in a diagram.

You can change the orientation of a jump, corner or step connector by pressing F on the keyboard or clicking the Flip button on the command bar.
You can adjust the jump radius of a jump connector by typing a new value in the Jump Radius field on the command bar and pressing Enter to update the connector. You also can adjust the position of the jump by selecting the middle handle and moving it along the connector segment.

Only one jump per connector is allowed. However, you can create a string of connectors with one jump each, which behaves like a single connector with multiple jumps. Set the start/end terminators of the connectors in the middle to the “Blank” option. Do the same for the end terminator of the first connector and the start terminator of the end connector. For example:

You can create a U-shaped connector by placing a step-type connector, then selecting the connector middle handle and dragging it.
Lesson 3  Drawing Production Overview

Cut/copy/paste a connector

A selected connector can be cut, copied, and pasted using those commands on its shortcut menu. Press the Ctrl key while you drag the connector to both copy and move the connector.

Rotate/mirror(scale)/move a connector

Connector annotations can be rotated, mirrored, scaled, and moved using those commands. If you use these commands on a connected object, the connector segment will change with it. If you select the connector segment itself, only the connector will change.

To move an individual connector, it is more efficient to move the connected object. You cannot fence select connectors to move them.

Disconnecting a connector

To disconnect a connector from an object, select and drag the connector handle off the object.

Connector style and properties

A connector style can be applied globally to all connectors using dimension style mapping, or you can choose to customize the connectors added to the drawing by choosing a local style and then adjusting one or more connector properties.

Connector properties that can be set include those for line segment color, width, and type, as well as for independent start and end terminator styles. You also can opt to use no terminators at all.

Selecting and applying a global connector style

To select and apply a connector annotation style globally, go to the Dimension Style tab of the Options dialog box, set the Dimension Style Mapping option, and select a style for the Connector annotation element.

Connectors share a line style with dimensions. You can set certain global defaults for connector line styles on the Dimension Style dialog box (choose Format→Style, select "Dimension" from the Style Type list, then click the New Modify button).

Here, you can make these style changes:

- Default Line Color—Select the General tab to change the default Connector line style color, which is black, for all new connectors added to the drawing.

- Default Line Type and Width—Select the Annotation tab to change the default Connector Line Type and Connector Line Width.

Note

Connector terminator options are set on the Connector command bar. These settings can be changed interactively as you place new connectors.

To set the connector edit handle colors, change these global settings on the Color tab of the Options dialog box:
• Highlight: Sets the edit handle color for the start of the connector segment. This also sets the highlight color for elements connected to the connector. The default color is red.

• Selected: Sets the connector line segment color for a connector that is selected. The default color is purple.

• Handle: Sets the edit handle color for the end of the connector segment, as well as for middle connector handles. The default color is black.

**Overriding styles with object properties**

You can override the default line segment settings for new connectors using the options on the Connector command bar and on the Connector Properties dialog box. Also, you can modify the start and end terminator styles on either the command bar or the dialog box.

**Symbols overview**

A frequently used drawing or drawing component can be stored as a symbol for easy reuse in other documents. You can redefine the scale, position, and orientation of the geometry after you place it. Reusing geometry makes drawing more productive and efficient, and helps you maintain accuracy and consistency throughout a project.

Blocks are similar to symbols in their creation, use, and reuse capabilities. They can be imported from AutoCAD or defined in Solid Edge and stored in global libraries. Blocks also have some advantages over symbols. For example, they can contain intelligence in the form of variable text that can be referenced in callouts and part lists. They are also "lighter" than symbols. A block can be selected from a library and placed in a document as the master block, and then different representations, or views, of that master block can be added to the same document without the overhead of additional geometry and data. For more information about blocks, see the Help topic, Using blocks.

**Choosing a symbol placement method**

The default method for placing a symbol in a document is Block. To change placement method, make sure that no symbol is selected on the Library tab, and then on the shortcut menu, use the Insert Symbol As shortcut command and select the placement option you want.

**Note**

If the options on the Insert Symbol As shortcut menu are not available, clear the Show Blocks option on the Library tab: ![Show Blocks](image)

To learn about the effect of choosing one placement method over another, see the Help topic, Symbol placement methods.
**Placing symbols, images, and pictures**

You can place a symbol in your document by selecting the symbol document from the Library tab, and then dragging the symbol onto the sheet. You also can copy and paste the symbol document into the draft document.

- When you drag a symbol, you can control where it is placed.
- When you copy and paste a symbol, it is automatically placed at the lower left corner of the drawing.

You can add images and pictures to draft, assembly, and part documents using the Insert Image command. You also can drag an image or picture onto the sheet, or copy and paste it.

- Image files are placed as image objects rather than symbols, but they can be sized, rotated, and moved after insertion.
- Like symbols, images can be embedded in the document or referenced as a link to an external file.

**Creating symbols**

The easiest way to create a symbol is to select the graphics you want to store as a symbol, then drag the graphics into the Library. Solid Edge automatically assigns a default document name to each symbol. You can rename the symbol later using the Rename command on the shortcut menu.

You can also use the Copy to Library command on the Edit menu to create a symbol. When you use the Copy to Library command, you define an origin for the symbol, which allows you to place the symbol precisely later. This command also allows you to define the symbol name you want before creating the symbol. With either method, the symbol graphics are placed in the active symbol library.

Since every new Solid Edge document contains the properties defined in the template that was used to create it, you might want to use different templates for symbol documents. Solid Edge includes basic symbol templates for metric and English unit symbols. To access them, click the More tab on the New dialog box when you create a new symbol document.

You can also create your own symbol template. Just create a new draft document using the New dialog box, implement any properties you want in every symbol, and then save the document as symbol.dft in the Template folder. It will be available on the General tab of the New dialog box the next time you create a new Solid Edge document.

**Creating symbol libraries**

Symbols can be stored in any folder on your computer or a computer on your network, but you should consider defining standards for where your company’s symbols are stored to make it easier for everyone to use them. You define the active symbol library using the Look In option on the Library.
Manipulating symbols

You can manipulate a symbol much as you would manipulate other graphics. For example, you can edit its properties, move it, or copy it. When you manipulate a symbol, it behaves as a single unit.

Editing symbol properties

- When you edit the properties of a symbol placed using the Link, Embed, or Shared Embed method, the Symbol Properties dialog box is displayed for you to make changes.

- When you edit the properties of an object that you placed using the Geometry method, the Group Properties dialog box is displayed.

- When you edit the properties of an object that you placed using the Block method, the Block Properties dialog box is displayed.

Editing symbol graphics

- Symbols placed using the Geometry method are edited manually, as you would any 2D element.

- To edit the graphics of a symbol placed using the Link, Embed, or Shared Embed options, double-click the symbol on the drawing. The symbol document is opened for you to edit the graphics. After you have made the changes you want, save and close the symbol document to return to the draft drawing sheet where the symbol was placed.

- To edit symbols placed using the Block method, double click the block graphics on the drawing sheet. The graphics are opened in a Draw In View window for editing. When you are done editing the block graphics, click Return to save your changes and return to the drawing sheet where the symbol was placed.

Symbol placement methods

Choosing a symbol placement method

Before you add a symbol to your document, you can specify which placement method is used. Placement method determines how a symbol behaves once it is on the drawing sheet.

- Geometry

  Note

  The Geometry option only works for draft documents and translatable documents, such as AutoCAD and Microstation. If you select the Geometry option and place another type of file, the placement option defaults to Embed.

- Link

- Embed

- Shared Embed
Lesson 3  Drawing Production Overview

- Block

Inserting a symbol as geometry

This method copies the drawing elements directly into the active document without placing the elements as a symbol. The graphics are placed as a group and appear on the Groups page on the Library pane.

There is no limit to the number of symbols you can insert as geometry. Only the geometry and styles used are copied into the target draft file, so no unnecessary space is consumed.

Inserting a symbol as linked

Inserting a symbol as a link results in adding a reference to another file within the draft file. As the contents of the symbol file are not embedded in this draft file, there is no problem with increased file size. However, every time you move a draft file to another folder or machine, you must also move the linked symbol files.

Any change to the original symbol file will result in changes to all draft files that contain a link to that symbol. This can be useful in some workflows. However, you may find that you do not want a change to a symbol file to result in display changes in a released draft file.

Inserting a symbol as embedded

Inserting a symbol as embedded copies the symbol file into the draft file. When you drag a file from the Library onto the active sheet, a symbol object is created and the symbol file copied, intact, into a separate storage area within the target draft file.

Inserting a symbol as shared embedded

Inserting a symbol as shared embedded is the default mode, and includes elements of both the Embed and Link methods. It is like the Embed method in that the symbol file is copied into the target draft file. It is like the Link method in that additional insertions of the same symbol refer to the same embedding, rather than creating a new embedding. When you modify a shared embedded symbol by double-clicking the symbol on the draft sheet, all edits made to one instance will display in all other instances of the same shared embed. Because there is only one embedded file and each instance of a symbol refers to it, edits made in one are displayed in all instances of that symbol.

The shared embedded method avoids the potential disadvantages of both the embedded method and the linked method. Because the file is present, a link to it does not need to be maintained. Because the file is shared within the target draft file, multiple instances of the symbol can reuse it, so the target draft file stays smaller.

Inserting a symbol as a block

When you want to develop electrical, P&ID, and other diagrams, you should insert symbols as blocks. With blocks, you have access to the block, block label, and connector diagramming tools, as well as an extensive library of industry-standard 2D design blocks representing piping, electrical, and mechanical symbols. You also can access all of your AutoCAD-built blocks through on-the-fly conversion. The
Solid Edge intelligent connectors quickly snap to keypoints on the blocks and create associative links that are easily updated.

For more information, see the Help topic, Using Blocks.
Lesson

4 Activity: Drawing view placement

This activity covers the typical workflow for placing drawing views of a Solid Edge part. All drawings are different, but the basic approach to view creation, layout, manipulation, and editing is the same in all Solid Edge environments. In fact, the steps for placing assembly views are the same steps used for creating part views on a drawing sheet. This activity provides you with a basic understanding of the workflow used to create drawing sheets quickly and effectively.

Turn to Appendix A for the activity.
Lesson

5 Activity: Assembly drawing creation

This activity demonstrates the method for creating a drawing of an exploded assembly view.

Turn to Appendix B for the activity.
Lesson

6 Activity: Quicksheet

A quicksheet is a draft document that contains drawing views that are not linked to a model. When you drag and drop a model file from the Library tab of PathFinder or Windows Explorer onto a quicksheet template, the views populate with the model. Quicksheet templates can only be created using the Create Quicksheet Template command.

This activity shows the process for using a quicksheet.

Turn to Appendix C for the activity.
Lesson

7 Activity: Broken view creation

This activity covers the use of the Broken View command.

Turn to Appendix D for the activity.
Lesson

8  Activity: Broken-out section creation

This activity demonstrates the use of the Broken-Out Section command. Turn to Appendix E for the activity.
An essential part of the design process is adding dimensions and annotations as Product Manufacturing Information (PMI) to your drawings and model documents.

- You can add dimensions and annotations to a drawing in the Draft environment, and to a sketch in a model document.

- You can add PMI to 3D models in the Part, Sheet Metal, and Assembly environments.

**Dimensioning overview**

You can add dimensions to the 3D PMI model or 2D design geometry by measuring characteristics such as size, location, and orientation of elements. You can measure the length of a line, the distance between points, or the angle of a line relative to a horizontal or vertical orientation. Dimensions are associative to the 3D model or 2D elements to which they refer, so you can make design changes easily. Solid Edge provides a full complement of dimensioning tools so you can document your parts, assemblies, and drawings.

To learn about placing dimensions on the 3D model, see PMI dimensions and annotations.

In the Draft environment, you can add dimensions using the commands in the Dimension group on the Home tab or the Sketching tab. You also can create dimensions by retrieving them from part, sheet metal, and assembly models with the Retrieve Dimensions command.
You can use the dimensioning commands to place the following types of dimensions:

- Linear dimensions
- Angular dimensions
- Diameter dimensions
- Radial dimensions
- Dimension groups

These dimension commands are available:

- Smart Dimension command
- Distance Between command
- Angle Between command
- Coordinate Dimension command
- Angular Coordinate Dimension command
- Symmetric Diameter command
- Chamfer Dimension command

Each dimension command has a command bar that sets options for placing the dimension. When you select an existing dimension, the same command bar is displayed so you can edit the dimension characteristics.
Using dimensions to control elements

You can place a dimension that controls the size or location of the element that it refers to. This type of dimension is known as a locked dimension. If you change the dimensional value of a locked dimension, the element updates to match the new value.

The value of an unlocked dimension is controlled by the element it refers to, or by a formula or variable you define. If the element, formula, or variable changes, the dimensional value updates.

Because both locked and unlocked dimensions are associative to the element they refer to, you can change the design more easily without having to delete and reapply elements or dimensions when you update the design.

Locking and unlocking dimensions

In general, you can set or clear the lock option on the Dimension command bar or on the Dimension Value Edit dialog box to specify whether a dimension is locked or unlocked.

- The dimension is unlocked.
- The dimension is locked.

Note

- If the Lock button is not available, set the Maintain Relationships option in the Relate group on the Home tab or the Sketching tab.

In the Draft environment, dimensions can be placed as either locked or unlocked, depending upon the setting of the Maintain Relationships command. If Maintain Relationships is set, the dimensions are locked by default. These exceptions apply:

- Dimensions placed on part views are always unlocked.
- Dimensions placed between a 2D view and an element on the drawing sheet can only be unlocked.
Dimension color

Locked and unlocked dimensions are distinguished by color. The default colors are different in the synchronous modeling environments than they are in the Draft environment.

**Changing dimension color in Draft**

In the Draft environment, the color defined for each dimension type is part of the dimension style, which you can edit using the Style command on the View tab in the Style group. You can change the default color for locked and unlocked dimensions on the General page of the Modify Dimension Style dialog box.

- The default color for locked dimensions—Black/White—is set by the Driving Dimension option.
- The default color for unlocked dimensions—Dk Cyan—is set by the Driven Dimension option.

To learn about PMI model dimension color in synchronous models, see the Help topic [Setting global PMI color and text size](#).

**Not-to-scale dimensions**

You can override the value of a driven dimension by setting its dimensional value to *not-to-scale*. For example, if you override the dimensional value that is 15 millimeters (1) to be 30 millimeters, the actual size of the line that you see would still be 15 millimeters (2). Solid Edge underlines the values of not-to-scale dimensions.

![Not-to-scale dimensions example](image-url)
Placing dimensions

To add dimensions to elements, you can use a dimension command, such as Smart Dimension, and then select the elements you want to dimension.

As you place dimensions, the software shows a temporary, dynamic display of the dimension you are placing. This temporary display shows what the new dimension will look like if you click at the current cursor position. The dimension orientation changes depending on where you move the cursor.

For example, when you click the Distance Between command and select an origin element (1) and an element to measure to (2), the dimension dynamically adjusts its orientation depending on where you position your cursor (3) and (4).

Because you can dynamically control the orientation of a dimension during placement, you can place dimensions quickly and efficiently without having to use several commands. Each of the dimension commands uses placement dynamics that allow you to control how the dimension will look before you place it.

Note

When the IntelliSketch Intersection option is set and you select Distance Between, you can place a driven dimension that measures to the intersection of two elements.

Snapping to keypoints and intersection points

When placing a dimension, you can use shortcut keys to select and snap to keypoints or intersections. After you locate the line, circle, or other element that you want to snap to, you can press one of these shortcut keys to apply the point coordinates to the command in progress: M (midpoint), I (intersection point), C (center point), and E (endpoint).

To learn more, see Help topic Selecting and snapping to points.
Placing driving dimensions to an intersection

Sometimes you need to place a driving dimension to the intersection of two elements. You can do this using profile lines (1) or a profile point (2).

When using profile lines, any profile elements that are not part of the feature you are constructing must be toggled to construction elements using the Construction command.

When placing a profile point, you can set the Intersection option on the IntelliSketch dialog box so the profile point stays at the theoretical intersection.

Note

The button for the Point command can be displayed through customization.

Placing dimensions with the dimension axis

The Dimension Axis command sets the orientation of the dimension axis on the drawing sheet or profile plane. You can use the new dimension axis, rather than the default axis of the drawing sheet or profile plane, while you use the Distance Between or Coordinate Dimension commands. After you define the dimension axis, you can place dimensions that run parallel to or perpendicular to the dimension axis.

Dimensioning with a grid

You can easily create and align dimensions using a grid and the Snap To Grid options on the Grid options dialog box. You can snap to a grid point or to a grid line.

While modifying an existing dimension, you can select any part of the dimension—line, text, or handle—and drag it, and it will snap into position. When you turn off the grid, you turn off the snap-to-grid feature.
Dimensioning automatically

There are two ways you can add dimensions automatically and generate geometric relationships to constrain the geometry:

- You can use the Relationship Assistant command when editing existing profiles. This is a quick method of dimensioning and setting simple geometric relationships for any 2D information brought into Solid Edge, including information from other systems.

- You can use the Auto-Dimension command when drawing new elements. The options on the Auto-Dimension page of the IntelliSketch dialog box control when the dimensions are drawn as well as whether to use dimension style mapping or not.

Using the Relationship Assistant

The Relationship Assistant command helps you finish a profile or sketch, or make it fully parametric. After applying all critical dimensions and relationships to the shape, you can use the Relationship Assistant command to apply any missing geometric or dimensional relationships to help fully constrain the model. It is a good idea to check the profile with the Show Variability option to check for degrees of freedom.

You can also use the Relationship Assistant command bar to show you how many additional relationships are required and how the shape can change based on the current relationships and dimensions.

To determine how many additional relationships are needed and how the profile or sketch can change, drag a fence around the profile, then click the Accept button on the command bar. You can then click the Show Variability button on the command bar to display the number of relationships needed. A temporary display of the profile using the highlight color is also displayed to illustrate one possibility of how the profile can change. You can click the Show Variability button repeatedly to see other variations.

Formatting dimensions

If you want two or more dimensions to look the same, you can select the dimensions and apply a style with the command bar. If you want to format dimensions so that they look unique, you can select a dimension and edit formats with the command bar or the Properties command on the shortcut menu.

To learn how to format dimension terminators, see Set Terminator Size and Shape.

You can add prefix, suffix, superfix, and subfix text and supplementary information to a dimension value using the options in the Dimension Prefix dialog box. You can use this dialog box while you place or edit a dimension. To learn how, see Add and edit dimension text.
Adding breaks to dimension projection lines

Dimensioned drawings can become cluttered and difficult to read when dimensions intersect one another. Using the Add Projection Line Break command, you can add breaks to projection lines on a selected dimension (1). The result is that break gaps (4) are inserted into the projection line (2) wherever it intersects another dimension (3). Visually, the break is represented by not drawing the projection line at the point of intersection.

(1) = selected dimension
(2) = projection line (broken)
(3) = intersecting dimensions (unbroken)
(4) = break gaps

The purpose of the projection line gap is to add visible white space and improve legibility. The size of the gap is set by the Break option on the Lines and Coordinate tab (Dimension Properties dialog box).

To add a break around dimension text that intersects other dimensions, set the Fill Text With Background Color option on the Text page (Dimension properties dialog box).

You can cut, copy, and paste a dimension with projection line break gaps as long as you select both the breaking and the broken dimensions along with the geometry.

Dimension projection lines that you have broken retain their setting during view updates, and also when you reposition the dimension text or lines for aesthetic reasons.

You can remove dimension line breaks using the Remove Projection Line Break command.
**Copying dimension data**

In the Solid Edge Draft environment, you can copy data such as prefix strings, dimension display types, and tolerance strings from one dimension to another. To copy dimension data, use the Prefix Copier.

**Using the mouse scroll wheel to change dimensions**

You can use the mouse scroll wheel to change a driving or system dimension. As you scroll the wheel, the dimension increases or decreases in 5 percent increments. For example, if the dimension is 100 mm, the dimension will increase or decrease by 5 mm.

To use the mouse scroll wheel to change a dimension, click the dimension you want to change, and scroll the wheel forward to increase the dimension or backward to decrease it.

To control the scroll wheel dimension editing capability, set or clear the Enable Dimension Changes Using the Mouse Wheel option on the General page of the Options dialog box.

**Note**

Depending on the mouse driver you have installed, if you are in an active draft window you may scroll the view instead of the dimension value. In this case, you may need to move the mouse cursor away from the draft window to scroll the value.

**Using expressions in dimensions**

There are many instances when the dimensions of individual features in a design are related. For example, the bend radius used to manufacture a sheet metal part is usually a function of the stock thickness. You can define and automate these types of design relationships with expressions. You can select a dimension and then use the Variables command on the Tools tab to enter a formula. When the formula is solved, the dimensional value changes to the value that the formula calculates.

You might want to use dimensions with expressions for the following purposes:

- Drive a dimension by another dimension; Dimension A = Dimension B
- Drive a dimension by a formula; Dimension A = pi * 3.5
- Drive a dimension by a formula and another dimension; Dimension A = pi * Dimension B

**Setting or modifying units of measure**

To set the units of measure for a dimension, select the dimension and use the Properties command on the shortcut menu. To set the units of measure for a document, use the Properties→File Properties command on the Application menu.
Showing variability

The Show Variability command determines how 2D elements can change based on their dimensions and relationships. Use this command to see the types of changes in a shape allowed by existing degrees of freedom. To show variability, use the Tools tab→Assistants group→Relationship Assistant command. Select the element, and then click the Show Variability button on the command bar.

Tracking changed dimensions and annotations

When a drawing view is updated in the Solid Edge Draft environment, you can track dimensions and annotations that have been changed or deleted from the model. To open the Dimension Tracker dialog box so you can identify these changes, use the Tools tab→Assistants group→Track Dimension Changes command.

- On the drawing, every changed dimension and annotation is flagged by a balloon.
- In the Dimension Tracker dialog box, changed items are displayed in columnar format. You can sort the changes by clicking a column heading.
- You can select one or more items in the list and assign a revision name to the balloon labels on the drawing.

To learn more, see Help topic Tracking dimension and annotation changes.
Types of dimensions

A linear dimension measures the length of a line or the distance between two points or elements. You can place linear dimensions with the Coordinate, Distance Between, Smart Dimension, and Symmetric Diameter commands.

An angular dimension measures the angle of a line, the sweep angle of an arc, or the angle between two or more lines or points. You can place angular dimensions with the Angle Between and Smart Dimension commands.

A radial dimension measures the radius of elements, such as arcs, circles, ellipses, or curves. You can place a radial dimension with the Smart Dimension command.

A diameter dimension measures the diameter of a circle. You can place a diameter dimension with the Smart Dimension command.

A coordinate dimension measures the distance from a common origin to one or more keypoints or elements.

You can use the following commands in Solid Edge to place dimensions:

- Smart Dimension command
- Distance Between command
- Angle Between command
- Coordinate Dimension command
- Angular Coordinate Dimension command
- Symmetric Diameter command
- Chamfer command
The components of a dimension are as follows:

1. Projection line
2. Dimension line
3. Dimensional value
4. Terminator
5. Break line
6. Symbol
7. Connect line
Coordinate dimensions

You can use the Coordinate Dimension command and Angular Coordinate Dimension command to place dimensions that measure the distance from a common origin to one or more keypoints or elements.

You can place coordinate dimensions in any order and on either side of the origin. You can also add, remove, and modify jogs on the dimension line to make it easy to position all the dimensions.

Coordinate dimensions that refer to a common origin are members of a coordinate dimension group.

Placing coordinate dimensions

To place coordinate dimensions, you first select an origin element to establish a measure-from point (1), and then position the origin symbol (2).
Lesson 9  Dimensions, Annotations, and PMI

You then select an element away from the origin as a measure-to point (3), and position the dimension (4). The dimension measures the distance from the origin element to the measure-to element.

To make it easier to accurately align the dimension text for a group of coordinate dimensions, several built-in snap alignment positions allow you to align the text when placing or modifying coordinate dimensions.

You can add additional coordinate dimensions to an existing coordinate dimension group by selecting any dimension in the group as the origin, and then select an additional element to dimension.
Moving coordinate dimension groups

In the Draft environment, you can move a group of coordinate dimensions by dragging the track point on the origin symbol. Select the origin, position the cursor over the track point, then drag the group to a new location.

Placing coordinate dimensions with jogs

To add one or more jogs while placing a coordinate dimension, first select the element you want to dimension, then hold the Alt key and click to add the jogs. For example, to place the following 12 millimeter dimension as shown, you would first select the circle as the element to dimension (1), you then hold the Alt key and click points (2), (3), and (4) to add the jogs. You then release the Alt key and click points (5) and (6) to finish placing the dimension.
Lesson 9  
*Dimensions, Annotations, and PMI*

**Adding jogs to coordinate dimensions**

To add a jog to an existing coordinate dimension, use the Select Tool to select a coordinate dimension (1). Position the cursor over the dimension line where you want to insert the jog (2). Hold the Alt key and click.

Two vertices and a jog segment are added (3). You can modify the jog by dragging a vertex handle (4). You can also modify the jog by dragging the jog segment.

To make it easier to place coordinate dimensions with multiple jogs, the cursor snaps into alignment when the last dimension line segment (1) is aligned with the first dimension line segment (2).
Modifying jogged coordinate dimensions

You can modify the jog on a coordinate dimension by dragging a jog vertex (1) and (2), or by dragging a jog segment (3).

The modification behavior for each jog vertex is different when you drag it. For example, when you drag the vertex farthest from the dimension text (1), you change the jog segment position. When you drag the jog vertex closest to the dimension text (2), you change the jog segment angle.

When you drag the jog segment (3), you also change the jog segment position.
Snapping coordinate dimensions to a grid

After you place coordinate dimensions using the built-in snap positions, and if you have exceeded the number of built-in snap positions, then you can adjust their alignment using a grid. To activate the grid, select the Tools→Grid command, and then set the Snap To Grid options to use grid lines or points.

If you added jogs, then you can use snap to grid to modify the location of jog handles.

Removing jogs from coordinate dimensions

In the Draft environment, you can remove all the jogs from a coordinate dimension using the Jog button on the Dimension command bar. Use the Select Tool to select a coordinate dimension, then click the Jog button on the command bar.

You can also remove a single jog from a coordinate dimension using the Select Tool and the Alt key. Select a coordinate dimension, then position the cursor over a vertex on the jog you want to remove. Hold the Alt key and click.

Class fit dimensions

Because the tolerance specification for the proper fit between holes and shafts is such a common and critical aspect in the design and manufacture of parts, international standards bodies have established rule-based systems of tolerances for the Limits and Fits of holes and shafts.

The terms hole and shaft can also be taken as referring to the space between two parallel faces of any part, such as the width of a slot, the thickness of a key, etc. Only distance dimensions are covered by the standards. The standards do not apply to angular dimensions.

Solid Edge provides ASCII text files that you can use to automatically define the limit or fit for a dimension whose type is set to Class using the dimension command bar.
Class dimension display options

When you set the dimension type to Class, you can choose one of several methods to display the limits or fits for the dimension.

<table>
<thead>
<tr>
<th>Fit</th>
<th>(\phi) 60 H7</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fit, tolerance only</td>
<td>(\phi) 60 +0.030</td>
</tr>
<tr>
<td>Fit with tolerance</td>
<td>(\phi) 60 H7 (+0.030)</td>
</tr>
<tr>
<td>Fit with limits</td>
<td>(\phi) 60 H7 (60.030)</td>
</tr>
<tr>
<td>Fit Hole/Shaft</td>
<td>(\phi) 60 H7/h7</td>
</tr>
<tr>
<td>User-defined</td>
<td>(\phi) 60 Q1 (abc)</td>
</tr>
</tbody>
</table>

(Any user-defined text is valid)

Class fit ASCII text files

Three ASCII text files are available that provide support for ANSI and ISO class fit dimension standards:

- SE-LimitsAndFitsTableANSInch.txt
- SE-LimitsAndFitsTableANSIMetric.txt
- SE-LimitsAndFitsTableISO.txt

By default, the files are located in the Solid Edge Program folder. You can instruct Solid Edge to look for these files in a different folder, including a folder on another machine on the network using the File Locations tab on the Options dialog box.

**Note**

If you edit these files, save a copy of these files before you uninstall Solid Edge.

Controlling the display of zero value tolerances

When placing a class fit dimension that displays a tolerance, you can set an option in the dimension style to inhibit the display of a tolerance that has a value of zero.

The Inhibit Display of 0.0 Values for Automatic Fit Tolerances option on the Text page controls whether zero value tolerances are displayed or hidden.

\[\phi\ 80\ 0\ -0.030/\phi\ 80\ -0.030\]

You can set this option for an individual dimension using the Properties command, or you can set it for all dimensions using the Style command.
3D pictorial drawing view dimensions

You can add 3D dimensions to a pictorial drawing view. On a drawing, 3D dimensions use the associative model to determine true distance, rather than the space on a 2D drawing. You can place a linear, radial, or angular Smart Dimension as a 3D dimension.

**Note**

To add dimensions and annotations to 3D models, use the commands on the PMI tab on the ribbon. See the Help book, Product Manufacturing Information (PMI).
Radial 3D dimensions

For radial 3D dimensions, if the dimension is on the inside of the 3D circle or arc, then the tail of the dimension is tied to the center of the 3D circle or arc. If the dimension is on the outside of the 3D circle or arc, then the dimension line is aligned with the center of the 3D circle or arc.

Angular 3D dimensions

For angular 3D dimensions, the model planes and adjacent face planes of the lines are valid dimension planes.

Workflow

You place a 3D dimension on a pictorial drawing view using the same workflow as when you place a 2D dimension. However, if the drawing view is out of date, you must use the Update View command to make it up to date with the model before you can dimension it.

Dimensions in 3D are created relative to a dimension plane. In a drawing, this is determined by the element you select. You can change the plane at any time during dimension placement. In a drawing, change the dimension plane with the N and B keys.
Drawing View Properties dialog box

The Create 3D Dimensions In Pictorial Views check box on the General page of the Drawing View Properties dialog box controls whether 3D dimensions are placed. By default, 3D dimensions are enabled for pictorial views.

Placement guidelines on drawings

Because 3D dimensions measure actual model space, it is important to consider the perspective of the view when evaluating apparent conflicts between dimensions. For example, a cutout that appears circular in a pictorial view may actually be elliptical, and have proximate radial dimensions with different values. Moreover, when you look at a drawing, there is no way to distinguish at a glance between a 2D dimension and a 3D dimension (unless the 3D dimension has a placement that is impossible for 2D dimensions).

Therefore, it is possible to create a drawing with both 2D and 3D dimensions on which dimension values seem to conflict, because the 2D dimension is measuring drawing sheet space and the 3D dimension is measuring actual model space. Keep this in mind and use your knowledge about your situation and workflow to avoid creating potentially confusing drawings.

Dimension Groups

You can place dimensions in dimension groups with the following commands:

- Distance Between
- Angle Between
- Symmetric Diameter
- Coordinate Dimension

This makes the dimensions easier to manipulate on the drawing sheet. All members of a stacked or chained dimension group share the same dimension axis.

(1) Stacked dimension group
(2) Chained dimension group
A coordinate dimension group is another type of dimension group. Coordinate dimensions measure the position of key points or elements from a common origin. All the dimensions within the group measure from a common origin. You should use coordinate dimensions when you want to dimension elements in relation to a common origin or zero point.

When you place dimension groups with the Distance Between or Angle Between commands, the cursor position determines what type of dimension group will be placed. After you place the first dimension in a group and click the second element you want to measure, if the cursor is below the first dimension, then the dimension group will be a chained group (1). If the cursor is above the first dimension, then the dimension group will be a stacked group (2).

Zero and negative dimensions

You can use zero and negative values to manipulate geometry in the following dimension types:

- Smart Dimension between two elements (or keypoints from two elements)
- Distance between two elements (or keypoints from two elements)
- Smart Dimension angle between two elements (or keypoints from two elements)
- Angle between two elements (or keypoints from two elements)
After you place one of the above dimensions, you can change it to zero or a negative value to control element placement. When you select a dimension, its parents highlight.

![Diagram showing the effect of changing a dimension from positive to negative]

Zero and negative dimensions work best on fully constrained geometry. When a profile or sketch is not fully constrained, negative dimensions can be unpredictable (unexpected change of side, for example).

**Unsupported dimensions**

Zero and negative values are not supported for any group dimension, including linear coordinate, angular coordinate, linear stacked, linear chained, angular stacked, and angular chained. Zero and negative dimensions are also not supported for radial dimensions, diameter dimensions, and chamfer dimensions. Point constraints do not allow negative offsets.

**Controlling zero and negative dimensions**

Because positive and negative values need not follow the X axis or Y axis, there is no set positive or negative direction when you use zero and negative dimension values. Rather, the direction is determined by how the dimension is placed with respect to the other relationships affecting the geometry. When you change the sign of a dimension (from positive to negative, for example), the direction the distance is measured changes relative to the geometry only. A positive value is measured in the direction in which the dimension was originally placed.

If you toggle a dimension from driving to driven when its value is negative, the dimension is displayed as positive. A driven dimension can never be negative. Dimensions retrieved from part models are positive because they are always driven, and zero dimensions are not retrieved.

**Displaying zero and negative dimensions**

The following conditions apply to the display of zero and negative dimensions:

- Text positions are processed as if the dimension were positive or non-zero (above, embedded, and so forth). Text position for zero values behaves as if the dimension were a very small positive value.

- Zero dimensions do not move or change the dimension break position.
• Dual unit display shows both united values with a negative sign.

• Zero angular dimensions between two non-intersecting elements display as linear dimensions (but with a degrees symbol). You can drag the ends of the extension lines with handles or move the text position as shown below.

![Diagram showing angular dimensions]

Retrieving dimensions and annotations from a model

You can copy dimensions and annotations from a part, sheet metal, or assembly model to a drawing view using either of the following methods:

• Use the Retrieve Dimensions command to copy dimensions and annotations from the model to an existing orthogonal or section drawing view. The Retrieve Dimensions command copies PMI dimensions and annotations as well as sketch dimensions and annotations.

  To learn how, see the Help topic, Retrieve dimensions and annotations from the model.

• Use the Drawing View Wizard to generate a drawing view from any previously defined PMI model view created with the PMI tab→Model Views group→View command. This method copies only PMI elements to the drawing.

  To learn how, see the Help topic, Create a PMI drawing.

With either method, when you change the design later you can use the Update View command on the shortcut menu to update the part view and the retrieved dimensions also update. For example, if you change the size of a hole in your part, the retrieved dimension for the hole in the part view will update to the new value.
Dimension and Annotation Standards and Formats

Style mapping applies standard or custom style formats to lines, hatches, fonts, fills, dimensions, annotations, and views as you place objects that use these styles in the document. The element-to-style mapping table on the Dimension Style tab of the Options dialog box allows you to choose which style to map to which element, or it allows you to assign one style to all elements.

When the Use Dimension Style Mapping option is set on the Dimension Style tab, then the Dimension Style Mapping option \(\) is also set by default on the relevant command bars and dialog boxes used to place individual elements. You can override the mapped style for an individual element by clearing this option on the command bar.

For global impact across all design documents and drawings, you can specify drawing standards and styles in the template files used to create part, assembly, sheet metal, and draft documents. This ensures that designers apply standards that conform with company style guidelines.

Standards

The default, standard styles available are:

- ANSI
- ANSI\(\text{mm}\)
- BSI
- DIN
- ISO
- JIS
- UNI

In addition, you can create and name custom styles. The style format is defined in the Style dialog box (Format-Style-Dimension style type-New button or Modify button).

Style Format Options

New and modified style formatting options vary widely between the type of element. Some of the style formatting options include the following:

- Lines (e.g., style, color, width)
- Units (e.g., inch, mm)
- Spacing (e.g., in a pattern)
- Delimiters (e.g., period or comma)
- Terminators (e.g., arrow, circle, dot)
- Round-off
User-defined tables

The Table command allows you to create a table that contains user-defined data. The table consists of a title (1), column header (2), and column data (3).

![Table example]

Creating a table

To create a user-defined table, use the Table command. The command displays the Table Properties dialog box, which contains four tabs that assist you in creating the table: the General tab, Title tab, Data tab, and Sorting tab. These tabs are shared among all Solid Edge table types.

To learn more about how you can use the options on these tabs, see the following Help topics:

- Using the General tab
- Using the Title tab
- Using the Data tab
- Using the Sorting tab

Creating a custom table style

You can use the Style command to create your own, fully customized Table styles in the Draft environment and make them available for many different table applications. For example, custom table styles can be applied to parts lists, pipe lists, hole tables, bend tables, drawing notes, revision tables, and the dimension table used by families of assemblies.

See the Help topic, Table styles.

Using the General tab

The General page on the Properties dialog box is where you define basic information about the table or parts list. This includes where to place the table, how the table grows or shrinks, and how multi-page tables are displayed. You also can move a table to a different sheet.
Table placement and sizing

You can use either of these methods to place a table: dynamically, or by specifying a table origin point.

- You can place a table dynamically by moving the mouse until the table is located where you want it, and then clicking to fix its position.

- You can place the table at a specific origin point when you select the Enable Predefined Origin for Placement check box, and then enter sheet coordinates in the X Origin and Y Origin boxes.

With either placement method, you can apply a Page Anchor Point to control table placement and sizing. These options are illustrated here:

(1) Top-Left
(2) Bottom-Left
(3) Top-Right
(4) Bottom-Right

- Choosing a top-left anchor point means that the top-left table corner is easily matched to the top-left corner of the working sheet.

- When the anchor point is on the left, the page gets wider on the right as columns are added. When the anchor point is on the right, the page gets wider on the left as columns are added.

- When the anchor point is on the top, the page height adjusts on the bottom. When the anchor point is on the bottom, the page height adjusts on the top.

Specifying maximum table height

You can specify the maximum table height using either of these methods:

- Selecting the Maximum Number of Rows option and typing a positive integer. Once that number is reached, a new page is created.

- Selecting the Maximum Height option for the table and typing a size value. Once that size is reached, a new page is created.

Moving table pages to working sheets

You can use the Sheet control to specify the sheet that you want the table to appear on. Use the control to place the parts list with the drawing it references.

Working with multi-page tables

In tables that have multiple pages:
• Left and right anchor points control which side of the table that pages are added.
• When new columns are added, they are added to each page.
• The Page Gap specifies the minimum distance between each page.
• You can change the Page value to place each page onto different sheets.

**Using the Title tab**

Use the Title tab on the Properties dialog box to add, remove, and manage the location of titles and subtitles in a table or parts list.

**Creating titles**

A table can have any number of titles and each title can have multiple lines of text.

You can create a table title using the Add Title button and then typing in the Title Text box. The Position option determines whether the title is displayed as a header, a footer, both, or not at all.

The order in which the titles are created, combined with the Position setting, determines their display order and location in the table.

**Example**

• If you create two titles in the Header position, then they are displayed as a title and subtitle spanning the first two rows of the table.

• If you create two titles—Title 1 and Title 2—with the first in the Header position and the second in the Footer position, then Title 1 is displayed at the top of the table and Title 2 is displayed at the bottom of the table.

The total number of titles is indicated by the value in the Number Of Titles box.

To learn how: Add a table title.

**Modifying titles**

You can modify a title by selecting its number from the Title list. Then, you can:

• Change the title by typing in the Title Text box.

• Change the location of the title in the table by selecting an option from the Position list.

• Delete the title using the Delete Title button.

**Using the Data tab**

You can use the Data page on the Properties dialog box to enter data into a table or parts list, and to manipulate the format of the table. You can insert or delete columns and rows, move rows, drag columns from one location to another, and format columns.
To learn how, see the Help topic, Make changes to a table or parts list.

Formatting a data column

On the Data page, you can use the Format Column button to display the Format Column dialog box, where you can customize the format for the selected column. You can do such things as set the column width; create, position, and align a column header; align data; and show and hide columns and headers.

Editing data cells

White data cells may be edited. You can double-click a cell to edit it, and press the Tab key to save the value you type.

Gray shaded data cells are disabled for direct editing, because they contain content derived from the model by property text. You can override the derived values in these cells using the following shortcut commands:

- Allow Cell Overrides—When you use this command to enter a new value, the cell is no longer associative to the model.

- Clear Cell Overrides—This command resets the value of an edited cell to its original value derived by property text.

Copying data from a spreadsheet

You can copy and paste cells from a spreadsheet into a user-defined table or into user-defined cells in system-generated tables, such as parts lists and family of parts tables.

When importing a spreadsheet, you need to ensure that the number of columns and rows are exactly the same in the table and spreadsheet or you may lose data during the copy and paste. For example, if your table contains three columns and five rows, but the spreadsheet contains four columns and six rows, the table is not large enough and data will be lost.

Using the Sorting page

You can use the Sorting page on the Properties dialog box to sort the table or parts list based on the contents of the column. To learn how, see Sort table contents.

General sorting techniques

- You can do multi-column sorting with up to three columns. For example, you can sort by column 1, then by column 5, and then by column 2.

- You can sort by ascending or descending order.

- You can use the Reverse Order of Entries option to reverse the order of the search results.

- You can add a column name to the Sort Criteria lists by first adding the column property on the Columns tab.
Sort by component type

For assembly models containing piping or tubing, you may want to sort the parts list by selecting the Component Type Order option from the Sort by lists.

Sort by assembly structure or item number

There are two ways you can sort the columns to show item numbers in parts lists on assembly drawings:

• You can select the Assembly Order criteria in the first Sort by list to match the order that is shown in Assembly PathFinder.

• You can select the Item Number criteria to sort using the item numbers generated by the Parts List command.

Hole tables

Hole tables are a useful means of defining the size and location of a hole. A hole table works much like a software spreadsheet. Holes are represented as rows in the table and dimensions of the holes as columns. Both circles and arcs are supported in hole tables.

You can create hole tables based on the following hole dimensions:

• hole size only

• hole location only

• hole size and location

Creating hole tables

To create a hole table, use the Hole Table command. On the Hole Table command bar, you can use the Hole Table Properties button to open the Hole Table Properties dialog box, where you can define the information you want to appear in the table.
Lesson 9  

*Dimensions, Annotations, and PMI*

**Formatting a hole table**

Before you place the hole table on the drawing sheet, you can use the Hole Table Properties dialog box to format it the way you want. For example, you can set properties on the Columns tab to control the column width, column title and column arrangement in your hole table. You can also set options for the size and location of the hole table, the font you want to use, whether you want to list the holes by origin or by size, and so forth. You can add callout columns to the hole table. You can change the hole table formatting later.

**Using smart depth with hole table entries**

You can use Smart Depth controls to intelligently describe holes in a hole table. When you use Smart Hole Depth or Smart Thread Depth for a hole table entry, the entry populates based on the data variables, template text, or other information you specify on the Smart Depth tab of the Hole Table Properties dialog box. This is useful for easily determining whether the depth or thread of a hole is finite.

**Renumbering hole table entries**

With the renumbering options on the List tab of the Hole Table Properties dialog box, you can determine how Solid Edge renumbers the rows in your hole table when you update it. You can choose to renumber holes, to keep previous numbers for deleted holes, or to leave blank lines for deleted holes.

**Saving the hole table format**

You can save a hole table format with a name you define, so you can easily use it again. To apply a saved format in another drawing, select its name from the Hole Table Properties list on the command bar.

**Setting up hole properties for the hole table**

You can include hole properties such as Radial Location and Angular Location in your hole table. Use the Columns tab of the Hole Table Properties dialog box to set up a column for each property you want in the hole table.

**Family of Parts dimension tables on drawings**

Family of parts dimension tables placed on drawings are useful for defining the size and location of features derived from similar family members. The Family Of Parts Table command automatically generates a table that contains all of the variables derived from a family of parts, and it imports the dimensional and positional data for all members of the selected family. You also can link the family member variables to dimensions on the drawing.
The family of parts table lists family member location and size data by row. Family variable labels are shown as column headings. You can easily customize the table by making formatting changes. You can insert user-defined columns into the table and extract other model information into them. For example, you can use property text to extract graphical model information to supplement the dimensional and positional values derived from the family of parts.

<table>
<thead>
<tr>
<th>Name</th>
<th>FlangeDia</th>
<th>FlangeThick</th>
<th>BossDia</th>
<th>BossThick</th>
<th>BoreDia</th>
<th>MfgHoleDia</th>
</tr>
</thead>
<tbody>
<tr>
<td>3Hole</td>
<td>130.00 mm</td>
<td>15.00 mm</td>
<td>65.00 mm</td>
<td>30.00 mm</td>
<td>35.00 mm</td>
<td>18.00 mm</td>
</tr>
<tr>
<td>4Hole</td>
<td>145.00 mm</td>
<td>18.00 mm</td>
<td>75.00 mm</td>
<td>40.00 mm</td>
<td>45.00 mm</td>
<td>20.00 mm</td>
</tr>
<tr>
<td>6Hole</td>
<td>160.00 mm</td>
<td>25.00 mm</td>
<td>85.00 mm</td>
<td>50.00 mm</td>
<td>55.00 mm</td>
<td>22.00 mm</td>
</tr>
</tbody>
</table>

Creating a family of parts table on a drawing

To create a family of parts table on a drawing, you begin by placing one or more drawing views containing a family member, and then you add dimensions to them.

Next, you select the Family Of Parts Table command, and then click a drawing view of a family member.

The command displays the Variables tab on the Family Of Parts Table Properties dialog box, where you can specify which family variables you want to include and exclude from the table.
Lesson 9  Dimensions, Annotations, and PMI

You then can place the table on the drawing sheet, or you can first use the other options on the multi-tabbed Family Of Parts Table Properties dialog box to add a table title and make other formatting changes.

The last step is to link the drawing dimensions to the variables in the family of parts table.

**Note**
Do not create a drawing from the family of parts master document. Instead, create the drawing from one of the family members. For more information, see the Using family members in assemblies and drawings section in the Help topic, Families of Parts.

**Including and excluding family variables**

The Variables page on the Family Of Parts Properties dialog box is where you choose the variables that you want to display in the family of parts drawing table. These are also the variables that you can link to dimensions on the drawing.

The Variables page contains two lists of variables:

- The left-hand pane, Variables, displays all of the variables found in the Variable Table for the selected family of parts, less those variables that are listed in the right-hand pane.

- The right-hand pane, Variables Shown In Table, shows the variables that are currently selected for the drawing table.

You can remove variables from the table using the Remove button. You can add variables to the table using the Add button.

When you click OK, the data for all family members is imported, and the drawing table is ready to place on the drawing sheet.

**Linking family variables to drawing dimensions**

After you place the table on the drawing, you can link each of the family variables to its corresponding driven dimension on the drawing. The links are associative, so that when the member changes in the model, the dimension on the drawing goes out of date.

Each dimension can be linked to just one variable, but you can link the same variable to multiple dimensions. This enables you to illustrate the same dimension in different views.

To create a link, use the Link Variable button on the Family Of Parts Table command bar: 🔗.

To remove a link, use the Unlink Variable button on the command bar: 🔗.

**Formatting a family of parts table**

You can make formatting changes to a table before you click to place it, or you can place it first and then select the Properties button on the command bar or on the table shortcut menu to modify the table and data format.
Some of the formatting changes you can make include:

- Add one or more table titles of multiple lines of text.
- Hide a table row. Each row displays the values for a member of the family. You may not want to show the data for members other than the one in the drawing view.
- Hide a table column. Each column displays the family-derived values for a family variable. You may not want to show the values for a variable that does not have a corresponding dimension shown on the drawing view.
- Reorder members (rows) and variables (columns). You can move rows up and down, and you can move columns left and right.
- Change the data display order. You can do multi-column sorting with up to three columns.
- Insert one or more user-defined data columns, and specify that information such as mass, volume, and material be extracted from the model using property text strings.

Note

You can use property text to extract information from the Variable Table by selecting Variables From Active Document as the source in the Select Property Text dialog box. To learn how to use property text in a family of parts table, see the Extract model information using property text section in Modify a family of parts table on a drawing.

Use the options on the Format Column dialog box to do such things as add, align, and position headers, hide columns, change column width, and align data within the table.

To learn how to change the table format, see Modify a family of parts table on a drawing.

Updating a family of parts table

When a change to a family of parts causes a drawing table to go out of date, a thin gray border surrounds the table.

To update the table based on the model change, use the Update Family Of Parts Table command on the table shortcut menu. You also can use this command to apply formatting changes you make to an existing table.

Defining and modifying table styles

You can use the Styles command to create your own, fully customized Table styles in the Draft environment and make them available for many different table applications.

The Table style provides line style properties that control the display of table borders and grids. For example, you can change the color, type, and width of the border and grid lines. Set the Type to None if you do not want to display a table component.
For each component of a table, you also can define a text style. You can define different text styles for the table title, column headings, and cell data.

To learn more, see help topic Table styles.

To learn how to customize table styles, see Help topic Create or modify a table style.

**Tracking dimension and annotation changes**

**Activating the Dimension Tracker**

In the Solid Edge Draft environment, you can track dimensions and annotations that have changed when a drawing view is updated. The Dimension Tracker dialog box reports the changes for you to review and to label.

- You can open the Dimension Tracker dialog box at any time by choosing Tools tab→Assistants group→Track Dimension Changes from the menu. However, the contents of the dialog box are updated only when dimensions, annotations, or hole table entries have actually changed.

- The Dimension Tracker dialog box is opened automatically when you update a drawing view in which dimensions, annotations, or model-derived table entries have changed.

**Using the Dimension Tracker**

On the drawing, every changed dimension, annotation, and model-derived table is flagged by a balloon. On the Dimension Tracker dialog box, changed items are listed in columnar format. You can:

- Sort the changes by clicking on the column headings: ID, Element, Reason, Previous (Value), Current (Value), and Sheet. Each number in the ID column corresponds to a change balloon number on the drawing. The Element column identifies whether the item is a dimension or an annotation, and what type it is, for example, linear, coordinate, circular diameter, or balloon/callout.

- Select one or multiple items and assign a label to the corresponding balloons on the drawing using the New Revision button on the dialog box.

- Find a changed item on the drawing by clicking an item listed on the Dimension Tracker. This highlights the dimension or annotation on the drawing view. For complicated drawings, you can locate and zoom in on a changed item using the Find button.

- Remove validated items from the change list—and corresponding balloons from the drawing—using the Clear Selected or Clear All buttons.

**Change reasons**

The Reason column in the Dimension Tracker dialog box explains how a dimension or annotation changed when you updated a drawing view.

- **Detached – rebind failure.**
  Solid Edge was unable to find an eligible geometric element to rebind the item. The item may have been deleted.
• **Detached – no edge information.**
  The edge of the geometry was not rendered and could not be found.

• **Value changed.**
  The model feature changed size.

• **Terminator moved.**
  The terminator connect point was moved. The Annotation Moved Tolerance option on the Options tab of the Dimension Tracker dialog box specifies the distance tolerance beyond which this change is reported.

• **Geometric rebind – Reattached to available geometry.**
  The item was rebound to the nearest eligible geometric element within a preset distance tolerance.

• **Content changed.**
  A change to dimension text or other content not related to value was made to a PMI dimension. Examples of changes that cause the Content Changed reason to be displayed include edits to dimension prefix text, a changed dimension type and tolerance, and the addition of inspection requirements.

**Revision balloons**

To modify the appearance of revision balloons before they are added to the drawing, you can change these settings on the Options tab of the Dimension Tracker dialog box: Balloon Shape, Balloon Color, and Number of Sides (for n-sided balloons). Then, update the drawing view.

To alter the appearance of revision balloons already on the drawing, select the balloon and then select the Properties command on its shortcut menu. You can then edit the balloon annotation properties.

**Using Copy/Paste/Undo**

You can use the Copy button on the Dimension Tracker dialog box to copy all the information from the Dimension Tracker list, and then use the Paste command on the shortcut menu to paste the information to another document.

If you assign a label to a changed item and then want to revise it, you can immediately select the Edit→Undo command to restore the item to the Dimension Tracker list and the corresponding balloon to the drawing.

**Annotations overview**

An essential part of the design process is adding text, notes, and annotations. Annotations are text and graphics that give information about the design. You can add annotations to a drawing, a part, or an assembly by using the text and annotation commands in the software.
Types of annotations

To place annotations, you can use the following commands:

- **Text Box**

  ![Text Box Example]

- **Balloon**

  ![Balloon Example]

- **Callout**

  ![Callout Example]

- **Connector**

  ![Connector Example]

- **Feature Control Frame**

  ![Feature Control Frame Example]

- **Datum Frame**

  ![Datum Frame Example]
- Datum Target

![Datum Target Diagram]

- Surface Texture

![Surface Texture Diagram]

- Weld Symbol

![Weld Symbol Diagram]

- Center Mark

![Center Mark Diagram]

- Center Line

![Center Line Diagram]
Annotations with leaders

When you create a balloon, feature control frame, datum frame, datum target, or surface texture symbol, you can place them with a leader by setting options on the command bar. A weld symbol always has a leader.

The annotation’s leader can point to another element or be placed in free space. Annotations with leaders have the following components:

1. Leader line
2. Break line
3. Terminator
4. Annotation

You can manipulate the annotation by selecting the leader and moving parts of it. You can control the display of a leader’s break line and terminator and insert or delete vertices on a leader.

Snapping to keypoints and intersection points

When placing many types of annotation and when measuring distance, you can use shortcut keys to select and snap to keypoints or intersections. After you locate the line, circle, or other element that you want to snap to, you can press one of these shortcut keys to apply the point coordinates to the command in progress: M (midpoint), I (intersection point), C (center point), and E (endpoint).

To learn more, see Help topic Selecting and snapping to points.
Adding leaders

You can add a leader to an annotation with the Leader command. An annotation can have more than one leader. The terminator end of the annotation can point to an element or be placed in free space. The annotation end of a new leader must connect to an annotation or the leader on an annotation.

You can create a callout by placing a text box and adding a leader to it with the Leader command.

Inserting and deleting vertices on leaders

You can insert or delete a vertex on any annotation with a leader using the Alt key. To insert a vertex, click the leader, then position the pointer where you want the new vertex (1). Press and hold the Alt key, then click the mouse button (2). A new vertex is added, which you can reposition (3).

To delete a vertex, position the mouse over the vertex you want to remove, hold the Alt key and click the mouse.
Annotations and associativity

Annotations can be associative or non-associative. An associative annotation moves when the element it is connected to moves. Text boxes differ from the other annotations in that they are always non-associative.

If you attach the terminator of a leader to an element (1), the annotation moves with the element (2). If you create the leader connection point in free space, the annotation is not associative to any element in the drawing.

To make a connected annotation non-associative, press the Alt key while dragging the terminator handle to disconnect the annotation from the element.

To make a free space annotation associative, select the terminator of the leader and drag it to an element. The element edge highlights to show that it is connected.

To move a leader line connection point to free space or to another element yet retain associativity with the first element, press the Alt+Ctrl keys simultaneously while dragging the terminator handle.

Formatting annotations

You can format an annotation several ways. If you want several annotations to look the same, you can apply a style by selecting it on the command bar. Text styles can be applied to text boxes. You can apply dimension styles to the following annotations:

- Balloon
- Callout
- Feature control frames
- Datum frames
- Weld symbols
- Surface texture symbols
- Center marks, center lines, and bolt hold circles
- Connectors

If you want to customize the look of your annotations, you can select an annotation and edit its properties with the command bar or the Properties command on the Edit or shortcut menu.
Saving annotations

When an annotation, such as a feature control frame, appears several times, you can save the settings so that you can use them again. You can save any of the settings for a feature control frame, weld symbol, or surface texture symbol in a template with a name that you specify, much like a style.

Tracking changed dimensions and annotations

In the Solid Edge Draft environment, you can track dimensions and annotations that have been changed or deleted when a drawing view is updated. To open the Dimension Tracker dialog box so you can identify these changes, use the Tools→Dimensions→Track Dimension Changes command.

- On the drawing, every changed dimension and annotation is flagged by a revision balloon.

- On the Dimension Tracker dialog box, changed items are displayed in a columnar format. You can sort the changes by clicking a column heading.

- You can select one or more items in the list and assign a revision name to the balloon labels on the drawing.

To learn more, see Help topic Tracking dimensions and annotations.
Parts lists

Many companies include parts lists in their assembly drawings to give additional information about individual assembly components. For example, part number, material, and the quantity of parts required are typically documented in a parts list.

A Solid Edge parts list on a drawing is associative to the part view you select to create it. You can add balloons automatically to the drawing, and the balloons can be numbered to correspond to the part entries in the parts list.

![Parts list image]

<table>
<thead>
<tr>
<th>FIN. NO.</th>
<th>QTY</th>
<th>PART NUMBER</th>
<th>DESCRIPTION</th>
<th>MATERIAL</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>HEAD ASSY, GRINDER</td>
<td></td>
</tr>
</tbody>
</table>

Creating parts lists

You can create a parts list by selecting the Home tab→Tables group→Parts List command , and then selecting a part view. You can place balloons on the part view automatically by selecting the Auto-Balloon button on the Parts List command bar.

To learn more about using balloons in parts lists, see the Help topic, Balloons.
Specifying content and format of a parts list

Before you place the parts list on the drawing sheet, you can use the pages on the Parts List Properties dialog box to format it the way you want. You also can change the parts list formatting after you have placed it.

The parts list consists of a title (1), column header (2), and column data (3).

- The General page is where you specify the table style, the maximum number of data rows, and where it is to be placed on the drawing sheet. See the Help topic, Using the General tab.

- The Title page is where you specify the text, formatting, and positioning of table titles and subtitles. See the Help topic, Using the Title tab.

- The Columns page is where you define the column content and initial formatting. You define content by selecting the property text that you want to extract to display in it. You can combine multiple properties in each column, and you can add simple text strings to any column. See the Help topic, Using the Columns tab.

- The Data page is where you add and remove columns and rows, and where you edit extracted information displayed in individual cells. See the Help topic, Using the Data tab.

- Use the Balloon page to specify all aspects of balloons on the parts list:
  - Balloon shape and number of sides.
  - User-defined text and extracted property text.
  - Whether to show item number and count in the balloons.
  - Control level for duplicate auto-balloons.

- You assign the parts list item number format on the Options page. This also is where you choose whether to produce a cut length or total lengths part list for pipe and frames. See the Help topic, Using the Options tab.

- After the parts list is created, you can edit the item numbers displayed in the parts list and in the balloons using the Item Number page.
For each part and subassembly, you can use the List Control page to specify the granularity of the parts list.

On the Sorting page you can specify that the parts list is sorted based on the document number of the part in the assembly, by component type, material, quantity, and title. See the Help topic, Using the Sorting tab.

**Item numbers in parts lists**

You can include an Item Number column in the parts list, and show the part and subassembly item numbers that are used by the assembly. Item numbers are assigned in the assembly document using the Item Numbers page (Solid Edge Options dialog box).

To use these item numbers in parts lists, you must select the Use assembly generated item numbers check box on the Options page (Parts List Properties dialog box).

Alternatively, you can leave this option unchecked and have the Parts List command generate item numbers on the fly. You also can choose to use flat list item numbers or level based item numbers when you create an exploded parts list.

To learn more about item numbers, see the following Help topics:

- Exploded parts lists
- Item numbers in assemblies

**Items without balloons (*)**

An item number in the parts list that is marked by an asterisk indicates that no balloon was created automatically for it on the drawing. Items without balloons are controlled by options on the Parts List Properties dialog box:

- On the Options page, you can select the Mark Un-ballooned Items check box and specify one or more characters to display after the item number in the parts list.

**Example**

You can change the default single asterisk marker (*) to a double asterisk (**).

- On the Balloon page, you can use the Auto-Balloon options to control how many (or how few) duplicate balloons are created.

An item number balloon that displays NA represents a part that has been excluded using List Control.
Setting up part properties for the parts list

You can include part properties such as Title, Document Number, Mass, and Material in your parts lists. Use the Columns tab of the Parts List Properties dialog box to set up a column for each property you want in the parts list. The properties themselves are defined in the part and sheet metal documents, using these commands on the Application menu:

- Properties→File Properties command
- Properties→Material Table command

You also can use the Property Manager command to view and edit the document properties for a parts list. Working in a drawing of an assembly, the Property Manager command displays the document properties for all the parts in the assembly. This makes it easy to ensure that the parts list displays accurate and complete information about the assembly.

Note

You can define part properties without opening the part or sheet metal document in Solid Edge. Select the document in Windows Explorer, and then right-click and choose the Properties command.

For an example of how you can define a custom property and display it in a parts list, see Help topic Example: Show Custom Properties in a Parts List.

Accounting for non-graphic parts

Assemblies often contain components for which there is no model required, such as paint, grease, oil, labels, and so forth. These non-graphic parts still need to be documented in the parts list and bill of materials that are created for the assembly. In Solid Edge, you can use the File Properties command on the Application menu in the Part and Sheet Metal environments to add custom properties to an empty part document. Use the custom properties to define the required information for these types of parts. You can create two types of non-graphic parts: parts that require a unit type and quantity, and parts without a unit type and quantity.

For more information, see Non-graphic parts in assemblies.

Using multiple parts lists

You can create multiple parts lists for the same drawing. With multiple parts lists, you can have different item numbers for the same parts. You also can create parts lists that contain only specific component types (pipes, for example).

To create parts lists that share the same item numbers, you can designate an active parts list. Then, when you create other parts lists, use the Link To Active button on the Parts List command bar to link them.

You can make a different parts list the active parts list by selecting the Make Active command on the shortcut menu with the parts list selected. When you create a new parts list, it becomes the active parts list.
Renumbering parts lists

When you delete parts in an assembly and then update the parts list, the parts list is not automatically renumbered. For example, if you delete part number 10, the parts list will skip that number.
You can renumber a parts list using the Sorting tab on the Parts List Properties dialog box. If you used automatic ballooning when you created the parts list, renumbering the list also renumbers the balloons.

**Note**

The balloons for the deleted parts are not automatically deleted, but you can delete them manually.

```
<table>
<thead>
<tr>
<th>NO.</th>
<th>QTY</th>
<th>PART NUMBER</th>
<th>DESCRIPTION</th>
<th>MATERIAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>1</td>
<td>SHAFT1</td>
<td>SHAFT, INPUT</td>
<td>4140 STEEL</td>
</tr>
<tr>
<td>11</td>
<td>1</td>
<td>FLATE1</td>
<td>PLATE, INPUT</td>
<td>410 STAINLESS STEEL</td>
</tr>
<tr>
<td>10</td>
<td>1</td>
<td>CLAMP1</td>
<td>CLAMP</td>
<td>4540 STEEL</td>
</tr>
<tr>
<td>9</td>
<td>1</td>
<td>FLANGE1</td>
<td>FLANGE</td>
<td>4540 STEEL</td>
</tr>
<tr>
<td>8</td>
<td>2</td>
<td>EOLY1</td>
<td>BOLT WASHER HEAD</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>4</td>
<td>SHEILD1</td>
<td>SHEILD</td>
<td>1020 STEEL</td>
</tr>
<tr>
<td>6</td>
<td>2</td>
<td>GEAR1</td>
<td>GEAR, BEVEL</td>
<td>3620 STEEL</td>
</tr>
<tr>
<td>5</td>
<td>2</td>
<td>WASHER1</td>
<td>WASHER, THRUST</td>
<td>510 COPPER</td>
</tr>
<tr>
<td>4</td>
<td>4</td>
<td>SHAFT2</td>
<td>SHAFT, OUTPUT</td>
<td>4140 STEEL</td>
</tr>
<tr>
<td>3</td>
<td>2</td>
<td>BEARING1</td>
<td>BEARINGS, THRUST</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>FLATE2</td>
<td>PLATE, OUTPUT</td>
<td>410 STAINLESS STEEL</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>HEAD1</td>
<td>HEAD, GRINDER</td>
<td>A360 ALUMINUM</td>
</tr>
</tbody>
</table>
```

**Saving the parts list format**

You can save a parts list format with a name you define, so you can easily use it again. Use the Saved Settings option on the General page of the Parts List Properties dialog box to name, save, and reapply your parts list format.

A quick way to reapply the parts list formatting is to use the Saved Settings list on the Parts List command bar.

**Updating parts lists**

Parts lists are similar to part views; when the parts list is not up-to-date, a gray outline is displayed around the parts list to indicate that it needs updating. For example, if you edit the part properties, you will have to update the parts list to
display the changes. The Update Parts List command on the shortcut menu updates the parts list.

Solid Edge does not check the file time stamp to determine whether a parts list is out-of-date. Rather, the software computes the parts list in memory from cached properties and compares it to existing parts list data. If there are differences, the parts list becomes out-of-date.

Also, if mass is included in the parts list, the software uses the geometric time stamp of the model references to determine whether the parts list is out-of-date. This out-of-date check occurs during document transition (for example, when you open or save a file), during parts list updates, and when a drawing view using the same assembly the parts list references is created, updated, or deleted.

**Creating a custom table style**

You can use the Style command to create your own, fully customized Table styles for parts lists. For example, you can define line color for the table border, grid, and heading dividers.

When you place a parts list on the drawing, you can select a custom table style using the Table Style list on the Parts List command bar.

For more information, see these Help topics:

- Table styles
- Create or modify a table style

**Exploded parts lists**

You can use the Parts List command and options in the Parts List Properties dialog box to define and place an exploded parts list on an assembly drawing.

Use the Options page to:

- Show the item numbers that were created in the assembly.

  Using item numbers from the model ensures the parts list item numbers do not change unless the model does. Otherwise, item numbers generated on-the-fly by the Parts List command.

  **Note**

  You can use the assembly model item numbers when the Maintain item numbers check box is selected in the assembly document on the Item Numbers page, Solid Edge Options dialog box. To learn more, see Help topic Item numbers in assemblies.

Use the List Control page to:

- Display subassemblies and subassembly parts in an exploded parts list.
- Choose the item numbering format:
  - Level based item numbers, which indicate the hierarchy of an exploded parts list.
  - Flat list item numbers.
• Show the top level assembly in a row by itself.

Use the Columns page to:
• Select and format the Item Number data column.
• Select additional data columns—Mass (Item), Mass (Quantity), Miter Cut 1, and Miter Cut 2—when generating parts lists for assembly models containing frames, pipes, or tubes.
• Indent the item numbers or the content of any column.

Use the Sorting page to:
• Sort the item numbers in the same order that they are shown in Assembly PathFinder.

Instead of defining a custom exploded parts list style, you can select the default Solid Edge exploded parts list style from the Saved Settings list on the General page (Parts List Properties dialog box) or on the Parts List command bar.

**Using the Columns tab**

You can use the Columns tab on the Properties dialog box to define column content in a parts list or bend table. You do this by selecting property text to be extracted from the model document.

**Defining column content**

You define the column content by selecting the type of property you want to extract to display in it. You can combine multiple properties in each column, and you can add simple text strings to any column.

• Parts lists—You can choose a predefined parts list-specific property, such as Item Number, Quantity, Cut Length, Total Length, Mass (Item), Mass (Quantity) and miter angle (Miter Cut 1, Miter Cut 2).
  
  Column totals are computed automatically when you use the Mass (Item) and Mass (Quantity) columns.

• Bend tables—You can choose any predefined property in the sheet metal bend table to add to, or remove from, the drawing bend table. These include properties for Sequence, Radius, Included Angle, (outside) Angle, Direction, and Feature.

• You can choose from any of the other file properties, such as Material, Volume, Density, Status, Document Number, and Company.

• You can create custom columns by selecting the User Defined property.

• You can add simple text to the property strings in the column definition. The text is displayed in the parts list along with the property text derived values.

**Creating a custom column definition**

A custom column is one for which you specify the content you want to see. There are two things you need to do to create a custom column definition.
1. Use the Add Column button and select the User Defined property to define a custom column.

2. Use the Add Property button and the Properties list to select one or more types of data that you want to appear in this column. If you select multiple properties, they are added in a property text string to the dialog box.

You can add formatting to the property text string using the space bar and the Enter key. You can control the display order of extracted information by the order that you choose the property text. You also can type directly in the box to add special characters or any other fixed information that you want to appear in each cell in the custom column.

- Basic property text rules
- Property text codes for annotation and dimension text
- Format codes to modify property text output

**Formatting columns**

You can specify all column formatting on the Columns page. This includes column width and alignment, column heading position and alignment, and column heading text. For example, you can specify that column headings are centered but column data is left- or right-justified.

You can save all content and formatting specification settings on the Parts List Properties dialog box to be reused with another model. To save your parts list format, use the Save Settings options on the General page of the dialog box.

**Modifying individual columns**

Once the table is placed on the drawing, you can select a column to change its format. Use the buttons on the Data page to add new columns and rows, delete columns and rows, and edit the content of individual data cells. To learn how, see the Help topic, Make changes to a table or a parts list.

**Using the Options page**

The Options page in the Parts List Properties dialog box consolidates parts list-specific content selection properties in one location. It is where you specify item numbers, component types, and whether to generate a total length parts list.

**Formatting item numbers**

All properties that pertain to item number formatting are specified on the Options tab. You can:

- Specify whether item numbers are derived from the assembly and maintained by the assembly, or whether item numbers are generated on-the-fly by the Parts List command. If item numbers are not derived from the assembly, you can use the Item Number tab to edit the item numbers from within the parts list.
Tip
You can use the Assembly Order sorting criteria on the Sorting page to display the column data in the same order as the Assembly PathFinder.

- Specify the starting item number.
- Specify the number to increment by.
- Specify whether to mark items that do not have balloons, and what identifying string to use. The default mark is an asterisk (*).
- Specify if the parts list is renumbered by changing the sort order.

Note
The Maintain item numbers check box on the Item Numbers page (Solid Edge Options dialog box) in the assembly document controls whether item numbers are created in the assembly.

Selecting component types
You can include and exclude component types on the parts list—parts, pipes, pipe fittings, and frame members—and you can use the Move Up and Move Down buttons to change the component type display order.

You can sort the parts list by component type when you select the Component Type Order option on the Sorting page. You also can change the display order of information derived from the model document properties. Examples of these properties include file name, item number, quantity, material type, and material properties.
Specifying a total length or cut length parts list

A total length parts list shows all pipes and frame members derived from the same component displayed as a total length on the same row.

A cut length parts list (1) shows each frame member or pipe that is a different length displayed on a different row.

<table>
<thead>
<tr>
<th>Item #</th>
<th>Document Number</th>
<th>Qty</th>
<th>Cut Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>SQUARE TUBING 80x80x5</td>
<td>1</td>
<td>330.00 mm</td>
</tr>
<tr>
<td>2</td>
<td>SQUARE TUBING 80x80x5</td>
<td>1</td>
<td>347.20 mm</td>
</tr>
<tr>
<td>3</td>
<td>SQUARE TUBING 80x80x5</td>
<td>1</td>
<td>309.60 mm</td>
</tr>
<tr>
<td>4</td>
<td>SQUARE TUBING 80x80x5</td>
<td>1</td>
<td>249.00 mm</td>
</tr>
<tr>
<td>5</td>
<td>SQUARE TUBING 80x80x5</td>
<td>1</td>
<td>350.40 mm</td>
</tr>
<tr>
<td>6</td>
<td>SQUARE TUBING 80x80x5</td>
<td>1</td>
<td>350.80 mm</td>
</tr>
<tr>
<td>7</td>
<td>C CHANNEL 80x45</td>
<td>2</td>
<td>151.80 mm</td>
</tr>
<tr>
<td>8</td>
<td>C CHANNEL 80x45</td>
<td>4</td>
<td>321.60 mm</td>
</tr>
<tr>
<td>9</td>
<td>SQUARE TUBING 80x80x5</td>
<td>1</td>
<td>240.00 mm</td>
</tr>
<tr>
<td>10</td>
<td>SQUARE TUBING 80x80x5</td>
<td>2</td>
<td>244.00 mm</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Item #</th>
<th>Title</th>
<th>Qty</th>
<th>Cut Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>PIPE ANSI B36.1M - 3 x 0.120</td>
<td>1</td>
<td>293.52 mm</td>
</tr>
<tr>
<td>2</td>
<td>PIPE ANSI B36.1M - 1 1/2 x 0.169</td>
<td>1</td>
<td>859.33 mm</td>
</tr>
<tr>
<td>3</td>
<td>PIPE ANSI B36.1M - 3 x 0.120</td>
<td>1</td>
<td>204.37 mm</td>
</tr>
<tr>
<td>4</td>
<td>PIPE ANSI B36.1M - 3 x 0.120</td>
<td>1</td>
<td>153.37 mm</td>
</tr>
<tr>
<td>5</td>
<td>PIPE ANSI B36.1M - 3 x 0.120</td>
<td>1</td>
<td>452.33 mm</td>
</tr>
<tr>
<td>6</td>
<td>PIPE ANSI B36.1M - 1 1/2 x 0.169</td>
<td>1</td>
<td>216.53 mm</td>
</tr>
<tr>
<td>7</td>
<td>PIPE ANSI B36.1M - 1 1/2 x 0.169</td>
<td>1</td>
<td>258.53 mm</td>
</tr>
<tr>
<td>8</td>
<td>PIPE ANSI B36.1M - 1 1/2 x 0.169</td>
<td>1</td>
<td>210.39 mm</td>
</tr>
<tr>
<td>9</td>
<td>PIPE ANSI B36.1M - 1 1/2 x 0.169</td>
<td>1</td>
<td>141.33 mm</td>
</tr>
<tr>
<td>10</td>
<td>PIPE ANSI B36.1M - 1 1/2 x 0.169</td>
<td>1</td>
<td>260.43 mm</td>
</tr>
<tr>
<td>11</td>
<td>PIPE ANSI B36.1M - 3 x 0.120</td>
<td>1</td>
<td>272.74 mm</td>
</tr>
<tr>
<td>12</td>
<td>PIPE ANSI B36.1M - 3 x 0.120</td>
<td>1</td>
<td>223.46 mm</td>
</tr>
<tr>
<td>13</td>
<td>PIPE ANSI B36.1M - 3 x 0.120</td>
<td>1</td>
<td>271.05 mm</td>
</tr>
<tr>
<td>14</td>
<td>Elbow 90° Class 150 ANSI B16.1 - 1 1/2</td>
<td>2</td>
<td>286.80 mm</td>
</tr>
<tr>
<td>15</td>
<td>Elbow 90° Class 150 ANSI B16.1 - 1 1/2</td>
<td>1</td>
<td>257.05 mm</td>
</tr>
<tr>
<td>16</td>
<td>Flange Class 150 ANSI B16.5</td>
<td>1</td>
<td>271.05 mm</td>
</tr>
<tr>
<td>17</td>
<td>Flange Class 150 ANSI B16.5</td>
<td>1</td>
<td>304.80 mm</td>
</tr>
</tbody>
</table>

**Note**

Cut length can be synchronized with Teamcenter. The value appears as a Note in Product Structure Editor.

It is easy to generate either type of parts list for pipes and frames. See the Help topic, Create a total length parts list.
Balloons

Many companies include parts lists in their assembly drawings to give additional information about individual assembly components. For example, part number, material, and the quantity of parts required are typically documented in a parts list.

You can add balloons to the drawing, and the balloons can be numbered to correspond to the part entries in a parts list.

Balloons also can display property text extracted from a source file.

### Automatic balloons on a part view

You can automatically add balloons to a part view of an assembly based on its parts list when you choose the Parts List command and set the Auto-Balloon option on the Parts List command bar.

When you select the part view that you want to balloon, the parts list and the balloons that reference it are created automatically.

You also can create balloons automatically without placing a parts list. To learn how to do this, see the Help topic, Automatically Add Balloons to a Part View.
Controlling duplicate balloons

You can specify varying levels of control for duplicate balloons using the Auto-Balloon options on the Balloon page (Parts List Properties dialog box). For example, when working with multiple drawing views, you can specify that no part item has more than one balloon shown in the entire document, no matter how many drawing views show the part.

Adjusting text size for automatic balloons

The appearance of automatically generated balloons is specified by options on the Balloon page of the Parts List Properties dialog box. Here, for example, you can adjust the text size of the balloons before you add them to the drawing by typing a new value in the Text Size box.

Balloon item numbers

You can specify that balloons in a part view of an assembly display item numbers that reference the item numbers in a parts list.

- If you place the balloons before you create the parts list, the item numbers are assigned sequentially in the order you select the parts.

- If you place the balloons after you create the parts list, the item numbers in the balloons match the active parts list.

Note

There can be multiple parts lists on a drawing. The most recently created parts list is the active parts list.

You can make a different parts list the active parts list by clicking Make Active on the shortcut menu with the parts list selected.

To assign item numbers, use the Balloon command and set these options on the Balloon command bar:

- Link To Parts List, which automatically generates balloons according to the active parts list.

- Item Number, which automatically generates the balloon item numbers. If you clear the Item Number option, then you can add the item numbers individually to each balloon.

- Item Count, which adds the part quantity value to the bottom half of the balloon.

You can modify the balloon item numbers and the parts list at the same time.

- To edit the item number values in the parts list and in the balloons, use the Item Number tab (Parts List Properties dialog box).

- To change the item number formatting, use the Options tab (Parts List Properties dialog box).
Balloons that reference property text

You can create balloons that reference property text information in a source document. Some examples include project, part document number, material specification, and revision.

To select the specific property text to be displayed in a new balloon, use the Property Text button on the Balloon command bar to open the Select Property Text dialog box.

You can assign property text to different text locations in the balloon—(A), (B), (C), and (D)—by adding the property text string into the Text, Lower, Prefix, and Suffix boxes on the Balloon command bar.

Note

To display property text at text location (A), you must clear the Item Number option on the Balloon command bar.

To learn how to create or modify balloons so that they show a document number or other document property, see Show Document Properties in Balloons.

Stacking balloons

When multiple balloons reference items in the same parts list group, they often overlap one another and it is difficult to see what the leaders are pointing to. The parts that comprise a fastener group, for example—bolt, washer, lock washer and nut—are small and close together. You can rearrange the fastener’s balloons into a stack, yet have each fastener part retain its associativity. If a part item number changes, its balloon also updates.
When balloons are stacked, they align in a vertical or horizontal row, with a single leader attached to the first balloon in the stack. This example shows a horizontal stack and accompanying parts list. The first balloon is the one at right with the attached leader.

<table>
<thead>
<tr>
<th>Item Number</th>
<th>Document Number</th>
<th>Material</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>Metric hex nut</td>
<td>Steel</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>style 1 ANSI</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>B18.2.4.1M M6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Helical spring</td>
<td>Steel</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>lock washer</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>ANSI B18.211</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>heavy 1/4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Plain washer</td>
<td>Steel</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>ANSI B18.22M</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>regular 6 mm</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Hex head metric</td>
<td>Steel</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>machine screw</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>ANSI B18.6.7M</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>M6x25</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

To learn how to arrange balloons in a stack, see Help topic Stack Balloons.
Center lines, center marks, and bolt hole circles

Center lines, center marks, and bolt hole circles are used in the Draft environment to facilitate the dimensioning and annotation process. They are associative to the elements they are added to in the 2D Model sheet, working sheet, or drawing view. If the drawing view is modified, the center lines, center marks, and bolt hole circles will update their position and size accordingly.

You can use the Angle Between command to add dimensions that reference these annotations.

Adding center lines, center marks, and bolt hole circles

You can add a center line, center mark, or bolt hole circle annotation one annotation at a time, or automatically add them to all part views on the drawing sheet. For center lines and center marks, you can fence-select a group of elements to add them to.

The commands to add these annotations are located on the Home tab→Annotation group.

- Automatic Center Lines command, for part views only, provides access to command bar functions that automatically add and remove both center lines and center marks.
- Center Line command adds individual center lines.
- Center Mark command adds center marks to one or more curved elements, such as circles, arcs, ellipses, or partial ellipses.
- Bolt Hole Circle command
Modifying center lines, center marks, and bolt hole circles

You can change the appearance of an existing center mark, line, or bolt hole circle by changing its properties. Select the annotation and then use the Properties command on the shortcut menu.

Any of these annotations can be removed individually using the Delete command on the annotation’s shortcut menu.

Center lines and marks that were added automatically with the Automatic Center Lines command can be removed as a group by setting the Remove Lines and Marks button on the Automatic Center Lines command bar.

Engineering Fonts

The engineering fonts delivered with the software contain industry-specific fonts, special characters, and symbols that you can use to annotate engineering drawings. These fonts include degree symbols, diameter symbols, and other special characters and symbols that are not usually included in a typical word processing package.

Your choice of font should be based on the industry for which you are creating engineering drawings.

The software provides TrueType fonts; with TrueType fonts, what you see on the screen is what appears on the printed page. The screen display of the document closely matches the printed document.

Geometric Tolerancing

Geometric tolerancing is a form of annotation that you can use to provide additional information about the features of a part. While dimensions and their associated tolerances give information about the acceptable variation in the size or location of a feature on a part, geometric tolerancing establishes the relationships between features on a part. For example, you can define the tolerance for the position of a hole in a part in relation to other features, or datums, on the part.

Solid Edge supports the ASME Y14.5-1994 drafting standard for geometric dimensioning and tolerance callouts. The "between" and "statistical tolerance" symbols are supported in the TrueType symbol fonts.

In the Draft environment, you can define the geometric tolerances required with the Feature Control Frame command. This command allows you to define the necessary tolerance on a feature in relation to reference letters for other features of a part, called datums. You can identify the datums on your part using the Datum Frame command.
Feature Control Frames

A feature control frame is composed of two or more rectangular compartments that contain information about tolerances. The first block always contains a geometric characteristic symbol. Subsequent compartments contain tolerance values and symbols representing part variations, such as maximum material condition. You can create the feature control frame by typing text and selecting symbols from a dialog box.

You can refer to up to three datums in a feature control frame. These represent the primary, secondary, and tertiary datums.

A feature control frame has the following parts:

1. Geometric characteristic symbol
2. Tolerance
3. Datum reference
4. Tolerance zone symbol
5. Tolerance value
6. Material condition symbol

A valid feature control frame must contain these two components:

- Geometric characteristic symbol
- Tolerance

Some geometric characteristics also require a reference to a datum in the feature control frame. You can apply material conditions to the tolerance and datum references. You can also apply a diametral tolerance zone to the tolerance.

Saving Feature Control Frames

You can save a feature control frame so that you can use it again quickly and efficiently. You can then access the saved frame from the command bar.
Lesson 9  Dimensions, Annotations, and PMI

Product Manufacturing Information (PMI)

PMI overview

Product Manufacturing Information, or PMI, consists of dimensions and annotations that are added to the 3D model and can be used in the review, manufacturing, and inspection processes.

In synchronous and ordered modeling, PMI dimensions also provide an important design modification tool. By editing dimension values you can make changes to the model. You can lock and unlock dimensions to control how connected model faces respond to dimension value edits. And you can control the direction in which dimension edits are applied. This greatly simplifies the process of design, testing, and update.

The Solid Edge PMI application combines the functionality of adding dimensions and annotations, generating fully rendered 3D model views with 3D section views, drawing formatting, and publishing the information.

You can add these types of PMI:

- Dimensions—Smart Dimension, Distance Between, Angle Between, Coordinate Dimension, Angular Coordinate Dimension, Symmetric Dimension.

- Annotations—Leader, Balloon, Callout, Surface Texture Symbol, Weld Symbol, Edge Condition, Feature Control Frame, Datum Frame, Datum Target.

For more information about adding these PMI elements, see the Help topic, PMI dimensions and annotations.
You can create these types of views:

- 3D section views, which can be added to or removed from,

- 3D model views

  **Note**

  - The dimensions you add using the ordered PMI dimensioning commands are always driven dimensions.
  
  - You can choose whether a synchronous PMI dimension added to the model should be locked or unlocked.
  
  - The section views and model views are associative to the 3D model. When the 3D model changes, the section views and model views also update.

**PMI commands**

The PMI tab conveniently groups the commands you need to:

- Add PMI dimensions and annotations directly in the 3D model.

- In the ordered environment, copy 2D dimensions and annotations from a sketch to the PMI 3D model.

- Create model and section views of the 3D model.

In the synchronous environment, you also can use dimension and annotation commands located on any other tabs on the ribbon to add PMI to the model, as well as to dimension sketches. It is the type of element you select (model edge or sketch geometry), not the command, that determines whether a dimension is a three-dimensional PMI dimension or a two-dimensional sketch dimension.

For information about using PMI commands, see the Help topic, **Working with 3D PMI**.

**PathFinder, PMI, and model views**

PathFinder accesses and controls all PMI elements and 3D model views for the model. If a sheet metal model has two different states, designed and flattened, for example, then the PMI and model views are owned by the model state in which they are created.
• The PMI collection located on PathFinder contains expandable sub-collections of all Dimensions, Annotations, and Model Views in the active document.

• If the PMI collection is empty, then it is not displayed in PathFinder.

• When you define a PMI model view, its name is added to the Model Views collection.

• A separate Section Views collection, located in PathFinder above the PMI collection, contains all 3D section views that have been defined in the document.

• PMI elements and section views can appear multiple times in PathFinder. When one of these items is selected, all occurrences of the item are selected.

This table explains the PMI-related icons used in PathFinder.

A node is the top-level entry in a PMI collection or in a sub-collection under a defined model view.
### Legend

<table>
<thead>
<tr>
<th>PMI</th>
<th>PMI collection symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimensions</td>
<td>Dimension node, shown (in PMI or Model Views collection)</td>
</tr>
<tr>
<td>Dimensions</td>
<td>Dimension node, hidden (in PMI or Model Views collection)</td>
</tr>
<tr>
<td>PMI dimension element, shown</td>
<td>PMI dimension element locked (synchronous)</td>
</tr>
<tr>
<td>PMI dimension element, hidden</td>
<td>Annotation node, shown (in PMI or Model Views collection)</td>
</tr>
<tr>
<td>Annotation node, hidden (in PMI or Model Views collection)</td>
<td>PMI annotation element (callout symbol example), shown</td>
</tr>
<tr>
<td>PMI annotation element (callout symbol example), hidden</td>
<td>Model Views collection</td>
</tr>
<tr>
<td>Defined model view</td>
<td>Section Views collection</td>
</tr>
<tr>
<td>Section view, applied</td>
<td>Section view, unapplied</td>
</tr>
</tbody>
</table>

### Note

- The check box in front of each PMI element listed in PathFinder turns the element on and off. There are also Show, Hide, Show All, and Hide All commands on the shortcut menu for each group of Dimensions and Annotations.

- Model views are not shown or hidden, but instead they are applied to the graphic window using the Apply View command.

- Defined 3D sections are applied and removed using the Apply Cut command.
The following image and corresponding table explain the color codes assigned to dimensions.

<table>
<thead>
<tr>
<th>PMI dimension color codes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Color</strong></td>
</tr>
<tr>
<td>Blue</td>
</tr>
<tr>
<td>Red</td>
</tr>
<tr>
<td>Purple</td>
</tr>
<tr>
<td>Brown</td>
</tr>
</tbody>
</table>
Within the PMI collection, different types of dimensions—for example, linear, radial, angular—display unique symbols and element names on PathFinder. Also, their respective color code is displayed.

Annotations work the same way, with their own set of symbols and specific naming conventions.

To learn more about showing and hiding PMI elements, see the Help topic, Working with 3D PMI.

**Reviewing a PMI model**

A special PMI model review mode allows you to review all of the model views defined in the document along with their associated PMI data. You may want to use this feature before exporting PMI models and data to View and Markup, for example.

When you select the Review Command (PMI Model Views), a PMI Model Review command bar is displayed to guide you through the review of each model view.

For more information, see the Help topic, Creating 3D model views with PMI.

**Sharing a PMI model**

There are many ways you can share 3D models and their attached data.

- Use the Create Drawing command to generate a drawing of the dimensioned model currently displayed in the graphics window. You also can use the Create Drawing command to generate a drawing of any model view “snapshots” you have created in the document.

- Use the Apply View command to display a model view with a special orientation in the graphics window, and then use the Print command to print it.

- Use the Save As Image command on the Application menu to save the contents of the graphic window in an image file format.
Lesson 9  

*Dimensions, Annotations, and PMI*

- Publish them to a format compatible with View and Markup using the Send PMI to View and Markup command. This will save the file in .pcf format, making it available to View and Markup.

- Publish them to Solid Edge Viewer using the Save As command to save the information to .jt format.

**Creating drawings of a PMI model**

You can use the Drawing View Wizard to produce drawings from a 3D model with PMI. The data in the model views—view orientation, 3D sections, and PMI dimensions and annotations—are copied to the drawing view. The PMI text copied to the drawing retains its three-dimensional aspect.

There are two basic ways to do this:

- You can generate the drawing from the current model representation in the graphics window.

- You can generate drawings from alternate model views that you have created using the View command. Model views allow you to apply special formatting, backgrounds, and view orientations to your model.

Once you have copied one or more PMI model views to the drawing, you can:

- Turn associativity with the model view on and off.

- Change the PMI model view currently displayed in the drawing view.

- Choose a different render mode—including color shading—for each of the model views on the drawing.

For more information, see the Help topic, Create a PMI drawing.

**Working with 3D PMI**

**Model view creation workflow**

PMI model view creation is WYSIWYG. The model orientation, render mode, annotations, and dimensions that are visible in the graphics window when you select the Model View command are what you get when the PMI model view is created.

**Note**

Models in an assembly must be activated before PMI can be added to them.

1. Set a PMI dimension and annotation plane. In the ordered environment, use the Lock Dimension Plane command on the PMI toolbar to set an active 3D dimension and annotation plane. Annotations and dimensions are placed parallel to this plane. You can change this dimension plane at any time while adding annotations and dimensions.
2. **Add PMI dimensions and annotations.** In the synchronous environment, sketch dimensions migrate automatically to the 3D model when you extrude a sketch region or use another command that converts the 2D region to a 3D solid. You also can add new PMI annotations and dimensions directly to the model using the commands on the PMI tab.

   See these Help topics for more information:
   
   - Part Modeling workflow overview
   - PMI dimensions and annotations

3. **Add PMI dimensions and annotations.** In the ordered environment, you can use the Copy To PMI command to copy 2D dimensions and annotations from a feature or sketch to the 3D model. You can edit the copied elements using the commands on their shortcut menu. You can add new PMI annotations and dimensions using the commands on the PMI tab.

   To learn more about PMI dimensions and annotations, see the Help topic, **PMI dimensions and annotations.**

4. **Choose a view orientation** for the model view using standard rotation, view selection, and zoom commands.

5. **Create a PMI model view.** Use the PMI tab→Model Views group→View command to capture all of this display information, assign a view name and render mode, and save the view. It adds the view name to the “Model Views” collection on PathFinder. All of the dimensions and annotations associated with the model view are listed under the model view name.

   To learn more about PMI model views, see the Help topic, Creating 3D model views with PMI.

6. **Modify the model view.** If necessary, change the model orientation and display settings.

   You can hide PMI elements that interfere with the view.

   Use the Edit Definition command on the model view shortcut menu to:
   
   - Change the model view name and definition using the Options button on the Edit Definition command bar.
   
   - Make changes to the display of parts and subassemblies in the view using the Model View Display group button on command bar.
   
   - Add and edit dimensions and annotations in the model view using the Model View Display group button on command bar.

   To learn how, see the Help topic, Edit a PMI model view definition.

7. **Create additional model views.** Use the Model View command to capture a new orientation and display mode for corresponding PMI. Assign a different name to this view, and choose a render mode as desired. If you change the render mode, use the Apply View command on the PathFinder shortcut menu to apply the view settings to the graphic display.

8. **Review.** Use the Review command for a graphical tour of all PMI model views.
Lesson 9  Dimensions, Annotations, and PMI

9. **Export and publish the model view.** Use the Send PMI To View and Markup command to publish your PMI model views and open them in View and Markup.

   To learn more about publishing PMI models, see the Help topic, Publishing Product Manufacturing Information (PMI) and Model Views to View and Markup.

### Adding a 3D section view to a model view

Within the context of the PMI workflow, any 3D sections applied at the time of model view creation are automatically included in the model view, but you can add or remove sections after the model view is created, too.

1. Set the section view display properties.

2. Display or hide the cutting plane.

3. Add the section to the model view.

For more information about using section views in PMI model views, see the Help topic, Use a 3D section view in a PMI model view.

### Model view editing commands

The commands you use to edit the definition and properties of a 3D model view are located on the shortcut menu of the selected model view on PathFinder. For example, the shortcut menu to manipulate model views contains these commands:

<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete</td>
<td>x</td>
</tr>
<tr>
<td>Rename</td>
<td>F2</td>
</tr>
<tr>
<td>Apply View</td>
<td></td>
</tr>
<tr>
<td>Review...</td>
<td></td>
</tr>
<tr>
<td>Set View Orientation</td>
<td></td>
</tr>
<tr>
<td>Send PMI to View and Markup</td>
<td></td>
</tr>
<tr>
<td>Edit Definition</td>
<td></td>
</tr>
</tbody>
</table>

To learn how to use these commands to manipulate PMI model views, see the Help topic, Manipulate a PMI Model View.
PMI element editing commands

The commands you use to add PMI elements to 3D model views, remove PMI elements from 3D model views, and show and hide PMI elements are also located on the shortcut menu of a selected dimension or annotation in PathFinder:

To learn how to use the commands to manipulate PMI elements, see the Help topic, Display and edit PMI elements.
Whether PMI elements are visible or not is controlled by the check box preceding an element or node name, and by the Show and Hide commands on the shortcut menu.

Showing and hiding nodes and elements
When you point to the top level of a Dimensions or Annotations collection, the Show command acts as a gatekeeper for the individual PMI elements in that collection.

- If you select Hide while pointing to the Dimensions or Annotations node, then all the dimensions and annotations in the collection are immediately turned off in the display.

  Note
  Individual elements can only be made visible if the node is also set to be shown.

- If you select Show while pointing to the Dimensions or Annotations node, then the dimensions and annotations in the collection can be shown, depending upon their individual show/hide settings.

  Tip
  You can edit a model part or feature without the clutter of PMI annotations and dimensions. Use the Hide command to temporarily remove the annotations and dimensions; use the Show command to restore them.

If you set or clear the check box in front of an individual PMI element in any collection, then all instances of this PMI element are shown or hidden in the document.

See the Display and edit PMI elements section in the Product Manufacturing Information (PMI) overview Help topic for a table that illustrates the show and hide states of PMI-related icons.

Show or hide in a model view
If you select Hide while editing a model view, then elements that are hidden when you exit edit mode are removed from that model view’s list of collected elements.

Show All and Hide All
The Show All and Hide All commands for a node are a fast way to turn on or off all of the individual dimensions or annotations in the document.

PMI dimensions and annotations

Creating PMI elements
Annotations and dimensions placed on model geometry are PMI elements. They are created in two ways.

- When you use a sketch to construct a feature, the dimensions placed on the sketch migrate to the appropriate edges on the solid body. These migrated dimensions become three-dimensional, PMI dimensions. See the Help topic, Create a dimensioned part from a sketch.
Annotations placed on a sketch also are copied to the model.

- You can place dimensions and annotations directly on model edges at any time using any of the commands on the ribbon. In addition, the tool set on the PMI tab conveniently groups all PMI-related functions together in one place.

  **Note**
  The commands you use to place dimensions and annotations on sketches and on the model are the same. However, dimensions and annotations placed on 2D sketch elements and those placed on 3D model elements behave differently. The differences are most apparent during editing.

### Locked and unlocked PMI dimensions

In synchronous models, you can use PMI dimensions to modify the model. You control the effect of model changes by choosing whether a dimension on a model edge is locked or unlocked, and by specifying the direction of change.

- An unlocked dimension means that when faces connected to the dimensioned edge are modified, the dimension value is allowed to change. The default color of an unlocked dimension is blue.

- A locked dimension keeps the dimension value from being changed when a connected face is moved or resized.

  A dimension must be locked before a formula or variable rule can be applied to the dimension.

  The default display color of a locked dimension is red.

In PathFinder, a locked dimension is easily identified by the lock icon 🛡.

  **Note**
  All 2D dimensions that migrate from sketches are locked.
You can edit individual dimensions to lock and unlock them, as needed to modify the model. Use the lock button on the Dimension Value Edit dialog box to change a dimension from unlocked to locked.

If the Lock button is not available, select the Maintain Relationships command.

**Note**

**Dimension locking rules**

- It is better to leave dimensions unlocked, only locking values as necessary for a particular edit. When you edit the model, the edit is automatically localized, leaving uninvolved dimensions unchanged.

- In synchronous modeling, a PMI dimension must be locked before it can be driven by a formula or be used in a formula. Similarly, you cannot unlock a dimension that is controlled by a formula or is used within the formula of another dimension or variable.

To learn how you can modify a model by editing dimension values, see the Help topic, Editing model dimensions.

**PMI dimension colors**

The following table explains the color codes assigned to dimensions.

<table>
<thead>
<tr>
<th>PMI dimension color codes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Color</strong></td>
</tr>
<tr>
<td>Blue</td>
</tr>
</tbody>
</table>
**PMI dimension color codes**

<table>
<thead>
<tr>
<th>Color</th>
<th>Solve condition</th>
<th>Dynamic Edit?</th>
<th>Attached to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red</td>
<td>Locked, dimension constrained</td>
<td>Yes</td>
<td>Synchronous elements</td>
</tr>
<tr>
<td>Purple</td>
<td>Driven by other dimension or variable</td>
<td>No</td>
<td>Ordered elements or otherwise uneditable PMI</td>
</tr>
<tr>
<td>Brown</td>
<td>Not available</td>
<td>No</td>
<td>Not adequately attached to any element</td>
</tr>
</tbody>
</table>

**PMI dimension edit cursors**

As you move the Select cursor over a dimension, it indicates the type of operation that is available if you click at that location:

<table>
<thead>
<tr>
<th>Cursor image</th>
<th>Operation</th>
<th>When is it displayed?</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit the dimension value.</td>
<td>Cursor is over the dimension text.</td>
<td><img src="image1.png" alt="Example" /></td>
<td><img src="image2.png" alt="Example" /></td>
</tr>
<tr>
<td>Drag a terminator inside or outside the extension lines.</td>
<td>Cursor is over a dimension terminator.</td>
<td><img src="image3.png" alt="Example" /></td>
<td><img src="image4.png" alt="Example" /></td>
</tr>
<tr>
<td>Modify the dimension properties.</td>
<td>Cursor is over a dimension line or extension line.</td>
<td><img src="image5.png" alt="Example" /></td>
<td><img src="image6.png" alt="Example" /></td>
</tr>
</tbody>
</table>

**PMI dimension modification handles**

There are two types of dimension modification handles: a value edit handle and formatting handles.
Dimension value edit handle

- A PMI dimension value edit handle is displayed when you click the dimension text. The dimension value edit handle consists of a Dimension Value Edit dialog box (1) and 3D arrow and sphere terminators (2).

- The dialog box is where you enter or edit the value.
- You control the direction in which the edit is applied by clicking the arrow buttons on the dialog box or by clicking either of the 3D terminators.
  ◊ The 3D sphere terminator indicates the stationary side.
  ◊ The default direction is indicated by the highlighted arrow button on the dialog box and by the 3D arrow terminator. Sometimes the 3D terminators are more explicit, as shown in the following example.

To learn how to use the dimension value edit handle, see the Help topic, Resize the model by editing PMI dimension values.

- If the Dimension Value Edit dialog box is completely disabled, it means the dimension cannot be edited in its current state.

Dimension formatting handles

- You can change the dimension format using these handles:
  - The Edit Definition command bar and dimension formatting handles are displayed when you click a dimension line or extension line.
You can use the options on the Edit Definition command bar to modify the dimension properties, including tolerance, prefix, and orientation.

The filled circles are format handles you can drag to change the length of the dimension line and extension lines.

When you click a dimension terminator, such as an arrow, you can drag it outside or inside the extension lines.

To learn how you can show and hide, edit, and manipulate PMI elements, see the Help topic, Display and edit PMI elements.

**Not-to-scale dimensions**

You can override the value of a driven dimension by right-clicking on the dimension and selecting *Not to Scale* from the context menu. Solid Edge underlines the values of not-to-scale dimensions.

The not-to-scale designation appears in the dimension’s value edit dialog.

**Preselection preview**

When you place your cursor on a dimension value, you see two preselection preview features that show you how a dimension value edit will be applied: direction of edit and model face selection.

**Direction preview**

- Where you place your cursor prior to selecting the dimension text influences the direction in which the edit will be applied.
Lesson 9  Dimensions, Annotations, and PMI

– If you place the cursor on the left side of the dimension value, in this example the number 4, then the direction arrow points left. If you select the dimension value by clicking here, the edit will be applied in this direction.

– If you place the cursor on the right side of the dimension value, in this example the number 5, then the direction arrow will point right. If you select the dimension value by clicking here, the edit will be applied in this direction.

Face selection preview

You can preview what model faces will be affected when you edit a dimension value, by pointing to the dimension text without selecting it. The related model faces are highlighted for you to review them.

To change the selection set, you can set and clear relationships on the Live Rules options window.

You also can affect the outcome by changing the solve option on the Dimension Edit QuickBar.

To learn more, see these Help topics:

• Working with Live Rules

• Select faces to be modified by PMI dimension edits
Using keypoints

When placing PMI model dimensions that you want to use to change the model, you can use the 3D keypoint filter, Center And Endpoints ⬤ and Midpoint ⬥. This ensures that dimensions are placed on keypoints that are valid for modifying the model. These keypoints are at the centers of circles and arcs and at the midpoints and endpoints of edges.

Note

The Center and Endpoints, and Midpoint filters use virtual vertices to derive the appropriate keypoint.

To use either of these keypoint filters during dimension placement, select the Keypoints button on the Dimension command bar, under the Other group button. Then select the desired filter.

Using a dimension plane

When you add PMI dimensions and annotations to a model, they are aligned parallel to a dimension plane. The default plane is the base plane most parallel to the screen. However, you can choose a different plane using the Lock Dimension Plane option ⬤ on the command bar. This option is available when you have selected a dimension or annotation command.

Only planes you set explicitly appear in the graphics window. These are displayed in red-brown half-highlight.

To turn off a dimension plane you have set, press F3.

Using intersection points

You can use a model intersection point to place a PMI dimension. Using an intersection point:

- Makes it easy to add a dimension to a model edge that has been rounded, split, or trimmed.
• Helps the dimension rebind to the original endpoints when the model edge is rounded, split, or trimmed.

Solid Edge automatically detects the presence of intersection points. You can use the intersection point method when placing any dimension.

Note
To turn off Intersection Point mode, select a dimension command and press the “I” key.

Example
Following are some examples of when you might want to place dimensions using intersection points.

Edge modified by rounding

Edge modified by trimming

Edge modified by splitting
You also can use QuickPick to locate all intersection points—not just the least-distance default—as shown in the following example:

![QuickPick dialogue box]

You also can place a dimension using the intersection point of a virtual center line and the surface of a cylindrical or conical object, including canted, toroid, spherical, and splined shapes. These intersection points are available on demand, without having to invoke Intersection Point mode.

To learn how to use this feature, see the Help topic, Place a PMI dimension using an intersection point.

**Using a dimension axis**

Sometimes you need to add a PMI element that measures along an axis that is not orthogonal to the object you are dimensioning. This may be the case when you use the Distance Between, Angle Between, Coordinate Dimension, or Symmetric Diameter command.

When one of these dimension commands is in progress, you can use the Dimension Axis option under the Properties group button on the Dimension command bar to set the dimension axis.

**Adding PMI dimensions**

You can use the Smart Dimension command to dimension circles, arcs, and ellipses as well as linear elements.

When adding a dimension that requires two points:

- The first click determines the point to measure from.

- The second click specifies the point or element to measure to.
Lesson 9  
*Dimensions, Annotations, and PMI*

Dimension stacking and chaining
- Linear dimensions can be stacked or chained using the Distance Between command.
- Angular dimensions can be stacked or chained using the Angle Between command.
- Symmetric diameter dimensions can form a stack, not a chain.
- All dimensions in a stack or chain must be placed with respect to the same active dimension plane.
- Each stacked or chained dimension has its own entry on PathFinder.

Adding PMI annotations
- You can place annotations in free space.
- You can attach annotations to model faces, surfaces, curves, edges, and sketch elements.
- You can attach annotations to existing dimensions and annotations.
Here, the datum annotation is attached to an existing feature control frame.

They also can connect to faces.

**Modifying PMI format and properties**

You can select and modify individual PMI elements by doing any of the following:

- When the dimension format handles are displayed, you can:
– Modify PMI dimension round-off, dimension type, tolerance, and prefix for the selected element, using the options on the command bar.

– Change the length of the dimension lines and dimension extension lines by selecting and dragging a red dot. You also can select and drag a dimension arrow outside the extension lines.

• Use the Properties button on the command bar or the Properties command on the shortcut menu to change formatting properties for font size, terminator type, extension line type, coordinate display, and more.

  – If you select a dimension, then the Dimension Properties dialog box is displayed.

  – If you select an annotation, then the annotation-specific dialog box is displayed.

You can make changes that affect all PMI elements at once:

• You can make interactive adjustments to PMI text size so it is easier to read when you zoom in and out of the model.

• You can change PMI element color globally by modifying the style.

To learn more, see the Help topic, PMI text size and color.

**Moving a PMI element**

There are several ways you can move PMI elements.

• You can move a PMI dimension or annotation using the Move Dimension command. This moves PMI elements in a direction that is normal to the plane where they reside, adding extension lines as needed.
• Placing your cursor on a PMI element and then dragging it moves the element within the plane where it resides. The element moves in different ways depending upon what part of the element you drag and whether you use the formatting handles.

• You also can use Alt+drag to detach a PMI dimension or annotation from one model element and attach it to a different model element. To learn how, see Reattach or move a dimension or annotation.

If you move an annotation that is attached to another PMI element—including stacked and chained dimensions—they move together.

Moving an annotation connected directly to a face results in translation along the face only, not off it.

To learn how to move and manipulate PMI dimensions and annotations, see the Help topic, Move PMI elements.

Using property text in PMI elements

You can extract and use property text in PMI dimensions and in callout and balloon annotations.

• To use property text in callouts and balloons, select the Property Text button on the annotation dialog box.

• To use property text in a dimension prefix, suffix, subfix, or superfix, copy and paste the property text string into the corresponding text box on the Dimension
Prefix dialog box. You can open the Dimension Prefix dialog box by clicking the Prefix button on the Dimension command bar.

- To extract hole information from hole features in a part or assembly, use the Hole Reference, Smart Depth, or Hole callout property text strings.

- You can extract bend information—Angle, Radius, and Direction—from a formed part, but not from a flat pattern.

- To update property text in PMI elements, use the PMI tab→Property Text group→Update All command.

- To convert property text strings to plain text for individual annotations and dimensions, use the Convert Property Text command on the selected element shortcut menu.

- To convert all strings in the document, you can use the PMI tab→Property Text group→Convert All command.

To learn more about property text, see the Help topic, Using property text.

**PMI text size and color**

**Setting PMI text size**

There are several ways to change the text size of PMI elements.

- Change all PMI elements and associated graphics (lines, leaders, and arrows) at once, using either of the following methods:
  
  - Automatically scale elements. When you use the active model style to determine text size, PMI elements scale automatically as the view is zoomed in and out. This sometimes results in PMI being too large or too small relative to the feature or component.

  - Change element size interactively. You can use the Increase PMI Font and Decrease PMI Font buttons to change the size of PMI elements based on pixel size. This has the advantage of letting you fine-tune the size interactively.

- Change the size of new elements by editing the style. You can set a default text size for all new PMI elements on the Text page of the Modify Dimension Style dialog box. You can access this dialog box using the Styles command.

- Change the size of individual PMI elements. You can override the default text size for individually selected elements using the Properties command.

To learn how to set and change PMI text size, see the Help topic, Change PMI text size.
Setting global PMI color

PMI dimension color is an at-a-glance indicator as to whether a dimension is locked or unlocked. You can change the global color setting for PMI dimensions. This also changes the color of PMI annotations.

You can change global PMI color settings on the Colors page of the Solid Edge Options dialog box.

- The default color of unlocked PMI dimensions is blue. It is the same as that set for all sketch elements. You can choose another color for them from the Sketch list.

- The default color of locked PMI dimensions is red. It is the same as that set for handle elements. You can choose another color for them from the Handle list.

You cannot change the color of individual PMI elements.

Creating 3D model views with PMI
Lesson 9  

*Dimensions, Annotations, and PMI*

Model views help you manage the display of a part, sheet metal, or assembly model within the Product Manufacturing Information (PMI) workflow. You can define different 3D views of the model to completely communicate design, manufacturing, and functional information.

Model views can contain the following:

- Model state, for example, designed or flattened (synchronous).
- Ordered dimensions, including driving dimensions that have been copied to 3D.
- Synchronous dimensions
- Annotations
- Section views
Once defined, you can select individual model views from the Model Views collection, which is located under the PMI node on Pathfinder.

For review purposes, you can share the model view and data electronically using View and Markup or Solid Edge Viewer.

**Creating model views**

The View command creates a 3D view of the assembly, part, or sheet metal model as currently displayed in the graphics window.

- All dimensions, annotations, view settings, and section views that are displayed when you create the model view are copied to the model view.

- Each model view definition includes a view name, orientation, scale, and view extent (zoom).

- The Model View Options dialog box is where you assign initial values for view name, render mode, and section view and cutting plane display. You can change these settings by editing the model view definition.

- You access and control PMI model views using PathFinder.
Each model view definition contains a specific list of PMI elements—types of dimensions, annotations, and included section views—that are displayed when the view is applied.

**Note**

Showing or hiding these elements in one model view applies the show or hide setting to the same elements in all model views.

For more information, see the Help topic, *Working with 3D PMI*.

**Reviewing model views**

You can review all of the model views defined in the document along with their associated PMI data using a special PMI model review mode. You can use this feature before exporting PMI models and data to View and Markup.

When you select a model view and choose the Review command on the shortcut menu, a PMI Model View Review command bar is displayed to guide you through the review of each model view.

- You can navigate through the PMI model views using these tools:
  - Step through each view using the Next and Previous arrows.
  - Jump to a specific model view by selecting its name from the Model View List.

- As you select each 3D model view, the active window temporarily changes to display the view as it was defined. This includes its show and hide states and section views that have been applied.

- When you close the review session, the graphics screen returns to its previous display.

Another way to review the contents of a model view is to select the model view name on PathFinder, and then select the Apply View command on its shortcut menu.
Adding 3D section views to model views

- The Section Views collection on PathFinder contains a list of all existing 3D section views that have been defined for the model.

- You can add an existing 3D section view to a model view using the Add To Model View command on its shortcut menu.

- Similarly, you can remove a section view from the model view you are editing using the Remove From Model View command.

Modifying a PMI model view

When you select the Edit Definition command on the model view’s shortcut menu, the model view is displayed in a special edit environment. The Model View command bar provides access to two levels of editing functions for the PMI model view.

- Using the Model View Options dialog box, you can change the view name, choose a different rendering mode, and change the section view and cutting plane display settings.

- Selecting the Model View Display group button places you in model view creation and edit mode, where you can:
  - Change the show or hide visibility and display properties of individual PMI elements.
  - Add new PMI annotations and dimensions to the model view.

  **Note**
  - While you are in this edit mode, you cannot use the modeling commands.
  - Except for view orientation and render mode, changes made in this edit mode are WYSIWYG.
  - PMI elements and section views that are hidden are automatically removed from the model view.
  - PMI elements and section views that are added and shown are automatically added to the model view.

When you exit model view edit mode, your changes are applied to the model view and the normal modeling commands are made available again.
Lesson 9  Dimensions, Annotations, and PMI

Sending a PMI model view to View and Markup

You can share 3D model views containing PMI data by electronically publishing them to a format compatible with View and Markup or Solid Edge Viewer.

- Use the Send PMI to View and Markup command to save the file in .pcf format, which is opened in View and Markup.

- Alternatively, you can use the Save As command on the Application menu to save the information to .jt format.

  Note
  The Send PMI to View and Markup command sends all the model views in the file to View and Markup.

Publishing PMI and model views to View and Markup

To make Product Manufacturing Information, or PMI, and model views available for display in View and Markup or Solid Edge Viewer, the information must be published. You can publish the information with the Send PMI to View and Markup command, or you can use the Save As command to save the information to .jt format.

Using Send PMI To View and Markup

You can quickly publish information with the Send PMI To View and Markup command, which is available on the shortcut menu when a model view is selected in PathFinder. This sends all PMI data and model views defined in the active document to a .pcf file. The file is opened automatically in View and Markup. Any PMI data that is not associated with a model view is not displayed in the viewer.

Using Save As

To publish information with the Save As command, you must first set the Save PMI Data option on the Solid Edge to JT Translation Options dialog box, and then save the document to .jt format. All model views and PMI information associated with a model view are saved to the .jt document.

Once saved, you can open the .jt document in the viewer. A list of the model views and associated PMI information is displayed in the Model Views page on PathFinder.

  Note
  When the Save PMI Data option is selected, other .jt save options are disabled and the appropriate options are set to support PMI data. Precise geometry is always sent when the Save PMI Data option is selected even if the Include Precise Geometry option is not set.

Only graphic topology supported by the viewer is written to the .jt file. The following items are controlled by model views, but are not written to the .jt file.

- Coordinate systems
- Reference planes
- Sketches and profiles
Dimensions, Annotations, and PMI

- References axis
- PMI section views

**Property text codes**

You can add symbols and reference data to annotation text and dimension text. When a dialog box such as the Callout dialog box or the Dimension Prefix dialog box provides buttons to do so, you can click the buttons to insert the symbols. In some cases, when the dialog box does not provide a button interface to insert the symbol directly, you can type a three-character symbol code instead. As an example, this is true for the Surface Texture Symbol.
In the following tables, the three-character code in the left-most column displays the corresponding symbol shown in the right-most column, or it fetches the matching value from the model. The codes must be typed exactly as listed. They are valid for the Solid Edge ANSI Symbol and Solid Edge ISO Symbol fonts.

<table>
<thead>
<tr>
<th>Geometric characteristic symbols</th>
<th>Represents</th>
<th>Displays this symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>%FL</td>
<td>Flatness</td>
<td><img src="image" alt="Flatness" /></td>
</tr>
<tr>
<td>%SR</td>
<td>Straightness</td>
<td><img src="image" alt="Straightness" /></td>
</tr>
<tr>
<td>%CI</td>
<td>Circularity</td>
<td><img src="image" alt="Circularity" /></td>
</tr>
<tr>
<td>%CY</td>
<td>Cylindricity</td>
<td><img src="image" alt="Cylindricity" /></td>
</tr>
<tr>
<td>%PP</td>
<td>Perpendicularity</td>
<td><img src="image" alt="Perpendicularity" /></td>
</tr>
<tr>
<td>%AN</td>
<td>Angularity</td>
<td><img src="image" alt="Angularity" /></td>
</tr>
<tr>
<td>%PR</td>
<td>Parallelism</td>
<td><img src="image" alt="Parallelism" /></td>
</tr>
<tr>
<td>%PS</td>
<td>Profile of a Surface</td>
<td><img src="image" alt="Profile of a Surface" /></td>
</tr>
<tr>
<td>%PL</td>
<td>Profile of a Line</td>
<td><img src="image" alt="Profile of a Line" /></td>
</tr>
<tr>
<td>%CR</td>
<td>Circular Runout</td>
<td><img src="image" alt="Circular Runout" /></td>
</tr>
<tr>
<td>%TR</td>
<td>Total Runout</td>
<td><img src="image" alt="Total Runout" /></td>
</tr>
<tr>
<td>%PO</td>
<td>Position</td>
<td><img src="image" alt="Position" /></td>
</tr>
<tr>
<td>%CO</td>
<td>Concentricity</td>
<td><img src="image" alt="Concentricity" /></td>
</tr>
<tr>
<td>%SY</td>
<td>Symmetry</td>
<td><img src="image" alt="Symmetry" /></td>
</tr>
<tr>
<td>%VB</td>
<td>Frame</td>
<td><img src="image" alt="Frame" /></td>
</tr>
</tbody>
</table>
### Material condition symbols

<table>
<thead>
<tr>
<th>Code</th>
<th>Represents</th>
<th>Displays this symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>%MC</td>
<td>Maximum</td>
<td>M</td>
</tr>
<tr>
<td>%LC</td>
<td>Least</td>
<td>L</td>
</tr>
<tr>
<td>%SC</td>
<td>Regardless of Feature Size</td>
<td>S</td>
</tr>
<tr>
<td>%RC</td>
<td>Reciprocity Condition</td>
<td>R</td>
</tr>
</tbody>
</table>

### Tolerance zone symbols

<table>
<thead>
<tr>
<th>Code</th>
<th>Represents</th>
<th>Displays this symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>%PZ</td>
<td>Projected</td>
<td>P</td>
</tr>
<tr>
<td>%TZ</td>
<td>Tangent Plane</td>
<td>T</td>
</tr>
<tr>
<td>%FZ</td>
<td>Free State</td>
<td>F</td>
</tr>
<tr>
<td>%ER</td>
<td>Envelope Requirement</td>
<td>E</td>
</tr>
<tr>
<td>%UD</td>
<td>Profile Unequally Disposed</td>
<td>U</td>
</tr>
</tbody>
</table>
### Other symbols

<table>
<thead>
<tr>
<th>Code</th>
<th>Represents</th>
<th>Displays this</th>
</tr>
</thead>
<tbody>
<tr>
<td>%DI</td>
<td>Diameter</td>
<td>(\emptyset)</td>
</tr>
<tr>
<td>%DG</td>
<td>Degree</td>
<td>(°)</td>
</tr>
<tr>
<td>%BT</td>
<td>Between</td>
<td>(↔)</td>
</tr>
<tr>
<td>%ST</td>
<td>Statistical Tolerance</td>
<td>(ST)</td>
</tr>
<tr>
<td>%SQ</td>
<td>Square</td>
<td>(\square)</td>
</tr>
<tr>
<td>%CB</td>
<td>Counterbore</td>
<td>(\square)</td>
</tr>
<tr>
<td>%CS</td>
<td>Countersink</td>
<td>(\downarrow)</td>
</tr>
<tr>
<td>%DP</td>
<td>Depth</td>
<td>(\downarrow)</td>
</tr>
<tr>
<td>%IL</td>
<td>Initial Length</td>
<td>(\bullet)</td>
</tr>
<tr>
<td>%AL</td>
<td>Arc Length</td>
<td>(\circ)</td>
</tr>
<tr>
<td>%PM</td>
<td>Plus Minus</td>
<td>(\pm)</td>
</tr>
<tr>
<td>%TA</td>
<td>Taper Angle</td>
<td>(\angle)</td>
</tr>
<tr>
<td>%SG</td>
<td>Symmetric Taper Angle</td>
<td>(\triangle)</td>
</tr>
<tr>
<td>%Gd</td>
<td>Material Thickness</td>
<td>(\delta)</td>
</tr>
</tbody>
</table>

**Note**

The second letter is lowercase.
### Hole references

<table>
<thead>
<tr>
<th>Code</th>
<th>Represents</th>
<th>Fetches this hole data</th>
</tr>
</thead>
<tbody>
<tr>
<td>%HC</td>
<td>Hole Callout</td>
<td></td>
</tr>
<tr>
<td>%HS</td>
<td>Hole Size</td>
<td>&lt;Hole Size Value&gt;</td>
</tr>
<tr>
<td>%HD</td>
<td>Hole Depth</td>
<td>&lt;Hole Depth Value&gt;</td>
</tr>
<tr>
<td>%BS</td>
<td>Counterbore Size</td>
<td>&lt;Counterbore Size Value&gt;</td>
</tr>
<tr>
<td>%BD</td>
<td>Counterbore Depth</td>
<td>&lt;Counterbore Depth Value&gt;</td>
</tr>
<tr>
<td>%SS</td>
<td>Countersink Size</td>
<td>&lt;Countersink Size Value&gt;</td>
</tr>
<tr>
<td>%SA</td>
<td>Countersink Angle</td>
<td>&lt;Countersink Angle Value&gt;</td>
</tr>
<tr>
<td>%TS</td>
<td>Thread Size</td>
<td>&lt;Thread Size Value&gt;</td>
</tr>
<tr>
<td>%TD</td>
<td>Thread Depth</td>
<td>&lt;Thread Depth Value&gt;</td>
</tr>
<tr>
<td>%RT</td>
<td>Carriage Return</td>
<td></td>
</tr>
<tr>
<td>%TN</td>
<td>Terminal Name</td>
<td>&lt;Terminal name&gt;</td>
</tr>
<tr>
<td>%DN</td>
<td>Device Name</td>
<td>&lt;Device name&gt;</td>
</tr>
</tbody>
</table>

For example, displays hole diameter and depth symbols plus extracted values:

Ø .394 ▼ 2.165

### Smart depth symbols

<table>
<thead>
<tr>
<th>Code</th>
<th>Represents</th>
<th>Fetches this hole data</th>
</tr>
</thead>
<tbody>
<tr>
<td>%ZH</td>
<td>Smart Hole Depth</td>
<td>&lt;Smart Hole Value&gt;</td>
</tr>
<tr>
<td>%ZT</td>
<td>Smart Thread Depth</td>
<td>&lt;Smart Thread Depth Value&gt;</td>
</tr>
</tbody>
</table>

### Bend symbols

<table>
<thead>
<tr>
<th>Code</th>
<th>Represents</th>
<th>Fetches this bend data</th>
</tr>
</thead>
<tbody>
<tr>
<td>%BA</td>
<td>Bend Angle</td>
<td>&lt;Bend Angle Value&gt;</td>
</tr>
<tr>
<td>%BN</td>
<td>Bend Angle Unsigned</td>
<td>&lt;Bend Angle Unsigned Value&gt;</td>
</tr>
<tr>
<td>%BR</td>
<td>Bend Radius</td>
<td>&lt;Bend Radius Value&gt;</td>
</tr>
<tr>
<td>%BO</td>
<td>Bend Direction</td>
<td>&lt;Bend Direction Value&gt;</td>
</tr>
<tr>
<td>%BI</td>
<td>Bend Sequence</td>
<td>&lt;Bend Sequence Number&gt;</td>
</tr>
<tr>
<td>%BQ</td>
<td>Bend Quantity</td>
<td>&lt;Number of Bends&gt;</td>
</tr>
</tbody>
</table>
Lesson

10 Activity: Retrieving and placing dimensions

Overview

This activity covers the workflow of placing dimensions and annotations on a drawing. An existing drawing file is used to dimension and annotate.

Objectives

In this activity you will:

• Retrieve dimensions from the Model.

• Update out-of-date drawing views.

• Use the Drawing View Tracker.

• Place dimensions on a drawing.

• Modify dimensions on a drawing.

• Place annotations on a drawing.

Turn to Appendix F for the activity.
Lesson

11 Activity: Placing annotations

Overview

This activity covers the workflow of placing annotations on a drawing. An existing drawing file is used to annotate.

Objectives

In this activity you will place geometric tolerances and finish symbols.

Turn to Appendix G for the activity.
Overview

This activity demonstrates the process for placing an assembly parts list on a drawing sheet.

Turn to Appendix H for the activity.
Lesson

13 Summary

The Drafting application provides for the creation of drawings. Views and dimensions that are placed on a drawing are associative to the 3D model and update when changes are made to the model.

In this course you:

• Created drawings
• Added views to a drawings
• Dimensioned drawing views
• Placed annotations on drawings
• Placed a parts list on a drawing.
A  Activity: Drawing view placement

Overview

This activity covers the typical workflow for placing drawing views of a Solid Edge part. All drawings are different, but the basic approach to view creation, layout, manipulation, and editing is the same in all Solid Edge environments. In fact, the steps for placing assembly views are the same steps used for creating part views on a drawing sheet. This activity provides you with a basic understanding of the workflow used to create drawing sheets quickly and effectively.

Objectives

After completing this activity, you will be able to:

• Place multiple views of a part on a drawing sheet.

• Manipulate the views.

• Shade a drawing view.

• Modify drawing view properties.

• Create principal drawing views.

• Create Auxiliary views.

• Create Section views.

• Create Detail views.
Create a draft document

Create a new ISO draft document.

- Choose the Application button → New → ISO Draft.

Setup the background and sheet size for the drawing sheet

- Position the cursor over the Sheet1 tab (lower left corner) and right-click. On the shortcut menu, click Sheet Setup.
- On the Sheet Setup dialog box, click the Background page. Set the background sheet to A1-Sheet. This sets the background and sheet size for the drafting sheet. Check the Show background button.
- Click Save Defaults to save A1-Sheet as the default border/background for this document. By saving defaults now, any new sheets created in this file will automatically default to A1-Sheet.
- Click OK.
- Click the Fit command to display the entire drawing sheet in the active window.

Select the drawing standards for the drawing sheet

- Click the Application button.
- Click the Solid Edge Options button.
• Click Drawing Standards. On the Drawing Standards page, set the Projection Angle to Third and the Thread Display Mode to ISO/BSI, and then click OK.

**Select views in the Drawing View Creation Wizard**

• On the Home tab, in the Drawing Views group, choose the View Wizard command.

• On the Select Model dialog box, select `bearblk.par` and click Open.
In the Drawing View Creation Wizard, set the options as shown, and then click Next.

- Select “front” as the named view for the drawing view orientation. Click Next.
In the Drawing View Layout dialog box, click the Right and Top view buttons as shown, and click Finish.

**Drawing View Creation Wizard**

Place the views selected on to the drawing sheet

- The drawing scale is displayed in the command bar. Make sure it is set to 1:1. Solid Edge automatically assigns the scale, which makes the views as large as possible and still fit on the drawing sheet.
A rectangle is attached to the cursor. Move the rectangle to the approximate center of the sheet, and click.
Place an additional part view on the drawing sheet

- Choose the View Wizard command.
- On the Select Attachment dialog box, select `bearblk.par`, and click OK. This enables the placement of another part view.
Proceed through the Drawing View Creation Wizard as before, and when prompted for Named Views, click iso, then click Finish.
Activity: Drawing view placement

- In the command bar, set the view scale to 1:1. Then move the cursor, and click to place the view in the upper right corner of the sheet, as shown.

Save the drawing file

- On the Quick Access toolbar, click Save, and in the Save As dialog box, save the file as bearblk.dft.
Activity: Drawing view placement

Place an auxiliary view on the drawing sheet

- On the Home tab, in the Drawing Views group, choose the Auxiliary command. Notice that a fold line is now attached to the cursor. If IntelliSketch locates a point, the line will disappear. Move the cursor until IntelliSketch ceases to locate a point and the line displays.

- Move the cursor across the front drawing view until the fold line attaches to the model edge as shown, then click to select this edge as the folding line.

- Position the view as shown and click. This view may overlap other views because of limited space on the drawing sheet. This will be corrected in the next step.

Create a new drawing sheet and move the auxiliary view to the new sheet

- Position the cursor over the Sheet1 tab in the lower left corner of the screen, and right-click to display the shortcut menu.

- On the shortcut menu, click Insert to create a new drawing sheet. This adds a new sheet (Sheet2) to the draft document, and Sheet2 displays. To switch between sheets, click on the tab of the sheet you want to switch to. The sheet tabs are found at the lower left corner of the window.
Activity: Drawing view placement

- Click the Sheet1 tab. This returns the view to the first drawing sheet in the draft document.

- Click the Select tool command, and position the cursor over the auxiliary view so that the view highlights and then right-click. On the shortcut menu, click Properties.

- In the High Quality View Properties dialog box, on the General page, change the Sheet from Sheet1 to Sheet2, and click OK. This moves the auxiliary view to Sheet2.

- Click the Sheet2 tab to make Sheet2 the active sheet.

- Drag the auxiliary view towards the upper left corner, as shown.

Create a cutting plane for a section view

Place a cutting plane in the top view. This cutting plane will be used to create a section view.

- Click the Sheet1 tab to make it the active sheet.

- Click the Cutting Plane command.

- Select the Top view as the drawing view where the cutting plane will be drawn. The window changes to the Cutting Plane Line mode.

- Click the Zoom Area button, and define a zoom area around the Top view.

- Click the Line command to draw a profile line for the cutting plane.
Activity: Drawing view placement

- Draw the sequence of lines shown in the following figure. Lock into the midpoint of the left vertical edge and the center point for the upper right hole. Use IntelliSketch relationships to locate the keypoints. If the keypoints do not highlight, make sure the box is checked the **Mid and Center** options in the IntelliSketch group. Move the cursor over the elements (without selecting them) to activate them for keynote location. A dashed line appears when you are in line, horizontally or vertically, with the midpoint or center point of the circle.

![Diagram](image)

- In the Close group, choose the Close Cutting Plane command.

- To complete the direction step, position the cursor below the drawing view, and click to position the cutting plane arrows as shown.

![Diagram](image)

**Create a section view**

Create a section view using the cutting plane defined in the previous step.

- Fit the view.

- Choose the Section command.

- Select the cutting plane line created on the top view as cutting plane from which the section view will be created.

- In command bar, click the Model Display Settings option.

- In the dialog box, clear the **Hidden edge style** option box. Click OK on the message box and then click OK on the Drawing Properties dialog box. This turns off hidden edges in the cross section view.
• Place the cross section below the top view as shown.

![Diagram showing cross section below top view]

• Use the Properties dialog box to move the section view to Sheet2.

• Click the Sheet2 tab to view the second sheet. Reposition the section view, below the auxiliary view.

**Change the cross-hatch properties of the section view**

• To change the cross-hatch properties, select the view, then right-click to display the shortcut menu. Click Properties from the shortcut menu.

• In the High Quality View Properties dialog box, click the Display page.

• Under the *Show fill style* box, uncheck the *Derive from part* box. On the *Show fill style* list, select *ANSI32(Steel)* and then click OK on the message box and then click OK on the dialog box.

![Diagram showing cross-hatch properties change]

• Save the document.

**Place a detail view off of the front view**

• Return to Sheet1.

• Click the Detail command
Activity: Drawing view placement

- Click to place the center of the detail view circle on the front view, and then click again to define the radius of the detail view circle. The view circle should resemble the one shown in the following illustration.

- Move the large circle attached to the cursor away from the front view. Click to place the detail view as shown below.

- Move the detail view to Sheet2 by changing the view properties.

- Switch to Sheet2.

- On Sheet2, position the detail view to the right of the auxiliary and section views as shown.
Change the display of a drawing view to shaded

- Return to Sheet1.
- Click on the iso drawing view.

- In the command bar, notice the commands for the display of the selected drawing view. Click the Grayscale with Visible Edges command.

- Click in an open area of the drawing sheet to de-select the iso drawing view. Notice the out-of-date border around the iso drawing view.

- Click the Update Views command.
Activity: Drawing view placement

- The iso drawing view now displays as shaded.

- This completes the activity. Save and close the file.

Activity summary

In this activity you learned how to place drawing views, auxiliary views, section views and detail views. You also learned how to use drawing sheets to organize the drawing views.
B Activity: Assembly drawing creation

Overview
This activity demonstrates the method for creating a drawing of an exploded assembly view.

Objectives
After completing this activity, you will be able to:

- Place drawing views of an assembly.
- Create a drawing view that uses an exploded view assembly display configuration.

Create a new draft document
Create a new ISO draft document.
- Choose the Application button → New → ISO Draft.
Define views to place on the drawing sheet

Use the drawing view wizard to define the type of view to place on the drawing sheet.

- Choose the View Wizard command.
- Set the Files of type: field to Assembly Document (*.asm).
- On the Select Model dialog box, select *carrier.asm* located in the training folder and click Open.
- On the Drawing View Creation Wizard, select **exploded view** from the list of Configuration or PMI model view and then click Finish.
- Use background sheet **A1-sheet** and a view scale of 1:1.

Place an exploded assembly view

- Place the drawing view in the center of the drawing sheet.
- Click Save and save the file as *mycarrier.dft* in the training folder.

Place a front view on a new sheet

- On the Sheet tab, right-click and then click **Insert** to insert Sheet2.
- Choose the View Wizard command. The dialog box is different than the first time you executed the command because at this point you have placed a view of the assembly.
• On the Select Attachment dialog box, click OK. On the Drawing View Creation Wizard, make sure that no configuration is selected and click Next.

• On the Drawing View Orientation dialog box, click the Custom option.

• While in the Custom Orientation window, press the Home key to display the Isometric view.

• Click the Shaded with VHL Overlay button.

• Click the Common Views button.

• Click Show face view as shown.

• Click Rotate 90° clockwise as shown.

• Close the Common Views dialog box by clicking the X in the upper right corner.

• The image below shows the resulting view.
Activity: Assembly drawing creation

- Click Close in the Custom Orientation window, and then on the Drawing View Layout page, click Finish.
- Change the scale to 1:1.
- Place the view in the upper left region of the drawing sheet.

Draw a cutting plane for a section view

Draw a cutting plane on the front view that will be used to create a section view.

- Choose the Cutting Plane command.
- Click the drawing view just placed and construct a cutting line through the center of the view. The cutting plane will look similar to the illustration below.

- Choose the Close Cutting Plane command.
Activity: Assembly drawing creation

Create a section view

Create a section view using the cutting plane defined in the previous step.

• Choose the Section command.

• Click the cutting line just constructed.

• Click the Model Display Settings option.

• On the Drawing View Properties dialog box, expand the parts list for the assembly by clicking the + symbol next to carrier.asm. This shows all of the parts in the assembly. If the assembly contained subassemblies, these would also display.

• Click the Part named mtgpin.par:1, and then uncheck the Show box. This excludes the part from the sectioning process.

• Move the cursor and click on the upper side of the cutting plane to define the cutting direction.
Activity: Assembly drawing creation

- Click OK and finish placing the section view below the top view. Your drawing sheet should look similar to the following illustration. Notice that the mounting pin (*mtgpin.par*) is hidden in the section view.
Hide a part in the drawing view

Hide another part in the drawing view. Once this is done, an out-of-date border will appear.

- Click the Select Tool and select the new section view. Right-click on it, and click Properties on the shortcut menu. On the High Quality View Properties dialog box, on the Display page, repeat the previous steps to hide splate.par:1 and click OK. The section view should now display an out-of-date border.

- Click the Update Views command. The part file named splate.par:1 is now hidden in the section view of the assembly and the out-of-date border is no longer displayed.
Activity: Assembly drawing creation

Adjust the parts display

Adjust the displayed parts again. This demonstrates how to turn on and off the display of parts in the drawing view.

- Click the Select Tool and select the section view again. Right-click on the section view, and click Properties on the shortcut menu. Click the Display page, expand the parts list for carrier.asm, show all parts except mtgpin.par, and click OK.

- Click Update Views to update the section view. Splate.par:1 now displays in the section view.

- This completes the activity. Save and close the file.

Activity summary

In this activity you learned how to creating a drawing of an exploded assembly view. You also learned how to control the display of assembly parts on the drawing.
Activity: Quicksheet

Overview

A quicksheet is a draft document that contains drawing views that are not linked to a model. When you drag and drop a model file from the Library tab of PathFinder or Windows Explorer onto a quicksheet template, the views populate with the model. Quicksheet templates can only be created using the Create Quicksheet Template command.

This activity will show you the process for using a quicksheet.

Objectives

After the activity, you will be able to:

- Create a quicksheet template.
- Populate a quicksheet template.
- Place a user-defined quicksheet in the Quicksheet template folder.

Create a new draft document

Create a new ISO draft document.

- Choose the Application button → New → ISO Draft.
Activity: Quicksheet

Set the drawing standards

- Click the Application button.
- Click the Solid Edge Options button.
- Click Drawing Standards. On the Drawing Standards page, set the Projection Angle to Third and the Thread Display Mode to ISO/BSI, and then click OK.

Define the drawing views

Use the Drawing View Wizard to place a drawing view on the new sheet.
- Click the View Wizard command.
- On the Select Model dialog box, make sure the Look in: field is set to the class working folder, and set the Files of Type option to Part Document (*.par).
- Select dr_plate.par and click Open.
• Place the five views shown on the drawing sheet at a scale of 2:1, and then move the views so they fit on the sheet.
Arrange the views on the sheet

- Arrange the views as shown and edit the view properties.

View A – Hidden edge style turned off.

> [Check box for Hidden edge style] Hidden

View B – Scale = 5:1, Shaded with Visible Edges.

**Note**

This drawing view configuration will be used as a quicksheet template.
Activity: Quicksheet

Create a quicksheet template

- Click the Application button and then choose the **Create Quicksheet Template** command.
  
  **Note**
  
  Command empties all drawing views and parts lists, then converts the file into a Quicksheet Template.
  
- Click Yes in the Create Quicksheet Template warning box
  
- In the Save As dialog box, save the template as *quicksheet_a.dft* in the training folder.
Populate a quicksheet template

The template quicksheet_a.dft is still open. You will populate this template.

• In PathFinder (Library tab), drag dr_plate2.par into the template.

• The results are shown.

Note

Notice in the results that a view overlaps the title block. The views will need to be adjusted to fix this.

• Save the file as dr_plate2.dft and then make the necessary adjustments.

• Close the file.

Place the new quicksheet template in the Solid Edge templates folder

Note

If you decide that the template will be used in a common workflow for similar type parts, it is recommended that it be added to the Solid Edge template folder for easy access.

• Copy quicksheet_a.dft to the Solid Edge ST3/Template/Quicksheet folder.

Create a new draft file using the quicksheet template

Create a new ISO draft file using the quicksheet template just added to the Solid Edge ST3 templates folder.

• Click the Application button.

• Click New.
• In the New dialog box, click the Quicksheet page. Select \textit{quicksheet\_a.dft} and then click OK.

• Close all files. This concludes the quicksheet activity.

\textbf{Activity summary}

In this activity you learned how to create and populate a quicksheet template. This tool is provided to help streamline the drawing production workflow. When you know the views needed and view property settings for similar type parts, quicksheets can reduce repetitive steps required for each drawing created.
D  Activity: Broken view creation

Overview
This activity covers the use of the Broken View command.

Objectives
After completing this activity, you will be able to: create a broken drawing view of a part on a draft sheet in Solid Edge.

Create a new draft document
Create a new ISO draft document.
• Choose the Application button → New → ISO Draft.

Define the drawing view
• Click the View Wizard command.
• On the Select Model dialog box, make sure the Look in: field is set to the training folder, and set the Files of type: field to Part Document (*.par).
• Select dualbar.par and click Open.
Activity: Broken view creation

- In the Drawing View Creation Wizard, ensure the Part and Sheet Metal Drawing View default options are set as shown, then click Next.

- In the named Views: field, click top. Click Finish.

- Change the scale to 2:1 and place the drawing view on the draft sheet as shown.
Add a vertical broken region to the drawing view

- Click the Select tool, and then right-click on the drawing view. Click the Add Break Lines command on the short-cut menu.

- In command bar, set the options as shown.

- Place two vertical lines representing the region to be broken as shown.

- In the command bar, click Finish to create the broken view.
**Activity: Broken view creation**

- The result is shown.

- In command bar, click the Show Broken View button to toggle the view display back to unbroken.
Place a horizontal break in the drawing view

- Use the Horizontal Break Line option to add another set of break lines to the view.

- Close the file and save as breakline.dft.
Place a broken view with different break line types

- Create a new ISO draft file and using the View Wizard command, open and place the front view of \textit{bar.par}.

- Place four sets of break lines on the bar. Each set will be a different type.

  ![Break Line Types](image)

- This completes the activity. Save and close the file.

Activity summary

In this activity you learned how to create broken views using horizontal and vertical breaks. You also learned how to use different break line types.
Activity: Broken-out section creation

Overview
This activity covers the use of the Broken-Out Section command.

Objectives
After completing this activity, you will be able to create a broken section of a part on a draft sheet in Solid Edge.

Create a new draft document
Create a new ISO draft document.
- Choose the Application button → New → ISO Draft.

Set the drawing standards
- Click the Application button.
- Click the Solid Edge Options button.
- Click Drawing Standards. On the Drawing Standards page, set the Projection Angle to Third and the Thread Display Mode to ISO/BSI, and then click OK.
Define the drawing view

Use the View Wizard command to place a drawing view on the new sheet.

- Choose the View Wizard command.
- On the Select Model dialog box, make sure the Look in: field is set to the training folder, and set the Files of Type option to Part Document (*.par).
- Select crankcase.par and click Open.
- Place a top, front, right and iso view on the drawing sheet at a scale of 2:1, and then move the views so they fit on the sheet.
Define the broken-out section view

The section view will be displayed in the isometric view. Draw the profile defining the broken-out section in the front view.

- Choose the Broken-Out Section View Command.
- Select the front view. Beginning from the center of the circle, draw the profile shown.

- Choose the Close Broken Out Section command.
Activity: Broken-out section creation

- In the top view, define the extent of the section as shown.

- Select the iso drawing view to apply the broken-out section to.

Edit the broken-out section

- Right-click the iso view and click Properties.
• In the High Quality View Properties dialog box, click the General page and check **Show Broken-Out Section view profiles** and then click OK.

• The profile for the broken-out section for the iso drawing view is shown in the front drawing view.

• To edit the profile, click the rectangular profile in the front view.

• Click **Modify Depth** in command bar.

• Type 80 mm for the **Depth** and press the **Enter** key. Click Accept.

• The iso view is now out of date, signified by the box around the view.

• Click the Update View command ![Update View] to refresh the iso drawing view.
Activity: Broken-out section creation

- The broken-out section will appear as shown.

![Diagram of a broken-out section](image)

**Note**

To remove a broken out section, delete the profile used to define the broken out region.

- This completes the activity. Save the file as `broken section.dft`.

**Activity summary**

In this activity you learned how to create a broken-out section view. You also learned how to modify the broken-out section profile to create a different broken view representation.
Activity: Retrieving and placing dimensions

Overview

This activity covers the workflow of placing dimensions and annotations on a drawing sheet. An existing drawing file is used to dimension and annotate.

Objectives

In this activity you will:

- Retrieve dimensions from the model.
- Update out-of-date drawing views.
- Use the Drawing View Tracker.
- Place dimensions on a drawing sheet.
- Modify dimensions on a drawing sheet.
- Place annotations on a drawing.
Open a draft file

- Open `fan_body.dft`. 
Retrieve dimensions

Begin the activity by working on the front view. Retrieve dimensions from the part model.

- Choose the Zoom Area command and then zoom in on the drawing view as shown.

- In the Dimension group, choose the Retrieve Dimensions command.
Activity: Retrieving and placing dimensions

- Click the drawing view to retrieve dimensions contained in the part model.
Modify the retrieved dimensions

Delete and replace a dimension. Reposition a dimension.

- Click the Select tool and then delete the 100 mm diameter dimension. Replace this dimension on the cross section view later in the activity.

- Reposition the 75 mm dimension. Click the dimension value and drag it inside the dimension projection lines. Click the dimension line and drag it to the position shown.

Place center marks

Place a center mark in the center of the part and on each of the counterbored holes.

- In the Annotation group, choose the Center Mark command.

- In command bar, make sure the Projection Lines button is selected.

- Select the By 2 Points option.
Activity: Retrieving and placing dimensions

- For the first point, click circle (1).

- For the second point, click the center of the upper right counterbored hole to place the center mark.

- Repeat these two steps for each of the other three counterbored holes.

- To place the first center mark on the interior circle, change the dimension type to Horizontal/Vertical and select circle (1).

- To place the center marks between the diagonal ribs, change the orientation to Use Dimension Axis.

- Click the Dimension Axis option.
Activity: Retrieving and placing dimensions

- Click the 45° line. This will enable you to place center marks parallel and perpendicular to this line.

- Place the 45° center marks by selecting circle (1).

Place angular dimensions

Place angular dimensions on the holes measured from the right horizontal centerline.

- In the Dimension group, choose the Angle Between command 🌰.
• Place an angular dimension from the right horizontal centerline to the 45° center mark line on the upper right counterbore hole.

• Do not end this command. Continue using the same origin. Select the angled center mark line on the upper left side counterbore hole, and place the string 90° dimension.
Place a linear dimension and add a prefix

Dimension the fin thickness. Add a prefix to the dimension.

- Choose the Distance Between command.
- In the command bar, click the Prefix option. Type 8 X in the Prefix field and click OK.

- Set the dimension orientation to Horizontal/Vertical and select the two vertical lines illustrated below to place the new dimension. Click to position the dimension. This is the thickness dimension for each of the eight fins.
Place a Smart dimension and add prefix, suffix and special characters

Add a SmartDimension to the bottom right hole. Set a prefix and suffix for the dimension and also add special characters to include in the dimension display.

- Choose the Smart Dimension command.
- Click the Dimension Prefix option.
- Set the Prefix to 4 X.
- Click the Suffix field, and do the following:
  - Click the Counterbore symbol from the special characters, and press the spacebar on the keyboard.
  - Click the Diameter symbol, press the space bar on the keyboard, and type 14.
  - Press the spacebar.
  - Click the Depth symbol, press the spacebar, and type 5. This sets the suffix to the diameter and depth of the counterbored hole.
- Click OK to accept these inputs. The Special characters are displayed with a % sign as part of the character in the Suffix field. But the symbol is actually placed on the drawing.
• Select the through hole in the lower right counterbore hole. Any dimensions placed after this one will exhibit the same prefix and suffix until you clear the Prefix field in the Dimension Prefix dialog box.

Dimension a section view

Place a distance between dimension with a prefix option on the section view.

• Choose the Distance Between command, and click the Dimension Prefix option. Click the Clear button, and then set the Prefix to a diameter symbol. Click OK.

• Fit the view and then zoom in on the section view. Right-click to exit the zoom area command.
Activity: Retrieving and placing dimensions

- Select the two horizontal lines (flanked by white area and crosshatching), and place the dimension to the right of the view as shown. Even though this is a linear dimension, the diameter symbol can be used as a prefix.

- Save the document.
Edit a dimension and add a tolerance

Edit the dimension placed in the previous step and place a tolerance on the dimension.

- Using the Select tool, click the 90 mm diameter dimension in the section view. The command bar changes to edit definition mode to make a change to the selected dimension.

- Click Dimension Type, and click the Tolerance option to edit the upper and lower tolerance.
Activity: Retrieving and placing dimensions

- Type 0.03 in the Upper and Lower tolerance boxes. The dimension changes to show a plus/minus on the tolerance because the upper and lower values are the same. If the upper and lower tolerance values differ, the two tolerances display as separate items.

Use the dual unit dimension display

Edit the dimension and apply a dual unit dimension style.

- Click the Select tool and then, right-click on the 90 mm diameter dimension in the section view. Click Properties on the shortcut menu to display the Dimension Properties dialog box. Changes here will only change the property of the dimension selected. To modify all dimensions, click the Styles command in Style group and make the changes.
Click the Secondary Units tab, and then set the Dual unit display and the Add parenthesis ( ) boxes. Click OK. The 90 mm dimension updates to show the dual units.
Fit the drawing sheet

- Choose Fit to fit the drawing sheet.

Change sheet size

Notice that the drawing is too crowded. Change the drawing border to a larger size.

- Right-click on the Sheet1 tab, and from the shortcut menu, click Sheet Setup.
- Click the Background tab and change the background sheet to A2-Sheet. Click OK.
Activity: Retrieving and placing dimensions

- Fit the window again.

- Reposition the views on the drawing sheet.

Close the draft file

- Save and close the file.
Activity: Retrieving and placing dimensions

Open part file used to create drawing views

Open *fan_body.par* that was used to generate the drawing views. Make a change to *fan_body.par*. When the draft file is reopened the changes are made obvious with the out-of-date drawing views.

• Open *fan_body.par*.

Edit a circular pattern feature

• Notice the 8 fins on the fan. Select the circular pattern of fins. Use QuickPick or PathFinder to select the pattern.
• Click the on the **Pattern X8** text.

• Type *6* in the pattern count edit handle and then press the **Enter** key.

• Save and close the file.

**Open draft file**

Open `fan_body.dft` created earlier in this activity to observe how the file behaves after `fan_body.par` was edited.

• Open `fan_body.dft`. Notice the **Drawing Views** dialog box. This box informs you that one or more of the current drawing views are out-of-date. It also tells you to go to the Drawing View Tracker command to get more information about the status of the drawing views.
Click OK. Notice the box that surrounds the drawing views. This box indicates that the views are out-of-date.

Use Drawing View Tracker

- On the Tools tab, choose Drawing View Tracker. The Drawing View Tracker shows which drawings are out-of-date. When you click on an entry, more information displays in the Update Instructions box about that view.

- In the Drawing View Tracker dialog box, click the Update Views button. You could also select a single drawing view from the Drawing View Tracker dialog box and update that view by selecting Update View from the shortcut menu.

- Click Close to dismiss the Dimension Tracker dialog box.
• Now notice that the drawing views update to reflect the change to the number of fins on the fan. Also notice that the boxes indicating out-of-date drawing views are no longer displayed.

• Fit the drawing sheet.

• Save the file. This completes the activity. However, you may continue to place additional views or dimensions for extra practice.

**Activity summary**

In the activity you learned how to place dimensions and annotations on a drawing. You also learned how to edit a part and then update the drawing views to reflect the changes.
**G  Activity: Placing annotations**

**Overview**

This activity covers the workflow of placing annotations on a drawing. An existing drawing file is used to annotate.

**Objectives**

In this activity you will place geometric tolerances and finish symbols.

**Open draft file**

- Open `annotation_fan.dft`.

**Place a datum frame**

Place a datum frame on the right drawing view.

- In the Annotation group, choose the Datum Frame command.

- On the command bar, cancel the selection of the Leader and Break Line options. Type A in the Text box and set the Dimension Style box to ISO.
Activity: Placing annotations

- Select the right vertical edge on the cross-section view and place the datum frame as shown. If you want the minus sign to display before and behind the letter A in the datum frame (-A-), on the View tab, choose Styles→Modify to invoke the Modify Dimension Style dialog box. Then click the Annotation tab and set the Dashes on Datum Text option.

![Diagram](image1)

- On the command bar in the Text box, change A to B and then click the diameter dimension on the cross section view and place the datum frame as illustrated.

![Diagram](image2)

Reposition a dimension

- Click the Select tool, and reposition the dimension on the counterbored hole as shown below. Reposition the dimension approximately horizontal.

![Diagram](image3)
Place a feature control frame

- Choose the Feature Control Frame command 

- Click the Position symbol, and click the Divider symbol.

- Click the Diameter symbol, press the space bar, type in 0.05, and then press the space bar again.

- Click the Material conditions: S and click the Divider Symbol. Press spacebar and then type B in the content field. The dialog box should match the following illustration.

- In the Save settings: field, type **Position B 0.05**.

- Click Save to save these settings as Position B 0.05. If prompted, click yes to overwrite the file that already exists.

- Click OK.

- On command bar, clear the selection of the Leader and Break Line options.

- Select the diameter dimension on the lower right counterbore, and place the geometric tolerance as shown.
Activity: Placing annotations

Place another feature control frame

- Click the Feature Control Frame Properties.
- Click the Parallelism symbol and create a callout of 0.10 mm to datum A. Be sure to add the dividers as shown.

- Click OK and set the Leader and Break Line options. Place the feature control frame on the left side of the cross section view as shown.

- Save the file.

Place a surface texture symbol

- In the Annotation group, click the Surface Texture Symbol command.
Activity: Placing annotations

- Select the Symbol type: for a **machined** finish.

- Type 1.6 in the value field shown and click OK.

- On the command bar, clear the selection of the Leader.

- Place the surface finish symbol on the left vertical object line of the cross sectioned part. Click the edge (1).
Hide an edge in the drawing view

The section cut produced extra edges in the section view. Hide those edges.

• On the Home tab, in the Edges group, choose the Hide Edges command.

• Click the two edges shown.

Place a centerline on the section view

• On the Home tab, in the Annotation group, choose the Center Line command.

• On the command bar, make sure the Dimension Style is set to ISO and the Placement options field is set to By 2 Points.

• On the command bar, click the Center Line properties button.
• On the Center Line & Mark Properties dialog box, click the Line Type shown and click OK.

• Place the Centerline through the center of the counterbored hole by selecting a keypoint on each end of the hole. Use IntelliSketch to locate the keypoint of the vertical line.
Place an edge condition on the section view

- Choose the Edge Condition command.

- In the Edge Conditions properties dialog box, type 12 in the Upper tolerance field and 6 in the Lower tolerance field. Click OK.

- Select the lower horizontal edge on the cross section view edge and place the symbol as shown below. You may have to select the edge condition after placement and select the handles to reposition the text as shown.

- Fit the drawing sheet.

- Save the file.
Add notes to the drawing sheet

Notes can be added to a drawing sheet using text boxes. However, you can also use a word processor to create the notes, and then copy and paste the notes directly into Solid Edge.

• Choose the Text command 🖋.

• Set Height to 25 mm and Width to 50 mm.

• Click to place the text box above the title block as shown. You may want to use the Zoom Area command to view the text.

• Now that a text box is on the drawing sheet, you will now enter text. Type the text shown in the illustration in the Text box. After typing “NOTE:” press the Enter key to start a new line for the first note. Also notice that the last character wraps to a new line. This is because the text box is not wide enough for the sentence.

Note:
1. Break all sharp edges at 1.00mm
Activity: Placing annotations

- To modify the text box width, click the Select Tool command and identify the text box border of the text box. Select and hold one of the graphic handles, and drag it out to widen the text box. You can also identify the text box with the Select Tool command and then change its width on the ribbon bar.

![Note: 1. Break all sharp edges at 1.00mm]

- To add the second note, identify the end of the first note with the Select tool, press the **Enter** key, and then type the next note.

![Note: 1. Break all sharp edges at 1.00mm 2. Paint non-machined surfaces blue]

- Save and close the file. This completes the activity.

Activity summary

In the activity you learned how to place geometric tolerances and assign surface texture symbols to the drawing.
Activity: Placing a parts list

Overview

This activity demonstrates the process for placing an assembly parts list on a drawing sheet.

Open draft file

- Open carrier.dft located in the training folder.
- If the Drawing Views dialog box informs you of an out-of-date drawing view, click OK.
- Click the Update Views command located in the Drawing Views group.
**Set the parts list option for auto ballooning**

Turn on the auto-balloon option.

- In the Tables group, choose the Parts List command.
- Select the Drawing view.
- On the Parts List command bar, make sure the **Auto-Balloon** button is selected.

**Set the balloon properties**

- On the Parts List command bar, click the Properties button.
- Click the Balloon page. Type 5 for the Text Size. Use the default balloon shape. The settings shown will place balloons which contain the item number and count.
Activity: Placing a parts list

Define location of the parts list

- Click the General page.
- In the Location fields, type 10 in the X origin: and Y origin: fields. Click the **Enable predefined origin for placement** box. This fixes the offset distances of the parts list from the lower left corner of the draft sheet.

![Enable predefined origin for placement]

- X origin: 10.00 mm
- Y origin: 10.00 mm

Define the parts list columns

- Click the Columns page.
Select Author from the Properties list, and click the Add Column button to add this to the columns list.
• Click on Quantity in the Columns list.

• Type QTY in the Text: field under Column Format.

• Click OK.
Activity: Placing a parts list

Place the parts list on drawing

Now that the options are set, place the parts list on the drawing sheet.

- Click Place List on the command bar to include parts list with balloons.
- Click in the drawing sheet window to place the parts list and balloons.
- Zoom in on the Parts List in the lower left corner of the drawing.

<table>
<thead>
<tr>
<th>Item Number</th>
<th>Document Number</th>
<th>Title</th>
<th>Material</th>
<th>QTY</th>
<th>Author</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>SP-2070</td>
<td>Side Plate</td>
<td>6061-T6 Aluminum</td>
<td>2</td>
<td>Paul McSraith</td>
</tr>
<tr>
<td>2</td>
<td>C-3701</td>
<td>Cross Head</td>
<td>Bronze</td>
<td>1</td>
<td>Dwight Yorke</td>
</tr>
<tr>
<td>3</td>
<td>MP-101</td>
<td>Mounting Pin</td>
<td>Copper</td>
<td>1</td>
<td>Dwight Yorke</td>
</tr>
</tbody>
</table>

- Notice the Author field is added on the right end of the parts list, and the column header for Quantity is labeled as QTY. You can control the order of the columns by right-clicking the parts list and then click Properties. Click the columns page. Select the column from the list and then click the move up or move down buttons.

- Click Fit. Then zoom in on the drawing view. Notice that balloons are placed on the parts, and the balloon numbers correspond to those in the parts list. To reposition the balloons, click the Select Tool command, and drag the balloons to a new location.

- Save and close the file. This completes the activity.

Activity summary

In this activity you learned how to create a parts list with ballooning. You learned how to format the parts list.